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Modeling Frameworks
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Modeling an enterprise 1s a significant undertaking, but
using a tried and tested industry framework reduces some of
the risks and increases the benefits you will gain from the
effort and resources used in the creation of the Enterprise
Architecture models. Enterprise Architect supports the most
popular frameworks, including TOGAF, UPDM, UAF,
Zachman Framework, and the Federal Enterprise
Architecture Framework. The tool provides many pre-built
patterns that, when used, will reduce the modeling effort
required and ensure you develop industry-compliant
best-practice models, allowing you to concentrate your
efforts on the architectural description of your enterprise.
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Zachman Framework Interfaces Diagram showing the cells
supported by the Enterprise Architect models.

Enterprise Architect allows you to use each framework
independently or in combination. For example, you could
use TOGAF for your overall Enterprise Architecture
governance and description but use Zachman Framework as
your content framework to describe and catalog the artifacts
in the Architecture Landscape and the Reference Library,
Standards, and Governance Log. In this topic, you will learn
how to install and use each framework.

Modeling Frameworks

Framework/L

Description

(c) Sparx Systems 2022
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anguage

ArchiMate = ArchiMate 1s a framework defined by

Framework = The Open Group that provides a visual
modeling language used in the analysis
and design of business architectures. The
scope for its use is primarily orientated
towards enterprise modeling.

TOGAF The Open Group Architecture
Framework (TOGAF) 1s one of the most
widely accepted methods for developing
Enterprise Architecture, providing a
practical, definitive and proven
step-by-step method for developing and
maintaining Enterprise Architecture.

UPDM UAF/UPDM tightly integrates with Sparx
Systems Enterprise Architect and
provides a model-based framework for
planning, designing and implementing
the Unified Profile for DoDAF and
MODAF (UPDM) architectures.

Zachman The Zachman Framework 1s a widely
Framework | used approach for engineering Enterprise
A Architecture. The Framework 1s a simple,
logical structure that helps in organizing
the content models that describe the

(c) Sparx Systems 2022 Page 16 of 1007
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Enterprise.

ArcGIS The ArcGIS framework supports the
Geodatabases | modeling and design of geodatabase
structures for the Esri ArcGIS platform,
using a modeling standard based on
UML. ArcGIS models can be exported
and imported via the ArcGIS XML
Workspace document.

Google Enterprise Architect's Google Cloud
Cloud Platform modeling provides constructs
Platform for creating expressive GCP diagrams
(GCP) used 1n specifying new Cloud
infrastructure and platforms, as well as
for documenting existing GCP structures.

Amazon Web = Enterprise Architect's Amazon Web
Services Services modeling constructs allow you
(AWS) to create detailed diagrams that specify

Cloud infrastructure and platforms based
on AWS infrastructure. This includes
defining [aaS
(Infrastructure-as-a-Service) and PaaS
(Platform-as-a-Service) environments.

Microsoft ~ Microsoft Azure provides services to
Azure define [aaS (Infrastructure-as-a-Service),
PaaS (Platform-as-a-Service) and SaaS

(c) Sparx Systems 2022 Page 17 of 1007
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(Software as a Service) Cloud
environments. Enterprise Architect
provides modeling constructs that allow
you to create expressive Azure diagrams.

MDG Using MDG Technologies you can

Technologies @ extend the core UML structures to create
a modeling framework based on a
publicly defined model language or a
language of your own definition. As a
technology developer, can use Enterprise
Architect to develop your own
customized modeling languages and
solutions.

(c) Sparx Systems 2022 Page 18 of 1007
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The ArchiMate Framework

ArchiMate is both a language and a framework, making i1t a
profoundly useful paradigm for both descriptive and
prescriptive representations of the architecture of an
enterprise or its divisions. Combining language and
framework allows enterprise architects and others to create
an articulated model that unites the business, application,
and technology architectures. These layers are, in turn,
subdivided into aspects that cut across the language
grammar from active and passive structure to behavior and
motivation. The models can be embellished or supplemented
with other framework content such as reusable content
libraries, standards, governance logs, and more.

The Archimate Framework is expressed in a metamodel that
defines these layers and concepts. The core framework
defines three layers and three aspects and these are extended
in the Full Framework with two additional layers and a and
one more aspect. This allows the architect to model
motivation, strategy, implementation and migration artifacts.

Enterprise Architect supports both the ArchiMate language
and the Core Framework storing elements and their
relationships in a robust and flexible repository that can be
devised, visualized, queried, and viewed with a formidable
suite of tools. Industry best practice models, diagrams, and
viewpoints are available in a set of model patterns that you
can use to inject pre-built content into your architectures.
Descriptive text accompanies each pattern and details how

(c) Sparx Systems 2022 Page 19 of 1007
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to use the pattern, including tools, ideas, and next steps.
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ArchiMate Core Framework

The reference structure used to classify elements of the
ArchiMate core language 1s implemented in Enterprise
Architecture 1n its core internal metamodel. It consists of
three layers and three aspects (including the physical) and
the extended framework contains a number of extra layers
and aspects as extensions. These core and extended
language elements are visible in the tool in the form of the
Diagram list and Toolbox pages corresponding to the layers,
and in the element representations with their various forms
including the icon format. This diagram has been created in
Enterprise Architect to demonstrate the structure of the
language.

Passive Behavior Active
Structure Structure

Business

Application

Technology

Figure: Showing the layers and aspects of the core
framework
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Aspects

The Active Structure aspect defines structural concepts that
can exhibit behavior directly. Elements such as Business
Actors in the Business Layer and the Application
Component in the Application layer are examples. These are
like the subjects in our natural languages.

The Behavior aspect defines behaviors allocated to
structural elements and includes elements such as services,
functions, processes, and more. The structural elements
define the element that exhibits the behavior. These are like
the verbs in our natural languages.

The Passive structure aspect defines elements that are the
recipients of behavior. These elements are typically
information, data, and physical objects. These are like the
objects (or predicates) in our natural languages.

Layers

ArchiMate defines a layered and service-oriented paradigm
for architectural models. The higher layers utilize services
provided by the lower layers. The layers are abstract
concepts, and an architectural practice or team 1s free to
organize their models according to any structure. The layers
provide a continuum from the stakeholders and users
defined in the business layer to the virtual or physical
technology elements that provide the platform for the

(c) Sparx Systems 2022 Page 22 of 1007
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middle technology layer..
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The Full Framework

The ArchiMate core framework has been extended to allow
architects to model a range of additional concepts including
a cross-cutting motivation aspect that spans all layers and
two new layers to model strategy and Implementation and
Migration. Another layer is included which is contained in
the technology layer that the architect uses to model
physical items such as machines and devices.

Passive Behavior Active Motivation
Structure Structure

Strategy

Business

Application

Technology

Physical

Implementation &
Migration

Figure: Showing the layers and aspects of the full
framework
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Microsoft Azure

Create Microsoft Azure Diagrams that Specify and
Document Azure Virtual Infrastructure

Microsoft Azure (or simply Azure) is one of the market
leaders in public Cloud computing platforms and provides
services to define [aaS (Infrastructure-as-a-Service), PaaS
(Platform-as-a-Service) and SaaS (Software as a Service)
Cloud environments. Azure entered the market in 2010 and
has steadily grown in importance as a corporate Cloud
solution. The platform 1s used for building, testing,
deploying, and managing applications and services through
Microsoft-managed data centers and supports many
programming languages, tools, and frameworks, including
both Microsoft-specific and third-party software and
systems.

Enterprise Architect provides modeling constructs that allow
you to create expressive Azure diagrams that specify new
Cloud infrastructure and platforms or document existing
ones. You can also model other Cloud Infrastructure and
platform providers such as Amazon Web Services (AWS)
and Google Cloud Platform (GPC).

The Microsoft Azure UML profile provides a new image

(c) Sparx Systems 2022 Page 25 of 1007
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library of graphics (icons and images) required to model
Microsoft Azure deployments. The icons and images are
provided by a Model Wizard framework pattern, which
must be imported into your model before you can start
creating diagrams that describe Microsoft Azure
deployments. The Azure pattern contains over 350 Image
Assets that can be dragged-and-dropped onto diagrams.

(c) Sparx Systems 2022 Page 26 of 1007
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Getting Started

Creating Microsoft Azure diagrams is straight forward; all
the AWS service constructs are available from the Toolbox
pages or from the Browser in the MS Azure Packages. This
allows you to create expressive diagrams containing element
items such as Virtual Machines, MS SQL databases, Cycle
Cloud for big computer clusters, DevOps for code
collaboration, Blob Storage and Managed Disks for data
storage, and Load Balancers and Traffic Managers for

networking.
Traffic App & I
A App Manager Environmen t Azu

Service - Profiles Database for
Postgre5SQL

Diagram showing a mobile application using a Smart Phone
Traffic Manager and PostgreSQL Database

In this topic you will learn how to work with the features
that support MS Azure diagramming, outlined in the topic
sections.

Selecting the Perspective
Enterprise Architect partitions the tool's extensive features

(c) Sparx Systems 2022 Page 27 of 1007
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into Perspectives, which ensures that you can focus on a
specific task and work with the tools you need without the
distraction of other features. To work with the Microsoft
Azure features you first need to select this Perspective:

EI<perspective name> > Analysis > Microsoft Azure

Setting the Perspective ensures that the Microsoft Azure
diagrams, their tool boxes and other features of the
Perspective will be available by default.

Example Diagram

An example diagram provides a visual introduction to the
topic and allows you to see some of the important elements
and connectors used when specifying or describing AWS
cloud infrastructure.

Import the Microsoft Azure Patterns

Before you can start creating Microsoft Azure diagrams to
specify or document your cloud services you will need first
to import the graphics from a pattern. This will inject all the
Azure 1cons as components into the selected location in the
Browser window.

(c) Sparx Systems 2022 Page 28 of 1007
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Microsoft Azure Perspective

o Azure Images and Icons s

A Microsoft Azure Cloud and Al

2] Microsoft Azure icons and images | . @

Microsoft Azure example 1

T
Micrasoft Azure example 2 - Multi-region ... Manager |
Region 1 gien i
..... ] . e Ot recquents
Appin Appin
Wi er Web Tier
L T . T
Image Server Pool Default Server Pool Image Server Pool Default Server Pool
w w w L i i M M
AWS Architecture Perspective =~

- Amazon Web Services (AWS) Images

A Armazon Web Services

. This pattern has all the images required for modeling AWS
Amazon Web Services Images (Release 1)

diagrams in Enterprise Architect. Import this pattern into your

Amazon Web Services Images (Release 5) model before you start.
Amazon Web Services - Example 1
Amazon Web Services - Example 2 4 landing diagram has been provided to easily navigate to a

EA Web Servi Ex le3 specific category that you wish to work with.
mazon < EMNVICES - ample

Amazon Web Services - Example 4

Analytics Application Integration AR & VR

2 EH B

Patterns window showing Azure pattern for Import.

Create Azure Diagrams

More Information

This section provides useful links to other topics and
resources that you might find useful when working with the
Microsoft Azure tool features.
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Example Diagram
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Import the Microsoft Azure Patterns

Before you import the 'Microsoft Azure icons and images'
pattern into your model, click on the E icon and select the
'Analysis > Microsoft Azure' Perspective.

This automatically opens the Model Wizard on the '"Model
Patterns' tab at the 'Microsoft Azure Perspective' page.

Click on the target Package in the Browser window, then on
the 'Microsoft Azure icons and 1mages' pattern and click on
the Create Model(s) button.

Note: When you have the Images packet in your model, do
not copy it to another location in the model or save it as
XMI; always use the Model Wizard to import the pattern
into a new model. The reason for this is copying the Image

Assets will give them new GUIDs, which you do not want to
do.

In the Model Wizard there are two example patterns that
show typical use of the images in diagrams. This example is
the Azure Multi-region Web App.
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App Serviceplan

Web App

Function App
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Create Azure Diagrams

You can create a diagram by right-clicking on its parent
Package and selecting the 'Add Diagram' menu option to
display the 'New Diagram' dialog.

If you do not have the Microsoft Azure Perspective selected,
click on the drop-down arrow in the Type field and select
'Analysis > Microsoft Azure'.

In the 'Diagram’ field type an appropriate name for the
diagram, in the 'Select From panel' click on 'Microsoft
Azure', and in the 'Diagram Types' panel click on 'Azure’,
and then click on the OK button. The 'Azure' page of the
Diagram Toolbox opens, showing a small number of UML
base element types for Azure. However, you create your
diagrams using the images dragged onto the diagram from
the Azure Library Packages that you imported, illustrated
here:
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Note that the Azure diagrams are automatically set to
Custom Style, and when you right-click on an element in the
diagram you can make use of the Custom Style icons on the

Custom Styles Toolbar.

Each Package in the downloaded '"Microsoft Azure icons and
images' pattern has a diagram that shows every image that is

included in the Package.

To add one of these images to your diagram, locate it in the

(c) Sparx Systems 2022
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Browser window by either:
. Searching for it by name or

. Opening the diagram for the Package that you believe it
should be in, finding it in the diagram and pressing Alt+G
to highlight the Image Asset in the Browser window

Now drag-and-drop the Image Asset onto your diagram.
You can choose to:

. Add it as an element with an icon
. Add it as an element with an image, or

. (If you have made an element from the icon already) Add
as link
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More Information

Edition Information

This feature 1s available in the Corporate, Unified and
Ultimate Editions of Enterprise Architect, from Release
15.2.
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Google Cloud Platform (GCP) Icons

Create Google Cloud Platform Diagrams that Specify
and Document GCP Virtual Infrastructure

Google Cloud Platform (GCP) provides a suite of Cloud
computing services, following their initial Google App
offering. Alongside a set of management tools, it provides a
series of modular Cloud services including computing, data
storage, data analytics and machine learning. Google Cloud
Platform provides infrastructure as a service laaS, platform
as a service PaaS, and server-less computing environments.
Enterprise Architect provides modeling constructs that allow
you to create expressive GPC diagrams that specify new
Cloud infrastructure and platforms or document existing
ones. You can also model other Cloud Infrastructure and
platform providers such as Amazon's AWS and Microsoft's
Azure.

On-Premises "Render Farm"

{ot

Google Cloud
Interconnect
&VPN Virtual
a Gateway )
«SecondaryPath>» PrimaryPath File System

3

E

3
/

GPC diagram showing an On-Premise Render Farm
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While Google offers tools for creating diagrams, the power
of Enterprise Architect is that you can create visualizations
that show the relationship to on-premise platforms, and the
elements and services can be related to other system
life-cycle artifacts such as Strategy, Business Rules,
Requirements, Constraints, Applications XML and Database
Schemas, just to mention a few.

The Google Cloud Platform (GCP) UML Profile provides
all of the graphics (icons and images) necessary to model
GCP architecture diagrams. The icons and images are
provided by a Model Wizard (Start Page 'Create from
Pattern' tab) framework pattern, which must be imported
into your model before you can start creating GCP
architecture diagrams. The Google Web Images pattern
contains over 250 Image Assets that can be
dragged-and-dropped onto diagrams.
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Getting Started

In this topic you will learn how to work with the features
that support Google Cloud Platform diagramming outlined
in each section.

Selecting the Perspective

Enterprise Architect partitions the tool's extensive features
into Perspectives, which ensures that you can focus on a
specific task and work with the tools you need without the
distraction of other features. To work with the Google Cloud
Platform features you first need to select this Perspective:

El<perspective name> > Analysis > Google Cloud Platform

Setting the Perspective ensures that the Google Cloud
Platform diagrams, their tool boxes and other features of the
Perspective will be available by default.

Example Diagram

An example diagram provides a visual introduction to the
topic and allows you to see some of the important elements
and connectors that are created in specifying or describing
the way a Cloud Architecture is defined including:
Availability Zones, VPC's, Subnets, EC2, RDS and more.
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Import Google Cloud Platform Patterns

Before you can start creating GCP diagrams to specify or
document your cloud services you will need first to import
the graphics from a pattern. This will inject all the GCP
icons as components into the selected location in the
Browser window.

Create Google Cloud Platform Diagrams

Once the GCP images have been imported creating GCP
diagrams 1s straight forward as all the icons including App
Engines, Compute Engine, Virtual File System and
Gateways available from the Browser window and Toolbox.
You will simply create a diagram and then drag-and-drop
elements from the GCP Browser Packages or the Toolbox.

More Information

This section provides useful links to other topics and
resources that you might find useful when working with the
Google Cloud Platform tool features.
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Example Diagram

Using GCP diagrams you can model cloud architectures.
You can add new elements to the diagram from the
Imported GCP Icons, the GCP toolbox or existing elements
dragged from the Browser. This example 1s the Sensor
Stream Ingest and Processing diagram.

5555555
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aaaaaa

= (e
2l
.
EREn

GCP diagram showing Sensor Stream Ingest and Processing
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Import Google Cloud Platform Patterns

Before you import the 'Google Web Images' pattern into
your model, click on the EI1con and select the 'Analysis >
Google Cloud Platform' Perspective.

This automatically opens the Model Wizard (Start Page
'Create from Pattern' tab) at the 'Google Cloud Platform'
page.

Click on the target Package in the Browser window, then on

the 'Google Web Images' pattern and click on the Create
Model(s) button.

Note: When you have the Web Images packet in your model,
do not copy it to another location in the model or save it as
XMI; always use the Model Wizard to import the pattern
into a new model. The reason for this is that the provided
Diagram Toolbox patterns, described here, refer to the
Image Assets by their GUIDs. Copying the Image Assets will
give them new GUIDs and the Diagram Toolbox patterns
will not wortk.

@start Page x |2 Specification Manager 8Find in Project

Open Project  Create from Pattern Add Diagram Guidance

Google Cloud Platform

Google Cloud Platform {GCP) Images

ol Il

4 Google Cloud Platform
[E] Boogle Weh Images «1.0
éGDDgIeWebImagesz.S
[2] Google Cloud Platform (GCF) Example - Rendering E ch package in this pattern includes a diagram like th e below sl h owing all the images available

[E] Google Cloud Platform (GCP) Example - Sensor Strea.. nthe D ckage. U thes d gamst help you locate an image, or search for it by name, dth
n drag and drop it onto your own diagram.

.@@@@@@@
@@@.@@@..

Create Models) Add T SystemsEngineering ort Combine with selected Package

This pattern has all the images required for modeling GCP diagrams in Enterprise Architect, Import
this pattern into your model before you start.
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In the Model Wizard there are example patterns that show
typical use of the images in diagrams, reproduced from the
'Google Cloud Platform' Powerpoint.
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Create Google Cloud Platform
Diagrams

You can create a diagram by right-clicking on its parent
Package and selecting the 'Add Diagram' menu option to
display the 'New Diagram' dialog.

If you do not have the Google Cloud Platform Perspective

selected, click on the drop-down arrow in the "Type' field
and select 'Analysis > Google Cloud Platform'.

In the 'Diagram' field type an appropriate name for the
diagram, in the 'Select From panel' click on 'Google Cloud
Platform', and in the 'Diagram Types' panel click on
'Google', and then click on the OK button. The 'Google
Cloud Platform' pages of the Diagram Toolbox open,
including:

. Zones

. Open Source

. Al & Machine Learning

. API Management

. Compute

. Data Analytics

. Databases

. Developer tools

. General Cards
. Hybrid and Multi Cloud
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. Internet of Things

. Management Tools

. Migration

. Networking

. Serverless Computing Product Cards (Expanded)
. Security

. Serverless Computing

. Storage

. Paths

Note that the GCP diagrams are automatically set to Custom
Style, and when you right-click on an element in the
diagram you can make use of the Custom Style icons on the
Format Toolbar.

Each Package in the Google Web Images Model Wizard
pattern has a diagram that shows every image that is
included in the Package.

To add one of these images to your diagram, locate it in the
Browser window by either:

. Searching for it by name or

. Opening the diagram for the Package that you believe it
should be 1n, finding 1t in the diagram and pressing Alt+G
to highlight the Image Asset in the Browser window

Now drag-and-drop the Image Asset onto your diagram.
You can choose to:

. Add it as an element with an icon
. Add it as an element with an 1image, or

(c) Sparx Systems 2022 Page 47 of 1007



Modeling Frameworks 3 October, 2022

. (If you have made an element from the icon already) Add
as link
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You can create expressive diagrams that can show how the
GCP elements relate to other artifacts in your projects. This
1s achieved by placing any GCP element into a diagram and
creating a Trace, Dependency, Association or other
relationship between the AWS elements and other elements
such as Requirements, User Stories, Conceptual, Logical

and Physical database tables.

App Engine
Process Orders

The system must store

records of orders for
SEVEN YEars

wtraces

Cloud QL
Orders Db

customers

comments: string
date_of_hirth: date
email: string
first_name: string

d: long
middle_name: string
mahbile_no: string
phone_no: string

surname: sring

E

customers_orders

comments: string
censignment_no: string
customer_id: long

d: long

order_date: date
paid_date: date
shipped_date: date
special_instructions: sting
total_price: decima

GCP diagram showing traces to a requirement and two

database tables.
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More Information

Edition Information

This feature 1s available in the Corporate, Unified and
Ultimate Editions of Enterprise Architect, from Release
15.0.

Enterprise Architect Release 15.2 supports Version 1.5 of
the GCP graphics file.
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Amazon Web Services (AWS)

Creates Amazon Web Services Diagrams that Specify
and Document AWS Virtual Infrastructure

Amazon Web Services (AWS) 1s one of the market leaders
of services to define IaaS (Infrastructure-as-a-Service) and
PaaS (Platform-as-a-Service) in Cloud environments. The
services can be used in 1solation, but more typically are used
in combination to create scalable Cloud applications and
services, reducing any of the delays and issues associated
with infrastructure provisioning and device management
such as Compute, Storage and Network devices. Enterprise
Architect provides modeling constructs that allow you to
create expressive AWS diagrams that specify new Cloud
infrastructure and platforms or document existing ones. You
can also model other Cloud Infrastructure and platform
providers such as Google Cloud Platform and Microsoft's
Azure.
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1
Driver
safety score

Location-based marketing

Amazon DynamoDB

AWS Diagram of a Connected Vehicle Solution

While AWS has tools for doing this, the power of Enterprise
Architect is that you can create visualizations that show the
relationship to on-premise platforms, and the elements and
services can be related to other system life-cycle artifacts
such as Strategy, Business Rules, Requirements,
Constraints, XML and Database Schemas, just to mention a
few.
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Getting Started

Creating AWS platform diagrams is straight forward - all
the AWS service constructs are available from the Toolbox
or from the Browser in the AWS Packages. This allows you
to create expressive diagrams containing element items such
as EC2 compute and RDS databases, as well as container
items such as VPCs and Subnets.

Amazon Web Services (AWS) Architecture provides all of
the graphics (icons and 1images) required to build AWS
architecture diagrams. The icons and images are provided
by a Model Wizard framework pattern, which must be
imported into your model before you can start creating
AWS architecture diagrams. The Amazon AWS Web
Images pattern contains over 350 Image Assets that can be
dragged-and-dropped onto diagrams.

4 £1 AWS Connected Vehicle Solution

S AWS Connected Vehicle Solution

£] Amazon Kinesis Data Firehose

4 2 Anomaly detection

£] Amazon DynamoDEB
2] Amazon Kinesis Data Analytics
£] Amazon Kinesis Data Streams
%] AWS Lambda
AWS loT Core
Connected vehicles with AWS Greengrass Core
Diagnostic trouble codes
Driver safety score
Just-in-tirne registration
Location-based marketing
Motification service

Raw data

T v v
Y i i s s

Trip data

Working with AWS diagrams is straight forward; this topic
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will guide you through setting up AWS modeling in
Enterprise Architect, creating diagrams and tracing to other
project Artifacts.

Selecting the Perspective

Enterprise Architect partitions the tool's extensive features
into Perspectives; this ensures that you can focus on a
specific task and work with the tools you need without the
distraction of other features. To work with the Amazon Web
Services (AWS) features you first need to select the AWS
Architecture Perspective:

EI<perspective name> > > Analysis > AWS Architecture

Setting the Perspective ensures that the Amazon Web
Services diagrams, their tool boxes and other features of the
Perspective are available by default.

Example Diagram

An example diagram provides a visual introduction to the
topic and allows you to see some of the important elements
and connectors that are created in specifying or describing
the way a Cloud Architecture is defined including:
Availability Zones, VPC's, Subnets, EC2, RDS and more.

(c) Sparx Systems 2022 Page 54 of 1007



Modeling Frameworks 3 October, 2022

Import Amazon Web Services Patterns

Before you can start creating AWS diagrams to specify or
document your Cloud services you must first import the
graphics from a pattern. This will inject all the AWS icons
as components into the selected location in the Browser
window.

Create an Amazon Web Services Diagram

Once the AWS 1mages have been imported creating AWS
diagrams 1s straight forward as all the icons including
Products and Resources such as EC2 and RDS and
Containers such as VPCs and Availability Zones are
available from the Browser window and Toolbox
respectively. You will simply create a diagram and then
drag-and-drop elements from the AWS Browser Packages
or the Toolbox.
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4 £ Database
5 Database

4 51 Products
zlmages Amazon Aurora
«lmage» Amazon DocumentDE (with MongoDB Compatibility)
zlmages Amazon DynamoDE
«lmage» Amazon ElastiCache
zlmages Amazon Meptune
«|mage» Amazon Quantum Ledger Dabase
zlmages Amazon RD5
«lmage» Amazon RDS on ViMware
zlmages Amazon Redshift

«lmage» Amazon Timestream

zlmages AWS Database Migration Service
[» 1 Resources
zlmages Database Category

The Browser window showing AWS database Product
Images.

Tracing to Project Artifacts

Enterprise Architect 1s a collaboration platform for all
disciplines and one of the great advantages of modeling
Amazon web Services is that parts of the cloud based
infrastructure can be related to other domains in your
projects. You can trace elements in the AWS diagrams to a
wide range of other artifacts including: Requirements,
Business Rules, Database Schemas, On-Premise
Infrastructure and more.

More Information
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This section provides useful links to other topics and
resources that you might find useful when working with the

Amazon Web Services tool features.
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Example Diagram

Using AWS diagrams you can model cloud architectures.
You can add new elements to the diagram from the
Imported AWS Icons, the AWS toolbox or existing
clements dragged from the Browser. This example 1s the
Instances on AWS example that contains two availability
zones and auto-scaling groups.

e AWS Cloud
el o e e e e e e e
| Availability zone : | Availability zone :
| |
l l
1
B | | |
b I T | P I
[ b >{Je [ b
[ b : ¥ [ b :
| |
| NAT | Amazon EC2 | ::: |
| gatewsy | Auto Scaling | gateway |
[ ' [ '
I _: ________ T T T T T | :
I I IARRN] I I LL Ll I I
I I - = I - - I
1| 3 C I . | 3 C [
|| ] - | Auto Scaling group - - |
|| TTTTT | | TTTTT |
| | Instance | | Instance | |
|| | I 1|
e :— ——————— i e - :
I r—=—=—=—"—"=—""—""—"""7""wwm " = e e e e e e [
I |
I I
I | 1ia1) | I L1111 [
I I - = I I - - I I
- - — =
I | - - Auto Scaling group I . - |
| . = ' [ . = '
| : TITTT | | TITT1 : |
| I Instance : | Instance I :
I | a
| T T T T T T T T T | T T T~ |
I ‘ | ‘
[ ' [ '

AWS diagram showing two availability zones and auto
scaling groups.
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Import Amazon Web Services Patterns

Before you import the 'Amazon/AWS Web Images' pattern
into your model, click on the E icon and select the 'Analysis
> AWS Architecture' Perspective.

This automatically opens the Model Wizard (Start Page
'Create from Pattern' tab) at the AWS Architecture
Perspective page.

Click on the target Package in the Browser window, then on
the 'Amazon/AWS Web Images' pattern and click on the
Create Model(s) button.

In the Model Wizard there are three example patterns that
show typical use of the images in diagrams, reproduced
from the '"AWS Architecture Icons' Powerpoint.

AWS Architecture Perspective =~

o Amazon Web Services (AWS) Images

4 Amazon Web Services
This pattern has all the images required for modeling AWS

Amazon Web Services Images (Release 1) diagrams in Enterprise Architect. Import this pattern into your

Amazon Web Services Images (Release 5) model before you start.
Amazon Web Services - Example 1
Amazon Web Services - Example 2 A landing diagram has been provided to easily navigate to a

specific category that you wish to work with.
Amazon Web Services - Example 3 P eory ¥

Amazon Web Services - Example 4 - — -
Analytics Application Integration AR & VR

2 H B

Patterns window showing AWS pattern for Import.

Note: When you have the Web Images packet in your model,
do not copy it to another location in the model or save it as
XMI; always use the Model Wizard to import the pattern
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into a new model. The reason for this is that the provided
Diagram Toolbox patterns, described here, refer to the
Image Assets by their GUIDs. Copying the Image Assets will
give them new GUIDs and the Diagram Toolbox patterns

will not work.
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Create an Amazon Web Services
Diagram

You can create a diagram by right-clicking on its parent
Package and selecting the 'Add Diagram' menu option to
display the 'New Diagram' dialog.

If you do not have the AWS Architecture Perspective
selected, click on the drop-down arrow in the Type field and
select 'Analysis > AWS Architecture'.

In the 'Diagram' field type an appropriate name for the
diagram, in the 'Select From' panel click on '"AWS', in the
'Diagram Types' panel click on 'AWS', and then click on the
OK button. The AWS pages of the Diagram Toolbox open,
including:

. AWS Groups - This page provides a number of patterns
that will create a Group with an icon (from an Image
Asset) in the top left corner and the name left-justified at
the top; the exceptions are Auto Scaling Group and
Elastic Load Balancing, which have their icons centered
at the top, and Generic Group and Highlight which don't
have an icon
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(c) Sparx Systems 2022

Groups

Efj Auto Scaling Group

¢3 Availability Zone

¢3 AWsCloud

@ AWSCloud [Alternate)

Efj AWS StepFunctions Workflow
@ Corporate data center

Efj ECZ Instance Contents

@ Elastic Beanstalk Container
Efj Generic Group

@ Generic Group [Alternate)
Efj Private Subnet

@ Public subnet

Efj Region

@ Security Group

Efj Server Contents

¢% Spot Fleet

¥3 VEC

{| Component

AWS Illustrations - This page provides five illustrative
patterns, containing images for Users, Notification,
Devices, Desktop and Office building

llustrations

a Dresktop

a Devices

¢3 Motifications
3] Office Building

a Users

UML Base Types - This page provides a small number of
UML elements that you can use within the AWS diagrams

UML Base Types

= Class

{| Component

& Device
= Node
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Note that the AWS diagrams are automatically set to
Custom Style, and when you right-click on an element in the
diagram you can make use of the Custom Style icons on the
Custom Style Toolbar.

All the icons in the Diagram Toolbox generate Image Assets
as listed in the General Package of the AWS Model Wizard
pattern. The other 22 Packages in the AWS Model Wizard
pattern contain all the other images. Each Package has a
diagram that shows every image that is included in the
Package, and two sub-Packages 'Products' and 'Resources'
containing Image Assets for the images. 'Product' images are
white on dark gray, and 'Resource' images are dark gray on
white.

To add one of these images to your diagram, locate it in the
Browser window by either:

. Searching for it by name or

. Opening the diagram for the Package that you believe it
should be in, finding it in the diagram and pressing Alt+G
to highlight the Image Asset in the Browser window

Now drag-and-drop the Image Asset onto your diagram.
You can choose to:

. Add it as an element with an icon
. Add it as an element with an image, or

. (If you have made an element from the icon already) Add
as link
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Traces to Project Artifacts

You can create expressive diagrams that can show how the
AWS elements relate to other artifacts in your projects.
This is achieved by placing any AWS element into a
diagram and creating a Trace, Dependency, Association or
other relationship between the AWS elements and other
clements such as Requirements, User Stories, Conceptual,
Logical and Physical database tables.

The system must be able to store customers_orders E

historical records for orders for
SEVET Years

utrace®
ar(255

: [customerorder _id =id)

AWS Lambda Amazon @
DynamoDB customers_orders_items

COrders DB

Zoolumn®

AWS diagram showing traces to a requirement and two
database tables.
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More Information

Edition Information

This feature 1s available in the Corporate, Unified and
Ultimate Editions of Enterprise Architect, from Release
15.0.

Enterprise Architect Release 15.2.1559 supports Release 7
of the AWS Architecture graphics file.

(c) Sparx Systems 2022 Page 65 of 1007



Modeling Frameworks 3 October, 2022

ArcGIS Geodatabases

Exchange, Model and Visualize ArcGIS Geodatabases

Enterprise Architect supports the import and export of
ArcGIS geodatabases, allowing you to visualize Features
and Domains within this multi-featured collaboration
platform. In the recent past there has been a separation of
the disciplines between system software development and
geospatial development. In this age of social architecture
and digital disruption almost every project and endeavor
requires some aspect of location information, from simple
delivery services to agricultural, mining, exploration,
weather, real estate and disaster recovery systems.

(D)

ArcGIS Workspace \-9/ CArEGISy
ArcGlS Workspace

+ SmartMeter
+ Features

+ Domains

[P [P [Pem

+ 5patial References

tags

WorkspaceType = esrilocalDatabaseWorkspace

Package diagram showing a Navigation Cell and a Package
containing Features Domains and a Geospatial Reference
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The ArcGIS system, developed by Esri, supports the
development and management of geodatabases. As it 1s for
other databases, it is useful to model the design of a
geodatabase using a standard notation such as UML. You
can perform such modeling in Enterprise Architect, using
the UML profile for ArcGIS. Once you have modeled an
ArcGIS schema in Enterprise Architect, you can export the
model to ArcGIS as an XML Workspace document. You
can also visualize an existing ArcGIS geodatabase schema,
by importing the ArcGIS XML Workspace document into
Enterprise Architect.
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Example Diagram

ArcGIS diagrams allow you to visualize the geographic
features, domains and other elements that make up a
geodatabase schema. In this example a Building has been
sub-typed as a house, the house in turn 1s sub-typed based
on the material type. The subtypes of the House references a
Coded Value Domain also presented in the diagram with
two Domain Code Values:

. Brick
. WeatherBoard

A Smart Meter 1s associated with the house. The House is a
type of Building and the Building contains the property of
Street Address
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Building

wField»
+ StreetAddress: esriFieldTypeString

A

wPointy
House x0bjectClassn
ArcGlS WorkspacenSmartMeter
aFigld® +BelongsTo  H ToMeter + er
+  HouselD: esrifieldTypeGloballD — Fields
+ Material: esriFieldTypeString 1 “RelationshipClass? 0. | ¢ i dingiD: esriFieldTypeGUID
sSubtypeFields +  MeterlD: esrifieldTypeGloballD
+ SubtypeCode: esriFieldTypelnteger=0
«Subtype® wSubtype®
uCodedValueDomainy
aSubtypen aSubtypen Domains::BuildingMaterial
Brick Weatherboard + FieldType: esriFieldType = esriFieldTypeString
) ) + MergePolicy: esriMergePolicyType = esriMPTDefaultValue
©Field» ©Field? + SplitPolicy: esriSplitFolicyType = esriSFTDuplicate
+ Material: BuildingMaterial =BR + Material: BuildingMaterial =WB
aDomainCodedValuen
tags togs + Brick=BR
SubtypeCode=0 SubtypeCode=1 + Weatherboard =WB
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Getting Started

Using the ArcGIS features in Enterprise Architect you can
visualize geodatabases inside this system and collaboration
platform. This allows you to unify teams working in
traditional software-centric and engineering systems with
your geospatial teams defining features and domains. Teams
defining the strategy business rules and requirements for a
system or the components that deliver the system
functionality can share models with the geospatial teams
creating an integrated model that will help with integration
and risk reduction. The multidisciplinary teams can
communicate and collaborate using the collaboration
features including chat, discussion and reviews, ensuring
that the geospatial components are well-considered during
the strategy, specification, analysis, design, implementation
and support of the overall system.

The system must allow allow utility meters including gas,
electricity and water meters to be read remotely.
tags
Business Owner = Distribution Manager
Volatility = Low

wtraces

«ObjectClass» «Point»
SmartMeter

wSubtypeField»
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ArcGIS diagram showing a trace between a Smart Meter
and a formal system requirement.

In this topic you will learn how to work with the features
that support ArcGIS geodatabases outlined, in the sections.

Selecting the Perspective

Enterprise Architect partitions the tool's extensive features
into Perspectives, which ensures that you can focus on a
specific task and work with the tools you need without the
distraction of other features. To work with the ArcGIS
Geodatabases features you first need to select this
Perspective:

EI<perspective name> > Database Engineering > ArcGIS

Setting the Perspective ensures that the ArcGIS diagrams,
their tool boxes and other features of the Perspective will be
available by default.

Example Diagram

An example diagram provides a visual introduction to the
topic and allows you to see some of the important elements
and connectors that are created in specifying or describing
an ArcGIS geodatabase schema including Features and
Domains. Diagrams in other topics will show how Spatial
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References, Geometric Network and Topology can be
modeled in the tool.

Modeling with ArcGIS

This topic introduces the ArcGIS profile, which provides the
diagrams, Toolbox pages and elements that you will wor,k
with including connectivity rules and topologies. You are
able to select the ArcGIS perspective from the Geospatial
group, which will set the tool up for modeling geodabases.

Importing ArcGIS XML Workspaces

This functionality allows you to import an ArcGIS
workspace which 1s an XML document that contains the
geodatabase schema. Any number of schemas can be
imported and then layout tools can be used to show or hide
features, including the ability to show or hide ArcGIS
System features.

Add ArcGlS Model from Pattern

Import ArcGls Workspace XML I;}
Export to ArcGlS Workspace XML

Show or Hide Arcil5 System Fields

About ArcGls Technology

AcrGIS menu options on the Specialize ribbon to Import an
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ArcGIS Workspace.

Exporting ArcGIS XML Workspaces

You can model ArcGIS geodatabse schemas in Enterprise
Architect and when you are happy that they have been
elaborated correctly, including adding Features and Coded
Value and Range domains, they can be exported to an XML
document which in turn can be imported into the Esri tool.

Export Modular ArcGIS Schemas

In Enterprise Architect, you can export discreet parts of
schemas. This 1s useful if you have a large geodatabase
schema, for example a schema defined as part of an industry
reference model. Individual Features (elements) can be
exported using this facility allowing you to incrementally
build up a geodatabase

Validate ArcGIS Workspaces

Enterprise Architect provides a validation services that
allows you to check whether the models that you develop
are compliant with a set of inbuilt system rules for
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well-formed models.

Add ArcGls Model from Pattern

Import ArcGls Workspace XML

Export to ArcGls Workspace XML

Validate ArcGlS Model

About ArciGlS Technology

AcrGIS menu options on the Specialize ribbon to Validate
an ArcGIS model.

More Information

This section provides useful links to other topics and
resources that you might find useful when working with the

ArcGIS Geodatabase tool features.
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More Information

Edition Information

. ArcGIS is available in the Professional, Corporate,
Unified and Ultimate Editions of Enterprise Architect

Notice of Acknowledgement:

Support for modeling ArcGIS databases in Enterprise
Architect was developed in collaboration with the
Commonwealth Scientific and Industrial Research
Organization (CSIRO), who defined mappings between
UML 2 and ArcGIS concepts, and prototyped an automated
import and export capability for ArcGIS geodatabase
schemas represented in UML.
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Validate ArcGIS Workspaces

When you have developed or imported an ArcGIS model,
you can validate it against a set of rules 1n a
system-provided ArcGIS validation table.

Access
Ribbon Specialize > Technologies > ArcGIS >
Validate ArcGIS Model
Context Browser window | Right-click «ArcGIS»
Menu Workspace Package | Specialize | ArcGIS
| Validate ArcGIS Model
Process

The option launches a validation script on the workspace.
While running, the script logs information to the 'ArcGIS
Model Validation' tab of the System Output window. Check
the script output for errors and warnings.

There are two ways to investigate the errors reported by the
model validation script:
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. Expand the System Output window and review the errors
and warnings directly; you can double-click on a warning
or error line to highlight the element or attribute the
message relates to, in the Browser window
or

. Copy all of the output to a text file and open the file using
your preferred text editor; this is likely to provide cleaner
formatting of the script's output
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Importing ArcGIS XML Workspaces

If you have a Geodatabase Workspace XML Document
(containing the ArcGIS schema) you can import it into your
Enterprise Architect project as a UML model.

Before running the import, deselect the 'Sort Features
Alphabetically' checkbox on the 'Objects' page of the
Preferences window (Start > Appearance > Preferences >
Preferences). This ensures that the fields are imported and
organized in Enterprise Architect in the same order as in the
source.

Access

Click on the target Package in the Browser window.

Ribbon Publish > Technologies > Publish >
ArcGIS > Import ArcGIS Workspace
XML or

Publish > Model Exchange > Import

Package > Import Package from
Native/XMI File : Other XML Formats >

ArcGIS
Context Right-click on Package | Specialize |
Menu ArcGIS | Import ArcGIS Workspace
XML
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Keyboard Ctrl+Alt+I : Other XML Formats |
Shortcuts ArcGIS

Import a Geodatabase Workspace XML
document

Option Action

Filename Type in or browse for the name of the
ArcGIS XML file to import.

Create Select the checkbox to create Class

Diagrams diagrams under the imported Packages.

Hide Select the checkbox to hide these

System-Level @ stereotyped attributes:

ArcGlS . RequiredField

F1§1ds on . AttributeIndex

Diagrams

. Spatiallndex

on these stereotyped Classes:
. Point

. Polyline

. Polygon
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. MultiPatch

The 'RequiredField' and 'AttributeIndex’
attributes are also hidden for the Table
(Object Class) Class.

This option is enabled only when the
'Create Diagrams' checkbox is selected.

Strip GUIDs = The 'Strip GUIDs' feature 1s currently
mandatory for ArcGIS imports, which
means that elements are created 'as new'
each time an ArcGIS schema is imported.

Write Log Select the checkbox to write a log of
File import activity (recommended).

The log file is saved in the directory from
which the file is being imported, with the
same name as the imported file plus the
suffix 1mport.log.

View XML Click on this button to view the XML
before import.

Import Click on this button to import the ArcGIS
XML file.

Close Click on this button to close this dialog.

Help Click on this button to display this Help
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page.
Import This field indicates the progress of the
Progress import.

Notes

. ArcGIS is available in the Professional, Corporate,
Unified and Ultimate Editions of Enterprise Architect
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Export Modular ArcGIS Schemas

In Enterprise Architect, in addition to exporting your entire
ArcGIS workspace, you can also export partial schemas.
This 1s useful if you have a large geodatabase schema, as
might be defined in an industry reference model. You might
require the entire schema in some situations, but only
require small parts of it for particular spatial applications,
such as field data collection. In such a scenario, you would
want to export a schema that contains only the Feature
Classes, Tables and Domains that your field data application
uses, without duplicating parts of your original schema
model. You use the «ArcGISSchemaView» stereotyped
Package for this purpose.

An «ArcGISSchemaView» Package 1s modeled as a
subPackage of an ArcGIS Workspace Package. You can
define any number of «ArcGISSchemaView» Packages -
cach representing a different subset of the geodatabase
schema. You specify which parts of the schema are included
by drawing a UML Dependency connector from the
«ArcGISSchemaView» Package to each included Package.
When you export the «ArcGISSchemaView» Package, the
system includes any other Packages that your included
Packages depend on (via Dependency connectors).

This figure shows a partial schema that includes only one of
the three Feature Datasets from the complete schema.
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Feature Datassets

aFeatureDiatassts
A

sArcGI55chemayiews
Partial Sch A = i
arta ema + PointA

aFeatureDatassts
B

+ AbstractClassE
+ PohylineB

aFeastureliatassts
C

Q + PohygonC
]+ MNestedPackagel
]+ MestedPackagel

Create an ArcGISSchema Package

Ste Action
p

1 | Create or open an ArcGIS diagram within your
ArcGIS Workspace.

2 | Drag the ArcGIS Schema View icon from the Core

Diagram Toolbox onto your diagram.
A prompt displays to enter the Package name.
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3 | Type in a meaningful Package name and click on the
OK button.

4 | Drag onto the diagram any other Packages that you
want to include in the exported schema.

(You could achieve the same result using the child
diagram of the «ArcGISSchema View» Package to
draw the included Packages).

5 | Draw a Dependency connector from the
«ArcGISSchema View» Package to each of the other
Packages.

Notes

. Defining the Dependency relationships on a diagram 1s
convenient, but not necessary; as long as the dependencies
are defined in the model — irrespective of whether they
exist on a diagram — the ArcGIS schema exporter will use
them

. You can arrange your dependency diagrams in whatever
part of the ArcGIS Workspace seems appropriate — the
diagrams can reside under the « ArcGISSchema View »
Package itself or under any other element within the
ArcGIS Workspace
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Export an ArcGIS Schema View for use with
ArcCatalog

Ste Action
Y

1  Select the ArcGIS Schema View Package in a
diagram or in the Browser window.

2 Right-click and select the 'Specialize | ArcGIS |
Export to ArcGIS Workspace XML' menu option.

3 | Identify the target file and click on the Export
button.

The system generates a Workspace XML document
containing only the elements associated with the

ArcGIS Schema View Package.

Which related elements are included when
you export an ArcGIS Schema View Package?

These rules apply when you export an ArcGIS Schema
View Package:
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. Dependencies are modeled using the UML Dependency
connector

All elements of a Package that the ArcGIS Schema View
depends on (directly or indirectly) are included in the
generated schema

All fields inherited from Abstract Classes by included
clements are exported, regardless of the Package in which
the Abstract Classes reside

All Coded Value Domain elements to which included
clements refer are exported, regardless of the Package in
which the Coded Value Domain elements reside

If an ArcGIS Schema View Package depends on one or
more subPackages of a Feature Dataset Package, the
Feature Dataset is exported with only those elements
contained in the linked subPackages - no Feature Classes,
Domains and Tables that are directly contained in the
FeatureDataset Package are exported, because of the
Dependency to one of its subPackages; therefore, 1f you
want to export the entire Feature Dataset you must use a
Dependency to the Feature Dataset Package itself

. Ifafield of an included element refers to a Coded Value
Domain element, that Coded Value Domain element 1s
exported, irrespective of whether the ArcGIS Schema
View Package has an explicit dependency on the Coded
Value Domain element's Package

. Ifan included element has a Relationship Class connector
to another element X AND element X 1s not already
included by the ArcGIS Schema View, neither element X
nor the Relationship Class connector are exported; the log
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file will hold a list of names of the Relationship Class

connectors that, for this reason, are not exported

Examples of modeling partial schemas

Consider this complete Workspace, which includes three
Feature Datasets named A, B and C, and three Packages of
Coded Value Domains named DomainsA, DomainsB and

DomainsC:

Festurs Datazsts

sFeatursDatazats
A

Spatial References

+ PointA

+ CodedValeDomainAi
E + CodedValueDomainAZ

+ SpatizlReferenced
+ SpatizlReferencel

aFeatureDatasats
B

DomainsB

= + AbsitraciClassB
+ Pohylin=B

g + CodedValueDomainE

sFeatursDatazats
C

DomainsC

+ PohygonC
1+ MestedPackage!
O+ MestedPackage?

E + CodedValueDomainC

The corresponding model hierarchy in the Browser window

resembles this:
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Browser O x
B £ B35 3

Project | Context Diagram Element

-

4 {51 Model -
A [T] «ArcGIS» ArcGIS Workspace
%E ArcGIS Workspace
%E Partial 5chema Simple Example
[+ 7 «FeatureDatasets A
[+ 7 «FeatureDatasets B
4 [ «FeatureDatasets C b
%E FeaturesC
4 01 MestedPackagel
%E MestedFeatures]
[+ aPointe NestedPaintC
b 1 NestedPackage2
[ «Polygons PolygonC
£1 Domainsa
£1 DomainsE
£1 DomainsC
£ Spatial References

[ S~

7 «ArcGISschemaViews partial 5chema A
‘EE partial 5chema A

-

If you want to export only Feature Dataset A and its
required elements, you can model the Schema as a partial
schema that includes a single Feature Dataset, as shown:

afrcEl55chemaliews «FeatureDatasets
Partial 5chema A A

= + Point&

(This diagram 1s equivalent to the first diagram provided at
the start of the topic.) Assuming that Point A depends on no
other elements, the resulting schema would include only
FeatureDataset A with its Feature Class, Point A.

Now assume that Point A inherits from the Abstract Class
AbstractClassB (defined in FeatureDataset Package B) and
that one of A's fields has type CodedValueDomainA 1
defined in the DomainsA Package (as in the next model
diagram). Now, the same Partial Schema model would result
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in an exported schema that included the fields of
AbstractClassB and CodedValueDomainAl, even though
Partial Schema A does not explicitly depend on Package B
or Package DomainsA, because partial schemas
automatically include elements that are related by
inheritance or are referred to by field types. The exporter
thus helps you to generate valid ArcGIS schemas by
including such required elements.

«FeatureDatasets

{abstract} \\\ -
1 + AbsztractClazzg
«Fields E

+ AbstrsciFieldB: esriFisldTypeSting g *PolylineB

B ::AbstractClassB

(from ArcGIS Workepace)

«Points DomainsA

PointA + CodedValueDomainAd

«Fields / Ig * CodedValueDomainA2
+ FieldA: CodedValueDomainAl

(from AreGI5 Workepace)

If you wanted to include all CodedValueDomains in
DomainsA and all Feature Classes in FeatureDataset B
(including any domains they depended on), you could model
this situation to include entire Packages of elements in a
partial schema via direct and indirect UML Dependency
connectors, as shown.
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whArcG155chemaViews
Partial Schema A

C]+A

]+8B

_| + DomainsA

_| + Partial Schema A

L= + AbzfrsciClazzE

I = + PelylineB

|

I

: DomainsA

| - -
+ A

L————————————————E} cdedValueDomainAl

«FeatureDatasets
A

fm—m—m + AbstraciClazzB

+ PointA
Point4

_|+8

_| + Domainsd

wFeatureDatasets
B

+ CodedValueDomainAZ

3 October, 2022

You can also include Packages via indirect Dependency
connectors. For example, you can achieve the same result as
in the previous example by linking Packages to, say, Feature
Dataset A instead of linking them directly to the ArcGIS
Schema View.

wArciz15S5chemaViews
Partial S5chema A

C]+A

[]+8

1 + DomainsA

1 + Partial Schema A

«FeatureDatasets

=

B + AbzirsctClasst

o
+ PointA

(1+8
.+ Domainsd

«FeatureDatasets
B

+ AbsirsciClaz=E
+ PolylineB

DomainsA

+ CodedValueDomainAl

+ CodedVWalueDomainA2

Finally, if you want to create a partial schema that includes
only the elements in, say, NestedPackagel, you can model
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the scenario as a partial schema Package that refers to nested
Packages within a Feature Dataset.

whrc3155chemaViews NestedPackage1 |
Partial Schema C

é + MestedPointC

1 + MestedPackage1 I ——
]+ Partial Schema C

(from AreGIS Workspace) (from C)

The resulting schema would include a Feature Dataset
named C that contained all elements within
NestedPackagel. The elements in NestedPackage2 would be
excluded, as would PolygonC (assuming no explicit
relationships existed with the elements of NestedPackagel).
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Exporting ArcGIS XML Workspaces

When you have modeled your Geodatabase Workspace
XML Document (containing the ArcGIS schema), you can
export it to an external directory (using the Publish Model
Package facility), from which you can then import it to the
Esri ArcCatalog.

Access

Click on an ArcGIS stereotyped Package (your ArcGIS
Workspace Package) in the Browser window.

Ribbon Specialize > Technologies > ArcGIS >
Export to ArcGIS Workspace XML or

Publish > Model Exchange > Publish

As...
Context Right-click on Package | Specialize |
Menu ArcGIS | Export to ArcGIS Workspace
XML

Keyboard Ctrl+Alt+E : Publish
Shortcuts
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Export the Workspace

Option Action

Root Package Display the name of the selected ArcGIS
Workspace Package.

Filename Type 1n or browse for the file path into
which the XML file 1s to be generated.

XML Type Select 'ArcGIS' as the XML/XMI version
to export the Package to.

Format XML = Format the output into readable XML
Output (this takes a few more seconds at the end
of the run).

Write Log Write a log of the export activity
File (recommended).

The log file is saved to the directory into
which the XML file is exported.

View XML Click on this button to view the exported
XML file.

Export Click on this button to initiate the XML
export.
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Close Click on this button to close this dialog.
Progress Observe the progress of the XML export.
Notes

. ArcGIS is available in the Professional, Corporate,
Unified and Ultimate Editions of Enterprise Architect

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security 1s enabled you must have
'Export XMI' permission to export to XML

. Before exporting your model to an ArcGIS schema, you
must define at least one Spatial Reference element;
Spatial Reference elements are referred to by other
schema elements via a dynamically linked Tagged Value,
named SpatialReference

. The DefaultSpatialReference tag on an ArcGIS Package is
used to specify a Spatial Reference that can be applied to
all Feature Datasets and Feature Classes in the workspace;
therefore, you do not need to apply a Spatial Reference
element to each Feature Dataset or Feature Class

. If you do not reference a Spatial Reference Class from
any Feature Dataset or Feature Class in your ArcGIS
model, Enterprise Architect by default will generate an
XML schema with Unknown type of Spatial Reference
for these elements
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Modeling with ArcGIS

Integration with ArcGIS is built in to the Enterprise
Architect installer. A key component of the technology is
the UML Profile for ArcGIS.

Access
Ribbon Specialize > Technologies > ArcGIS
Context Right-click on Package | Specialize |
Menu ArcGIS

Features

Feature Detail
Profile ArcGIS provides:
Support . ArcGIS Toolbox pages that map

ArcGIS concepts to appropriately
stereotyped UML elements

. A Model Pattern that helps you to start
designing geodatabases quickly and to
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use the required Package structure in
Enterprise Architect

. Datatypes that are specific to the
ArcGIS platform

. Quick Linker capabilities that help you
make valid connections between

elements
ArcGIS The ArcGIS Toolbox contains five core
Toolbox pages:
Pages . Domains - for coded value and range
domains

. Features and Tables - for custom
feature types and tables

. Network Features - for geometric
network and topology Packages

. Raster - for raster datasets

. Workspace - for ArcGIS workspace
and spatial reference information

Two additional Toolboxes group the
objects used specifically in creating
Geometric Network and Topology

diagrams.
Spatial Enterprise Architect helps you to model
References Spatial Reference information for your

ArcGIS schema, including the selection
of predefined coordinate systems and
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associated values.

Show/Hide The ArcGIS elements provided through

System the Toolbox pages contain a number of
Attribute system-assigned attributes that define the
Fields «AttributeIndex», «Spatiallndex» and

«RequiredField» stereotypes. When you
drag an element onto a diagram from the
Toolbox, these attributes are not visible in
the newly-created structure.

If you want to show these system
attributes, right-click on the element(s)
and select the 'Specialize > Technologies
> ArcGIS > Show or Hide ArcGIS
System Fields' ribbon option. Similarly, 1f
you have exposed the attributes and want
to hide them, select the elements and
select the menu option again.

This option does not operate on attributes
or stereotypes you have added to the
selected elements, nor on elements that
you have not selected.

If you do not select any elements, the
option 1s grayed out.

Notes
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. ArcGIS is available in the Professional, Corporate,
Unified and Ultimate Editions of Enterprise Architect
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ArcGIS Toolbox Pages

The ArcGIS Toolbox pages provide elements and
connectors that you can use to model ArcGIS geodatabase
concepts and relationships. The ArcGIS Toolbox consists of
five Core pages:

. Domains - for coded value and range domains
. Features and Tables - for custom feature types and tables

. Network Features - to identify geometric network and
topology Packages

. Raster - for raster datasets

. Workspace - for ArcGIS workspace and spatial reference
information

Two additional Toolboxes group the objects used
specifically in creating Geometric Network and Topology
diagrams.

Access

On the Diagram Toolbox, click on £ to display the 'Find
Toolbox Item' dialog and specify 'ArcGIS:

. Core'
. Geometric Network' or
. Topology'

Ribbon Design > Diagram > Toolbox
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Keyboard Ctrl+Shift+3
Shortcuts

ArcGIS Toolbox Pages
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Diagram toolbox icons
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Toolbox Icon Description

Packages

ArcGIS
Workspace

ArcGIS
Schema
View

(c) Sparx Systems 2022

The geodatabase workspace Package,
which holds all the ArcGIS modeling
elements.

Export the contents of this Package to
produce the Geodatabase XML
Workspace Document, which can be
imported to Esr1 ArcCatalog.

A stereotyped Package that represents a
subset of the geodatabase schema defined
within the ArcGIS Workspace Package.
ArcGIS Schema View Packages are
useful if you need to create partial or
modular schemas based on your complete
geodatabase design. You can create any
number of ArcGIS Schema View
Packages under your ArcGIS Workspace
Package.

Add this element to a diagram under your
workspace, then create a UML
Dependency connector from it to each
Package to include in the generated XML
Workspace Document. For example, you
could include only a subset of your
Feature Datasets and Domains, by

Page 103 of 1007



Modeling Frameworks 3 October, 2022

drawing UML Dependency connectors to
the appropriate Packages.

To export your ArcGIS Schema View for
use with ArcCatalog, right-click on it and
select the 'Specialize | ArcGIS | Export to
ArcGIS Workspace XML' option. The
system generates a Workspace XML
document containing only the elements
associated with the ArcGIS Schema View

Package.
See the Export Modular ArcGIS Schemas
topic.
Feature A stereotyped Package that holds or
Dataset organizes Point, Polyline, Polygon or

Multipatch elements with the same
spatial reference, geometry type and
attribute fields (that is, Feature Classes).

The Feature Dataset is only created under
the ArcGIS Workspace Package; it can
not be created under another Feature
Dataset Package. Feature Dataset
Packages can contain other types of
sub-Package, however, which can be
useful for organizing large Feature
Datasets. When exported to an XML
Workspace document, elements of any
subPackages are included while the
subPackages themselves are ignored,
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resulting in a 'flattened' model hierarchy.

Although ArcGIS prevents Tables
(ObjectClasses) being defined under
Feature Datasets, Enterprise Architect
lets you model Tables under Feature
Datasets for convenience. On export,
Tables are placed at the root level to
create a valid schema.

Geometric An extended UML Package that

Network represents the logical relationships
between features in a network system —
implemented in ArcGIS as a geometric

network.
Raster A stereotyped Package that holds or
Dataset organizes the raster data (as Raster Band
clements).

Topology An extended UML Package that
represents the shared geometry of a set of
Feature Classes from a Feature Dataset.

Elements (in

alphabetical

order)

Abstract A standard UML Abstract Class,

Class representing a concept and set of fields,
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that can be shared by multiple Feature
Classes. Feature Classes that connect to
an Abstract Class via an Inheritance
relationship gain all of its fields. Since
the geodatabase does not directly support
Abstract Classes, inherited fields are
exported into the definition of each child
Feature Class when generating a schema
from the model.

Coded Value = An extended UML Class, representing a
Domain set of valid values that might apply to any
type of attribute.

Concrete A standard UML Class that can represent

Class a Feature Class or a Table in ArcGIS,
depending on the stereotype setting of its
parent Class. If the element has no
stereotyped parent Class, it 1s treated as
an ArcGIS Table (Object Class) by
default.

MultiPatch An extended UML Class, representing
the ArcGIS MultiPatch.

Multipoint An extended UML Class, representing
the ArcGIS Multipoint.

Point An extended UML Class, representing
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Polygon

Polyline

Range
Domain

Raster Band

Raster
Catalog

Raster
StorageDef

Spatial
Reference
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the ArcGIS Point.

An extended UML Class, representing
the ArcGIS Polygon.

An extended UML Class, representing
the ArcGIS Polyline.

An extended UML Class, representing a
valid range of numeric values that might
apply to a numeric type of attribute.

An extended UML Class, representing
one layer of a matrix of cell values.

Every Raster Dataset contains one or
more Raster Bands.

An extended UML Class, representing a
collection of Raster Datasets in the
geodatabase.

An extended UML Class, representing
the storage properties for a Raster value
in the geodatabase; this information is
required when a Raster Dataset Package
element is created.

An extended UML Class that defines the
spatial reference information of your
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Subtype

Table (Object
Class)

Relationships
(in
alphabetical
order)

Association

Connectivity
Rule
(Edge-Edge)
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schema, such as a coordinate system and
XY Tolerance.

You can define one or more Spatial
Reference elements, which you link to
other ArcGIS elements via their Spatial
Reference Tagged Value.

An extended UML Class, holding a
subset of the attributes of an element in
the Feature Dataset.

An extended UML Class, representing a
collection of nonspatial data of the same
type or Class.

A normal UML Association connector.

An extended UML N-ary Association
that models the valid relationships
between edge elements in a Geometric
Network.

For an example, see Connectivity Rule
Examples.

Page 108 of 1007



Modeling Frameworks

Connectivity

Rule
(Edge-Juncti
on)

Dependency

Generalizatio
n

Relationship
Class

Relationship
Class

Relationship
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An extended UML Association that
models the valid relationships between
edge and junction elements in a
Geometric Network.

For an example, see Connectivity Rule
Examples.

A normal UML Dependency connector.

Indicates inheritance from the specific
classifier to a general classifier.

An extended UML Association,
providing the relationship between:

. Two elements in the Feature Dataset,
or

. An element in the Feature Dataset and
an Object Class element

An extended UML Association Class,
providing the attributed relationship
between:

. Two elements in the Feature Dataset,
or

. An element in the Feature Dataset and
an Object Class element

An extended UML Association that

Page 109 of 1007



Modeling Frameworks

Rule

Subtype

Topology
Rule

Attributes (in
alphabetical
order)

Attribute
Index

Domain
Coded Value

Field

Spatial Index
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determines which subtypes can be related
in the geodatabase.

An extended UML Association,
providing the relationship between a
Feature Class element and a Subtype
clement.

An extended UML Association that
connects Feature Class and Subtype
clements in the geodatabase.

An extended UML attribute that
represents the ArcGIS Attribute Index.

An extended UML attribute that specifies
the value of an ArcGIS Coded Value

Domain.

An extended UML attribute that
represents an ArcGIS field of the
geodatabase, 1n a Table or Feature Class.

An extended UML attribute that
represents the ArcGIS Spatial Index.
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Subtype An extended UML attribute that
Field represents the 'subtype' field of an
ArcGIS Table or Feature Class.

TopologyMe = An extended UML attribute that

mbership represents the accuracy ranks of a Feature
Class.
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Connectivity Rule Examples

In an ArcGIS Geometric Network diagram, you can use one
or other of the two Connectivity Rule relationships -
Edge-Junction or Edge-Edge. These examples illustrate the
use of each type.

Edge-Junction Connectivity Rule

«Polylines «Points
Laterals Fittings
«Fieldn «Fields
+ RECORDED_L :ewiFieldTypeDouble = + ANGLE :esriFieldTypelnteger = 150832044
1.0884399808121.. + SUB_TYPE :e=iFieldTypeSting
«SubtypeFields «SubtypeFields
+ SubtypeCode ewiFieldTypeSmalllnteger =1 + SubtypeCode exiFieldTypeSmalllnteger = 11
=Subtypes «Subtypes «Suﬁf‘r‘PEn
aSubtypes «Subtypes «Subtypes
Hydrant laterals Fire laterals Tee
«Fields «Fieldn «Fieldx
+ RECORDED_L :ewiFieldTypeDouble = + RECORDED L :ewiFieldTypeDouble = + ANGLE ewiFieldTypelnteger = 150832044
1.0684399808121.. 1.0884399808121.. + SUB_TYPE ewiFieldTypeSting = TEE
tage tags
SubtypeCode =1 SubtypeCode =2
0.& 1.3

«ConnRules

. The Connectivity-Rule (Edge-Junction) connector is a
UML binary Association connector

. The connection includes one edge element («Point», or
«Subtype» with «Point» as parent) and one junction
element («Polyline», or «Subtype» with «Polyline» as
parent)

. Cardinality can be set from the source and target
'Multiplicity' fields on the connector 'Properties' dialog
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. You can set the 'Source Role' or 'Target Role' fields to
'Default' on the connector 'Properties' dialog

. All the elements within this Edge-Junction rule must be
held in the «GeometricNetwork» Package

Edge-Edge Connectivity Rule

xPolylines
Laterals
«Fields
+ RECORDED_L :esriFieldTypelDouble =
1.0884355808121. ..

aSubtypeFields
+ SubtypeCode ewiFieldTypeSmalllnteger = 1

’T

aSubtypes
aSubtypes
aPaolylines Hydrant laterals
Reoad_cl .
«Fields
«Fields + HEECH@E;EB_L Les'iFiEIdT}'pEEnub.IE =
+ FEA_CODE :ewiFieldTypeSmallinteger= |+ 1.0824259508121..
28718 tage
SubtypeCode = 1
=
El
i
a
rlll [
«Points
Fittings

«Fields
+ AMNGLE ewiFieldTypelnteger = 150832044

+ SUB_TYPE :e=siFieldTypeString

. The Connectivity-Rule (Edge-Edge) connector is a UML
N-ary Association connector

. The connection should include two edge elements
(«Polyline», or «Subtype» with «Polyline» as parent) and
any number of junction elements («Point», or «Subtype»

with «Point» as parent)
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. It is recommended that you use a Direct Association
connector, drawn from one of the edge elements to the
N-ary element, to indicate the 'from' Class - in the
diagram, Road cl is the edge element that is set as the
'from' Class; for the rest of connection, you can use
Association connectors to connect the edge or junction
clement and the N-ary element, drawn either from the
edge or junction elements to the N-ary element, or from
the N-ary element to the edge or junction elements

. Cardinality can be set from the source or target element
'Multiplicity' fields on the connector 'Properties' dialog;
you only need to set the multiplicity of one end of the
connector - 1f both ends are set, only the multiplicity of
the target end 1s used

. You must mark one of the Junction-N-ary connections as
Default, using the 'Source Role' or '"Target Role' field on
the connector 'Properties' dialog

. All the elements within this Edge-Edge rule must be held
in the «GeometricNetwork» Package
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Topology Example

In geodatabases, topology defines the spatial relationship
between geographic features; that is, how Point, Polyline,
and Polygon features share coincident geometry. Topology
1s fundamental to data integrity in a GIS database. In the
Enterprise Architect ArcGIS profile, you use a «Topology»
Package to model data integrity among the Feature Classes.

Modeling topology in the Enterprise Architect ArcGIS
model is simple:

1. Select a «FeatureDataset» Package in which to create
topology relationships.

2. Open the diagram under the «FeatureDataset» Package.

3. From the Diagram Toolbox ArcGIS Network Features
page, drag and drop a «Topology» Package icon onto the
diagram; this creates a Package that will contain all the
elements and relationships that are required for topology
definition.

A Topology defined in Enterprise Architect has these
characteristics:

. The «Topology» Package cannot be created outside a «
FeatureDataset» Package

. Within one «FeatureDataset» Package, multiple
«Topology» Packages can be created

. A Feature Class (Point, Polyline or Polygon) can only
participate in one «Topology» Package

. A Feature Class cannot participate in both a «Topology»
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Package and a «GeometricNetwork» Package

Elements of Topology

Element

Name

List of
Feature
Classes

X,Y Cluster
Tolerance
and

Z Cluster
Tolerance

Accuracy
ranks

(c) Sparx Systems 2022

Description

You can define the name for the
Topology as the «Topology» Package
name.

Either:

. Create new Feature Classes from the
Diagram Toolbox or

. Drag existing Feature Classes from the
Browser window into the «Topology»
Package

You define the cluster tolerance values
using the ClusterTolerance and
ZClusterTolerance Tagged Values of the
«Topology» Package.

Accuracy ranks are defined using the
Tagged Values of the
TopologyMembership attribute, which
you can create using the
"TopologyMembership' icon on the
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"Topology' page of the Diagram Toolbox.

Add this stereotyped attribute to each
Feature Class element and then set a
value for each rank.

. The name of the attribute should be the
name of the «Topology» Package

. You do not need to set the type of the
attribute

Each Feature Class only has one
TopologyMembership attribute. If you do
not add a TopologyMembership attribute
to a Feature Class, the ArcGIS exporter
will generate a set of default ranking
values for you. The values for XYRank
and ZRank are between 1 and 50.

Topology Topology Rules are represented by a

Rules UML Association connector that has the
«TopologyRule» stereotype. You can
create the connector using the "Topology
Rule' icon on the 'Topology' page of the
Diagram Toolbox.

Use this connector to link:

. Two Feature Class («Point», «Polyline»
or «Polygon») elements

. Two «Subtype» elements
. A Feature Class («Point», «Polyline» or
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«Polygon») element to a «Subtype»
element

. A Feature Class («Pointy, «Polyline» or
«Polygony) itself, or

. A «Subtype» element itself

The TopologyRuleType tag is used to
define the type of Topology Rule.

Example Topology Rule connection
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Building

«Fields

+ StrestAddress: esriFieldTypeString

1

«Paoint=
House

«Paoint=

Office

«Field=
+  Material: esriField TypeString

«TopologyMembership =
+ myTopology

«SubtypeField:

+ SubtypeCode: esriField TypeSmallinteger =1

+

«TopologyMembership:

myTopology

1

T

L

«Subtypes «Subtypes
«Subtypes «5Subtypes
Brick Weatherboard
«Fields «Field=
+ Material: BuildingMaterial =BR +  Material: Buildinghaterial =\WB

myRulel

=« TopologyRules

Browser
fHETE T+ L= g

Project | Context Diagram Element

A [O] cArcGISs ArcGIS Workspace

%E ArciGIS Workspace

4 [ «FeatureDatasets Features
%E Features
4 £ «Topology= myTopology
%E myTopology

B «Subtypes Brick
Building
«Point» House
«Points Office

P «Subtype» Weatherboard
[ £ Domains

= W RO

b
—

O x

Properties
H=-m

Conn... Source Target Const.. Bindi.. Tags

4 General
Name myRulel
Type Association
Stereotype ArcGIs:TopologyRule
Source Office
Target Weatherboard
Alias
Direction Unspecified
Style Custom

< TopologyRule ( from ArcGIS )
TopologyRuleType esriTRTPointCoincidePoint

[+ Association
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Relationship Rule Example

In ArcGIS modeling, you can use relationship rules to refine
the cardinality of a «RelationshipClass» connector between
a source Feature Class or Table and a destination Feature
Class or Table; a Relationship Class connector only defines
the initial cardinality, such as one-to-many or
many-to-many.

A relationship rule in Enterprise Architect i1s represented by
a «RelationshipRule» connector, a stereotyped UML
Association connector, which you can create using the
Relationship Rule icon on the 'ArcGIS Core' page of the
Diagram Toolbox. You set the cardinality from the source
and target 'Multiplicity' fields on the connector 'Properties’
dialog.

When creating a «RelationshipRule» connector between two
objects, you must have:

. An existing «RelationshipClass» connector between the
two objects that you want to define the relationship rule
for; 1f there 1s no connector, the «RelationshipRule» you
create 1s ignored during ArcGIS schema generation

. A cardinality range at each end that i1s compatible with the
cardinality of the parent «RelationshipClassy; for
example, if you define a cardinality of 1-M 1n a
«RelationshipClass» connector, the source end of the
«RelationshipRule» connector must be 1, while you can
set the target end of the «RelationshipRule» to a specific
number such as 3 (see the example diagrams in this topic)
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Relationship rules can also restrict the type of object in the
source Feature Class or Table that can be related to a certain
kind of object in the destination Feature Class or Table. For
example, 1f the source Class has no subtype elements, the
relationship rule applies to all features. If the source Class
has subtype elements and the «RelationshipRule» is linked
to one of the subtype elements, this means only the
associated subtype element is related to the
«RelationshipRule». The same restriction 1is also applied to
the destination Feature Class or Table.

Examples

This diagram provides three examples of possible
«RelationshipRule» connections in an ArcGIS model. A
custom Line Thickness has been applied to highlight the
Relationship Class connectors, and the «RelationshipRule»
stereotype label has been hidden where appropriate:
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1) Relationship Rule Links feature class and object class/table.
is owned by v W
«DbjectClasss F ownes By FarcelOwners wns aPolygons
LLiiET= 1 «RelationshipClasss 0.* Parcels
1 1.3
2) Relationship Rule links feature class and subtype.
«Faolylinex . «Points
Bensice Service Service LeskReport Lesk Report LeakReport
1 «FelationshipClasss a.-
1.5 3
aSubtypes wSubtypes
wSubtypes =Subtypes “ardLine_LeskReport
Service Line i
el 1 «RelationshipRules
1
Serviceline_LeakReport
«RelationshipRules
3) Relationship Rule links subtype and subtype.
«Paolylines is installed at LandToWell has «Pointe
Landfill Monitoriell
" q «RelaticnshipClassw =
Subtype: .
& types «Subtypes «Subtypes «Subtypes
SERLE 1 7 Shallowr
. «Subtypes
xSubtypes Municipal =Subtypes aSubtypen
Deep
1.3
xSubtypes =Subtypes wSubtypes «Subtypes
Sanitary 1 Medium
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Setting ArcGIS Coordinate Systems

ArcGIS Feature Classes and Feature Datasets use spatial
references, which consist of a coordinate system and
associated values such as XY resolution and various
tolerance values.

You can capture spatial reference properties using a Class
stereotyped as «SpatialReference», which is available from
the ArcGIS Toolbox pages. The ArcGIS model Pattern
includes a Package named Spatial References, as a
placeholder for creating such elements.

To help you model spatial reference properties, Enterprise
Architect provides a dialog for selecting one of the
predefined coordinate systems supported by ArcGIS. When
you select a Geographic or Projected coordinate system,
Enterprise Architect automatically inserts default values for
the associated properties, such as Well Known Text (WKT),
resolution, precision or tolerances. These values are held as
Tagged Values on the «SpatialReference» element.

You can also add vertical coordinates to a selected

Geographic or Projected coordinate system; the vertical
coordinate is loaded to the VCSWKT and VCSWKID
Tagged Values on the «SpatialReference» element.

This is an example «SpatialReference» element:
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uSpatialReferences
mySpatialReference

tags
CoordinateSystemType = ProjectedCoordinateSystem
HighPrecision = true
LatestWEKID = 4442
mOrigin =-100000
MScale = 10000
MTolerance =0.001
VCSWEID = 5711
VCSWET = <memo>
WHKID = 4462
WET = <memo>
XOrigin =-39261800
X¥5cale = 10000
X¥Tolerance = 0.001
YOrigin =-12320800
Z0rigin =-100000
Z5cale = 10000
ZTolerance = 0.001

Looking at the WKT Tagged Value in the Tags' tab of the
Properties window for this element, you can see that the
'WGS 1984 Australian Centre for Remote Sensing Lambert
Projected Coordinate' system has been selected.
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Properties
H =-H

Element Tags

Mame
General
Type
Stereotype
Alias
Keywords
Status

Version

WET

XOrigin
YOrigin
X¥5cale
Z0rigin
Z5cale
MOrigin
M5cale
X¥Tolerance
ZTolerance
MTaolerance
HighPrecision
LeftLongitude
WEID
LatestWiID
VCSWET
VCSWRID
Class

Project

my5SpatialReference
SpatialReference

ArcGI5:SpatialReference

Proposed

1.0

SpatialReference ( from ArcGIS )
CoordinateSystemType ProjectedCoordinateSystem

<memo=* E
-359261200.000000
-12320800.000000
10000.000000
-100000.000000
10000.000000
-100000. 000000
10000.000000
0.001 000

0.001 000

0.001 000

true

0.000000

4462

4462

<memo=*

5711

You can expand the information held in this Tagged Value

by viewing its Tagged Value Note.
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Tagged Value Mote

PROJCS["WGS_1984_Australian_Centre_for Remote_Sensing_Lambert”, GEOGCS["GCS WGS_1984", DATUM["D_WGS_1984",
SPHEROID["WGS_1384",6378137.0,238 257223563 1], PRIMEM[" Greenwich”,0.0], UNIT[" Degre=",0.0174532925 13943 3]],FRO/
ECTION["Lambert_Conformal_Conic"],PARAMETER["False_Easting”,0.0],PARAMETER[*False_Northing™,0.0],PARAMETER["C
entral_Meridian®,132.0],PARAMETER["Standard_Parallel_1",-18.0],PARAMETER["Standard_Parallel_2",-36.0],PARAMETER["
Latitude_Of_Origin®,-27.0], UNIT[*Meter”,1.0]]|

Define a Spatial Reference element

Ste Action
Y

1 | Open the diagram under the Spatial References
Package of your ArcGIS model.

(You can actually use any ArcGIS diagram in your
model to define Spatial Reference elements;
however, this diagram 1s a convenient placeholder
created by Enterprise Architect's model Pattern for
ArcGIS.)

2 Drag a Spatial Reference element from the
'Workspace' page of the ArcGIS Core Toolbox onto
the diagram.

3 | Riught-click on the Spatial Reference element, and
select the 'Specialize | ArcGIS | Set Coordinate
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System' menu option.
The 'Set Coordinate System' dialog displays.

4 | Expand the Geographic or Projected Coordinate
Systems hierarchy as appropriate and click on the
required coordinate system in the list.

5 | If you want to also apply a vertical coordinate
system, click on the [] button at the right of the
'Vertical Coordinate' field.

The 'Set Vertical Coordinate System' dialog displays,
containing a hierarchy that you again expand and
from which you select a listed vertical coordinate
system.

Click on the OK button to return to the 'Set
Coordinate System' dialog; the 'Vertical Coordinate'
field now displays the system you selected.

6 | Click on the OK button to close the dialog and return
to the diagram.

The Tagged Values for the Spatial Reference
element are updated with the Coordinate System
information you have selected.

Notes
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. You can refer to a «SpatialReference» Class from any
other Feature Dataset or Feature Class in your model,
using the SpatialReference Tagged Value; the
«SpatialReference» Class thus provides a single point of
control, should you need to change the Spatial Reference
information later

. If a Feature Class element references a
«SpatialReference» Class that contains a vertical
coordinate, set the HasZ Tagged Value on that Feature
Class element to true if you want this Feature Class
clement to store three-dimensional data

. If you do not refer to a «SpatialReference» Class from any
Feature Dataset or Feature Class in your ArcGIS model,
the system will generate an XML schema with the
Unknown Spatial Reference type for these elements
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Applying ArcGIS Stereotypes to
Abstract Classes

Using the Enterprise Architect UML Profile for ArcGIS, you
can specify a geometry stereotype on the Feature Classes in
your geodatabase schema. Geometry stereotypes include
«Point», «Polyliney», «Polygon» and «Multipoint», among
others. The ArcGIS Toolbox provides convenient icons for
cach geometry so that you can drag and drop stereotyped
Classes into your geodatabase design model that are
immediately ready to export. These Classes are referred to
as concrete Classes; since their UML property, IsAbstract,
has a value of False, they will be implemented directly in
the geodatabase schema.

However, sometimes it 1s useful to specify the geometry
stereotype on an abstract UML Class so that multiple
concrete Classes can inherit the geometry, as well as Tagged
Values and any fields defined in the abstract Class. This
example models houses and garages as Point Feature
Classes. Both the 'House' and 'Garage' Classes inherit the
'StreetAddress' field from the abstract Class named
'Building'.
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Building
{abstract}

wFields
+ StreetAddress: esriFieldTypeString

‘f

«Points «Points
House Garage

You can create an equivalent model by specifying the
stereotype on the abstract Class and using unstereotyped
concrete Classes for 'House' and 'Garage', as shown:

aPoints
Building
fabstract}

aFields
+ StreetAddress: eswiField TypeString

]

House Garage

The advantages of stereotyping the abstract Class rather than
each concrete Class (especially when you have many such
derived Feature Classes) include:

. It is easier to change the geometry during design time;
you make only one change to the abstract Class
stereotype, which then automatically applies to each
concrete Class
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. Itis quicker to create the model in the first place, because
you have to edit only one set of Tagged Values associated
with the stereotype; the concrete Class might not have to
replicate (or override) any of the Tagged Values
associated with its inherited geometry stereotype

. For the same reason, the overall model is smaller and
simpler

Create an abstract Class with geometry in
the model

A Class 1s considered to be abstract when i1ts UML property
'Abstract' is set to True. When you create a Class using the
'Abstract Class' icon from the ArcGIS toolbox, the 'Abstract'
property is set to True automatically. You can also set the
property manually for any Class, on the 'Details' tab of the
Class 'Properties' dialog.

Ste | Action
p

1 | Open the relevant diagram in your model.

2 | Select the 'Core' page of the ArcGIS Toolbox (click
on £ to display the 'Find Toolbox Item' dialog and
specify 'ArcGIS Core') and drag the 'Abstract Class'
icon onto the diagram to create the element.

3 | If the 'Properties' dialog does not automatically
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display, double-click on the Abstract Class element.

4 | On the 'General' page of the 'Properties' dialog, click
on the 'Stereotype' field [ button and, on the
'Stereotype for Class' dialog, set the 'Profile' to
'ArcGIS' and click on the checkbox against the
required geometry stereotype.

Create a concrete Class that inherits an
abstract Class's geometry stereotype

When you export your model as a geodatabase schema, the
system applies the geometry stereotype from the abstract
Class to any of its derived concrete Classes. Furthermore,
the exporter will add any missing 'system level' fields. For
example, a Class need not specify, nor inherit, a field named
'OBJECTID'. Similarly for the 'Shape', 'Shape Length' and
'Shape Area' fields. Although the exporter will use these
fields 1f they are modeled somewhere in the inheritance
hierarchy, it will automatically generate valid instances of
them as required.

Ste Action
p

1 | Open the diagram that contains the abstract Class.
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Select the 'Core' page of the ArcGIS Toolbox (click
on i to display the 'Find Toolbox Item' dialog and
specify 'ArcGIS Core') and drag the 'Concrete Class'
icon onto the diagram to create the element.

Click on the Generalization icon in the Toolbox and
then click and drag the cursor from the concrete
Class to the abstract Class.

4 | Save your diagram.

N

(c)

otes

Any concrete Class that does not have a stereotype, and
does not inherit one, is exported as a Table (ObjectClass);
its OBJECTID field 1s also inserted if 1t is not defined in
the model

Concrete Classes can only inherit geometry stereotypes or
the «ObjectClass» stereotype from an abstract ancestor
Class; currently, Enterprise Architect does not support
stereotype inheritance from other concrete Classes

In addition to inheriting the stereotype, concrete Classes
also inherit fields from ancestor abstract Classes

You can inherit the stereotype from an abstract Class at
any level in inheritance hierarchy; for example, the
abstract Class that specifies the geometry can be the
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grandparent of the concrete Class, rather than the parent
Class

. Multiple shapes for a single Feature Class are not
supported by ArcGIS, nor by Enterprise Architect's
ArcGIS profile; therefore, it would be a modeling error if
a concrete Class inherited from more than one
geometry-stereotyped abstract Class

. If you specify a given tag on a concrete Class that 1s
already present in one of its parent abstract Classes, the
concrete Class has precedence and its Tagged Value will
be exported to the schema

. Enterprise Architect does not require you to show the
Object and Feature Esri1 Classes on a diagram, nor even
include them in your model, because the system implicitly
applies their characteristics when you apply a geometry or
ObjectClass stereotype to a Class

. It1s not, however, an error to include the Object and
Feature Esr1 Classes and model Generalization links to
them, even though they are typically not marked as
abstract
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Unified Profile for DoDAF/MODAF
(UPDM)

UPDM (Unified Profile for DoODAF-MODAF) provides a
UML profile that extends the capability of Enterprise
Architect to provide a standard approach for modeling

systems and Enterprise Architectures in support of DoDAF
and MODAF.

DoDATF is the abbreviation of Department of Defense

Architecture Framework (USA); MODAF is the
abbreviation of Ministry of Defence Architecture
Framework (UK).

Discussion

The topics described here provide an introduction to, and
procedural explanation of, using UPDM in Enterprise
Architect.

Section Content

Welcome This section provides an introduction to
D UPDM, and explains the support

| available for the Framework and the
system requirements for its use.

Licensing = These topics contain the formal
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Copyright = documentation defining the use of the
and MDG Technology for UPDM with
Trademarks = Enterprise Architect.

l’/

Using UPDM = Work with UPDM, learning about the
[ model structure, templates, diagram types

> and more.
Model Learn how to develop and configure
Validation  model validation for UPDM.
q;H-l
:|
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Brief Introduction

AUPDM

& —d MDG Technologyw

Welcome to the UPDM 2.0 profile in Sparx Systems
Enterprise Architect.

This UML profile extends the capability of Enterprise
Architect to support the creation of Unified Profile for
DoDAF and MODAF (UPDM) architecture models.
DoDAF is the abbreviation of Department of Defense
Architecture Framework (USA); MODATF is the
abbreviation of Ministry of Defence Architecture
Framework (UK).

The UPDM profile provides a standard approach for
modeling systems and enterprise architectures in support of
DoDAF and MODAF. It improves interoperability of
architecture data among architecture modeling tools,
enhances reuse of architecture data, and improves
communication among DoDAF and MODAF stakeholders.

UPDM is already integrated with the Enterprise Architect
Ultimate and Unified Editions; an MDG Technology can be
purchased separately to be used with the Enterprise
Architect Professional or Corporate Editions.

This technology is based on the Unified Profile for
DoDAF-MODAF (UPDM) version 1.0. UPDM 1.0 is based
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on DoDAF version 1.5 and MODAF version 1.2. Full
details of the profile, including the latest specification, can
be obtained from the Object Management Group (OMGQG)
website.

Getting Started

For instructions on how to use UPDM, see the topics
Getting Started with UPDM and Using UPDM.
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UPDM Support

Technical support for the UPDM profile is available to
registered users of Enterprise Architect in exactly the same
way as for Enterprise Architect itself.
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UPDM System Requirements

The UPDM profile version 2.0 runs under these
environments:

Operating Systems

. Windows 10

. Windows 8

. Windows 7

. Windows 2008 Server

. Windows 2003 Server

. Windows XP Service Pack 2

Enterprise Architect Versions

. Enterprise Architect Version 9.0 or later
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Licensing Copyright and Trademarks

For the Sparx Systems MDG Technology for UPDM, this
topic provides the:

. Copyright Notice

. Software Product License Agreement (or End User
License Agreement) and

. The acknowledgement of trademarks of other products
referenced in the User Interface and documentation
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MDG Technology for UPDM Copyright
Notice

This legal information concerns the copyright ownership of
Enterprise Architect and of any 3rd party tools of code that
require a statement of copyright ownership.

Copyright © 2010 - 2022 Sparx Systems Pty.
Ltd. All rights reserved.

The software contains proprietary information of Sparx
Systems Pty Ltd. It is provided under a license agreement
containing restrictions on use and disclosure and 1s also
protected by copyright law. Reverse engineering of the
software 1s prohibited. Please read the product license
agreement for full details.

Due to continued product development, this information
may change without notice. The information and intellectual
property contained herein is confidential between Sparx
Systems and the client and remains the exclusive property of
Sparx Systems. If you find any problems in the
documentation, please report them to us in writing. Sparx
Systems does not warrant that this document is error-free.
No part of this publication may be reproduced, stored in a
retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording or
otherwise without the prior written permission of Sparx
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Systems. Licensed users are granted the right to print a
single hardcopy of the user manual per licensed copy of the
software, but may not sell, distribute or otherwise dispose of
the hardcopy without written consent of Sparx Systems.

Sparx Systems Pty. Ltd.

99 Albert St,

Creswick, Victoria 3363,

AUSTRALIA

Phone: +61 (3) 5345 1140

Fax: +61 (3) 5345 1104

Support Email: support@sparxsystems.com

Sales Email: sales(@sparxsystems.com

Website: sparxsystems.com
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MDG Technology for UPDM Software
Product License Agreement

This Software Product License Agreement relates to the
separately-purchased MDG Technology for UPDM for use
with the Corporate and Professional Editions of Sparx
Systems Enterprise Architect. Where the MDG Technology
for UPDM is integrated with the Ultimate and Unified
Editions of Enterprise Architect, it 1s covered by the Sparx
Systems Enterprise Architect Modelling Tool.

MDG Technology for UPDM, Enterprise Architect MDG
Add-In, Version 2.0.

Copyright (C) 2010 - 2022 Sparx Systems Pty Ltd. All
Rights Reserved

IMPORTANT-READ CAREFULLY: This End User
License Agreement ("EULA") 1s a legal agreement between
YOU as Licensee and SPARX for the SOFTWARE
PRODUCT identified above. By installing, copying, or
otherwise using the SOFTWARE PRODUCT, YOU agree
to be bound by the terms of this EULA. If YOU do not
agree to the terms of this EULA, promptly delete the unused
SOFTWARE PRODUCT.

The copyright in the SOFTWARE PRODUCT and its
documentation is owned by Sparx Systems Pty Ltd, A.B.N
38 085 034 546. Subject to the terms of this EULA, YOU
are granted a non-exclusive right for the duration of the
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EULA to use the SOFTWARE PRODUCT. YOU do not
acquire ownership of copyright or other intellectual property
rights in any part of the SOFTWARE PRODUCT by virtue
of this EULA.

Your use of this software indicates your acceptance of this
EULA and warranty.

DEFINITIONS

In this End User License Agreement, unless the contrary
intention appears:

. "EULA" means this End User License Agreement

. "SPARX" means Sparx Systems Pty Ltd A.C.N 085 034
546

. "LICENSEE" means YOU, or the organization (if any) on
whose behalf YOU are taking the EULA

. "Registered Edition of MDG Technology for UPDM"
means the edition of the SOFTWARE PRODUCT, which
is available for purchase from the web site:
https://sparxsystems.com/updm/purchase.html, following
a thirty-day free evaluation period

. "SOFTWARE PRODUCT" or "SOFTWARE" means
MDG Technology for UPDM, which includes computer
software and associated media and printed materials, and
may include online or electronic documentation

. "SUPPORT SERVICES" means email-based support
provided by SPARX, including advice on usage of the
SOFTWARE PRODUCT, investigation of bugs, fixes,
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repairs of models, if and when appropriate, and general
product support

. "SPARX SUPPORT ENGINEERS" means employees of
SPARX who provide on-line support services

. "TRIAL EDITION" means the edition of the
SOFTWARE PRODUCT, which 1s available free of
charge for evaluation purposes for a period of thirty (30)
days

GRANT OF LICENSE

In accordance with the terms of this EULA, YOU are
granted the following rights:

. To install and use one copy of the SOFTWARE
PRODUCT, or in its place, any prior version for the same
operating system, on a single computer; as the primary
user of the computer on which the SOFTWARE
PRODUCT is installed, YOU may make a second copy
for your exclusive use on either a home or portable
computer

. To store or install a copy of the SOFTWARE PRODUCT
on a storage device, such as a network server, used only to
install or run the SOFTWARE PRODUCT over an
internal network; if YOU wish to increase the number of
users entitled to concurrently access the SOFTWARE
PRODUCT, YOU must notify SPARX and agree to pay
an additional fee
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. To make copies of the SOFTWARE PRODUCT for
backup and archival purposes only

EVALUATION LICENSE

The TRIAL EDITION is not free software. Subject to the
terms of this agreement, YOU are hereby licensed to use the
SOFTWARE PRODUCT for evaluation purposes without
charge for a period of thirty (30) days.

Upon expiration of the thirty (30) days, the Software
Product must be removed from the computer. Unregistered
use of the SOFTWARE PRODUCT after the 30-day
evaluation period is in violation of Australian, U.S. and
international copyright laws.

SPARX may extend the evaluation period on request and at
their discretion.

If YOU choose to use the SOFTWARE PRODUCT after the
30-day evaluation period, a license must be purchased (as
described at https://sparxsystems.com/updm/purchase.html).
Upon payment of the license fee, YOU will be sent details
on where to download the registered edition of the software
product and will be provided with a suitable software 'key'
by email.

ADDITIONAL RIGHTS AND LIMITATIONS
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YOU hereby undertake not to sell, rent, lease, translate,
adapt, vary, modify, decompile, disassemble, reverse
engineer, create derivative works of, modify, sub-license,
loan or distribute the SOFTWARE PRODUCT other than as
expressly authorized by this EULA.

YOU further undertake not to reproduce or distribute license
key-codes except under the express and written permission

of SPARX.

If the Software Product purchased is an ACADEMIC
EDITION, YOU acknowledge that the license 1s limited to
use 1n an educational context, either for self-education or
use 1n a registered teaching institution. The ACADEMIC
EDITION may not be used to produce commercial software
products or be used in a commercial environment, without
the express written permission of SPARX.

ASSIGNMENT

YOU may only assign all your rights and obligations under
this EULA to another party if YOU supply to the transferee
a copy of this EULA and all other documentation including
proof of ownership. Your license 1s then terminated.

TERMINATION

Without prejudice to any other rights, SPARX may
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terminate this EULA if YOU fail to comply with the terms
and conditions. Upon termination YOU or YOUR
representative shall destroy all copies of the SOFTWARE
PRODUCT and all of its component parts or otherwise
return or dispose of such material in the manner directed by
SPARX.

WARRANTIES AND LIABILITY

WARRANTIES
SPARX warrants that:

. The SOFTWARE PRODUCT will perform substantially
in accordance with the accompanying written materials
for a period of ninety (90) days from the date of receipt,
and

. Any SUPPORT SERVICES provided by SPARX shall be
substantially as described in applicable written materials
provided to YOU by SPARX, and SPARX SUPPORT
ENGINEERS will make commercially reasonable efforts
to solve any problems associated with the SOFTWARE
PRODUCT.

EXCLUSIONS

To the maximum extent permitted by law, SPARX excludes,
for itself and for any supplier of software incorporated in the
SOFTWARE PRODUCT, all liability for all claims,
expenses, losses, damages and costs made against or
incurred or suffered by YOU directly or indirectly
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(including without limitation lost costs, profits and data)
arising out of:

« YOUR use or misuse of the SOFTWARE PRODUCT;

. YOUR inability to use or obtain access to the
SOFTWARE PRODUCT;

. Negligence of SPARX or its employees, contractors or
agents, or of any supplier of software incorporated in the
SOFTWARE PRODUCT, in connection with the
performance of SPARX's obligations under this EULA; or

. Termination of this EULA by either party for any reason.
LIMITATION

The SOFTWARE PRODUCT and any documentation are
provided "AS IS" and all warranties, whether express,
implied, statutory or otherwise, relating in any way to the
subject matter of this EULA or to this EULA generally,
including without limitation, warranties as to: quality;
fitness; merchantability; correctness; accuracy; reliability;
correspondence with any description or sample, meeting
your or any other requirements; uninterrupted use;
compliance with any relevant legislation; and being error or
virus free are excluded. Where any legislation implies in this
EULA any term, and that legislation avoids or prohibits
provisions in a contract excluding or modifying such a term,
such term shall be deemed to be included in this EULA.
However, the liability of SPARX for any breach of such
term shall, if permitted by legislation, be limited, at
SPARX's option to any one or more of the following upon
return of the SOFTWARE PRODUCT and a copy of the
receipt:
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. If the breach relates to the SOFTWARE PRODUCT:

. The replacement of the SOFTWARE PRODUCT, or the
supply of an equivalent SOFTWARE PRODUCT,;

. The repair of such SOFTWARE PRODUCT, or the
payment of the cost of replacing the SOFTWARE
PRODUCT, or of acquiring an equivalent SOFTWARE
PRODUCT; or

. The payment of the cost of having the SOFTWARE
PRODUCT repaired.

. If the breach relates to services in relation to the
SOFTWARE PRODUCT:

. The supplying of the services again; or

. The payment of the cost of having the services supplied
again.

TRADEMARKS

All names of products and companies used in this EULA,
the SOFTWARE PRODUCT, or the enclosed
documentation may be trademarks of their corresponding
owners. Their use in this EULA 1is intended to be in
compliance with the respective guidelines and Licenses.

GOVERNING LAW
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This agreement shall be construed in accordance with the
laws of the Commonwealth of AUSTRALIA, in the state of

Victoria.
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Acknowledgement of Trademarks -

UPDM

Trademarks of Microsoft

. Microsoft®
. Windows®

Trademarks of the OMG

. OMG™

. Object Management Group™
. UML™

. Unified Modeling Language™

(c) Sparx Systems 2022

Page 153 of 1007



Modeling Frameworks 3 October, 2022

Using UPDM

UPDM is the Unified Profile for the Department of Defense
Architecture Framework (DoDAF) and Ministry of Defence
Architecture Framework (MODAF). UPDM is an Object
Management Group (OMG) 1nitiative; the specification is
available from the OMG website.

You can perform UPDM modeling within Enterprise
Architect, using these facilities:

. The UPDM Profile, which defines the stereotyped UML
elements that are used for UPDM modeling

. Custom diagram types for each UPDM view

. Custom Diagram Toolbox pages for each UPDM diagram
type, which give easy access to the elements used on
diagrams of that type

. Options within the Model Wizard (Start Page 'Create from
Pattern' tab) that can be used to import a template Package
for each UPDM view and that provide a brief description
of the view and what might be expected of the modeler

. Quicklinks for stereotyped elements that guide you
towards creating correct relationships between elements

. Model Validation rules that you can apply to check your
models for correctness

. Relationship Matrix profiles for showing the relationships
between elements

. Model Views that help you navigate your model quickly
to find specific diagram more easily
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. A Glossary import, with items describing each UPDM
stereotype for easy reference

. Tagged Values that you can use to enter metadata specific
to UPDM elements

. An Example Model that illustrates a typical UPDM
problem and its solution, implemented using Enterprise
Architect
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Getting Started with UPDM

When you install the Unified or Ultimate Edition of
Enterprise Architect, the UPDM profile is fully enabled and
ready to use.

If you have the Corporate or Professional Edition of
Enterprise Architect, you can purchase and install an MDG
Technology for UPDM separately; once you have entered
the registration key for the MDG Technology for UPDM, it
1s automatically available in and integrated with Enterprise
Architect, as for the Unified and Ultimate Editions.

Access the MDG Technology

1. Create a new Enterprise Architect project file, and click
on the top-level Package.

2. Select the 'Design > Package > Model Wizard' option.

3. In the Start Page 'Create from Pattern' tab (Model
Wizard), select the 'Systems Engineering > UPDM'
Perspective and the '"UPDM Frameworks' Pattern Group;
select either the 'DoDAF Framework' Pattern or the
'MODAF Framework' Pattern.

4. Click on the Create Model(s) button.

A new base DoDAF or MODAF model is created in the
Browser window.
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Model Wizard in UPDM

You can create UPDM models within your project using
templates selected from the Enterprise Architect Model
Wizard (Start Page 'Create from Pattern' tab).

Access
Ribbon Design > Package > Model Wizard
Context Browser window | Right-click on
Menu Package | Add a Model using Wizard >

Model Patterns

Keyboard Ctrl+Shift+M
Shortcuts

Notes

. In the Model Wizard, click on the <perspective name>
button and select 'System Engineering > UPDM'

. Expand the '"UPDM Frameworks' group or one of the
'DoDAF' or ' MODAF' groups, and click on the required
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Pattern in that group

. Click on the Create Model(s) button to generate the
corresponding UPDM model structures in your project
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UPDM Extensions Menu

You can perform various tasks on your UPDM model using
the UPDM Technology menu.

Access
Ribbon Specialize > Technologies > UPDM 2.0
Context Right-click on Package, diagram or
Menu element | Specialize | UPDM 2.0
Options
Option Action
Synchronize | Add missing Tagged Values to all
Tagged clements in the model that require them.
Values
Import Import UPDM information into the
Glossary Enterprise Architect Glossary.
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Import Import the alternative images (as used in
Images the UPDM Framework diagram) into the
current model.

You can use these images to decorate
your own models (select a diagram
object, right-click and select 'Appearance
| Select Alternate Image') or you can
design your own.

Help Display this Help topic.

About Show the version of the MDG
Technology for UPDM that you are
using. The version number has the format
1.0.001, where 1.0 is the version of the
UPDM specification that 1s supported,
and 001 1s the incremental build number.
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UPDM Framework Diagram

When developing and distributing a model, it is useful to
have a single front page diagram that has hyperlinks to all
the important information in the model. That is the aim of
the two UPDM Framework diagrams (one for DoDAF, one
for MODAF), which are created with color-coded
swimlanes for each set of views. You can drag and drop on
to these diagrams:

. Packages, which act as hyperlinks to the documents that
they own

. Document Artifacts

. Any kind of composite element that points to its child
diagram

. Hyperlinks pointing to custom SQL queries, Relationship
Matrix profiles or external files

Create a UPDM Framework Diagram

1. In the Start Page 'Create from Pattern' tab (Model
Wizard), click on the <perspective name> button and
select 'System Engineering > UPDM'.

2. Expand the 'UPDM Frameworks' group and click on the
required Pattern, either 'DODAF Framework' or' MODAF
Framework'.

3. Click on the Create Model(s) button to generate the
corresponding UPDM model structures in your project.
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Strategic View

«CV-1» | «CV-2» { «CV-3e | «CV-4» { «CV-5¢ | «CV-6» | «CV-T»
-1 cv-2 -3 cv4 V-5 o6 o7

«OV-1= «OV-2 «OV-3= «OV-4» =04 «OV-5s «OV-6as
ov-1 ov-2 ov-3 OV-4 Actual OV-4 Typical ovs Ov-b6a

Service Oriented View
T

Systems View

aSW-1e «SV-2% aSV-3e «SV-ds aSW-5e «SV-H» aSW-Tw
V-1 V-2 V-3 V4 SV-5 V-6 V-7

Editing Swimlanes

You can add, remove and modify the swimlanes on the
Framework diagram. Select 'Design > Diagram > Manage >
Swimlanes'.

To change the width of swimlanes, use the mouse to drag
their boundaries.

Changing Appearances

Each Package, document and hyperlink on the Framework
diagram has an alternative image. To load these images into
your model, select the 'Settings > Reference Data > Images'
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option.

If you want to apply your own bitmap images to the UPDM
clements, you must first import the images into the model,
also using the 'Settings > Reference Data > Images' option.
Then you can either select the element and press
Ctrl+Shift+W to add an alternative image to the element, or
you can apply your own stereotype to apply a Shape Script
to the element. For example, you might define a stereotype
with this Shape Script:

shape main

{

v_align="center";

h_align="center";

defS1ze(90,70);
image("myBitMap.bmp",0,0,100,100);

printWrapped("#name#");
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UPDM Diagram Types

UPDM introduces a number of custom diagram types into
Enterprise Architect. These are, for the most part, extended
UML diagrams. On opening a UPDM diagram, Enterprise
Architect automatically opens the appropriate UPDM
Diagram Toolbox pages for the diagram type.

You can use the UPDM diagrams that are generated by the
Model Wizard (Start Page 'Create from Pattern' tab), or
create a new UPDM diagram.

Access
Ribbon Design > Diagram > Add Diagram
Context Browser window | Right-click on
Menu Package | Add Diagram

Notes

. On the 'New Diagram' dialog, select ' UPDM' in the 'Select
From' panel and the appropriate diagram type in the
'Diagram Types' panel
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. Click on the OK button to open the Diagram View with
the empty diagram displayed
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UPDM Toolbox Pages

When you open a diagram, Enterprise Architect opens the
Diagram Toolbox pages that are most useful for that
particular diagram type. For a UPDM diagram, Enterprise
Architect opens the Toolbox pages that contain elements
and relationships appropriate to the particular View that the
diagram is part of, as well the pages for the diagram type.
For example, if you open an SOV-5 Activity diagram,
Enterprise Architect opens the 'SOV-5 Elements' page, the
'UML Activity' page and the 'UML Activity Relationships'

page.
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In addition, the 'Common Elements' and 'Common
Relationships' pages and various global task pages of the
Diagram Toolbox are always available, regardless of which
diagram is open.

If you hide the default Toolbox pages and want to get them
back, simply switch to the Start Page and back to the current
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diagram, and all the default Toolbox pages for the current
diagram type are re-opened.

All UPDM Stereotypes

For your convenience, a Diagram Toolbox page is provided
that includes every stereotype in the UPDM profile, listed in
alphabetical order. If you cannot remember which
context-sensitive Toolbox page a stereotype appears in, just
go to the 'All UPDM Stereotypes' Toolbox page instead. To
make this page available at all times, either:

. Select the 'Specialize > Technologies > Manage
Technology' ribbon option, select 'UPDM Technology' in
the table, and click on the Set Active button, or

. Select 'UPDM 2.0' from the list box on the Default Tools
toolbar
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UPDM Stereotypes

ActualMeasurementSet

A set or collection of measurements; used in AV-3, OV-3,
SV-6 and SV-7.

Extensions:

. Object

Constraints:

. Classifier must be a MeasurementSet
Use:

. Press Ctrl and drag a MeasurementSet element from the
Browser window to create an instance, or drop an
ActualMeasurementSet from the Diagram Toolbox and
press Ctrl+L to set the classifier; set the Run State and
enter actual values for each of the classifier's attributes

ActualOrganization

An actual specific organization as an instance of an
organization Class; used in AcV-1, OV-4, StV-5, TV-1 and
TV-2.

Extensions:
. Object
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Generalizations:

. ActualOrganizationalResource
Constraints:

. Classifier must be an Organization

Use:

. Press Ctrl and drag an Organization from the Browser
window to create an instance, or drop an
ActualOrganization from the Diagram Toolbox and press
Ctrl+L to set the classifier

. Can have a set of 'ratifiedStandards' (Standard)
. Can be 'responsibleFor' a set of ActualProject

. Can be client and/or supplier of an
ActualOrganizationRelationship

. Can be client of an OwnsProcess dependency to an
Operational Activity

ActualOrganizationRelationship

A relationship between two actual organizational resources
(organizations or posts); used in OV-4,

Extensions:
. InformationFlow
Constraints:

. Supplier must be an ActualOrganizationalResource
(ActualOrganization or ActualPost)
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. Client must be an ActualOrganizationalResource
(ActualOrganization or ActualPost)

. Realizes a Resourcelnteraction

ActualPerson

A named individual that fulfills an ActualPost; used in
OovV-4.

Extensions:

. Object

Constraints:

. Classifier must be a Person
Use:

. Press Ctrl and drag a Person from the Browser window to
create an instance, or drop an ActualPerson from the
Diagram Toolbox and press Ctrl+L to set the classifier

. Can be a client of a FillsPost dependency to an ActualPost

ActualPost

An actual, specific post, as an instance of the Post Class;
used in AcV-1, OV-4 and StV-5.

Extensions:
. Object
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Generalizations:

. ActualOrganizationalResource
Constraints:

. Classifier must be a Post

Use:

. Press Ctrl and drag a Post from the Browser window to
create an instance, or drop an ActualPost from the
Diagram Toolbox and press Ctrl+L to set the classifier

. Can be responsible for a set of ActualProject

. Can be client and/or supplier of an
ActualOrganizationRelationship

. Can be client of an OwnsProcess dependency to an
Operational Activity

. Can be supplier of a FillsPost dependency from an
ActualPerson

ActualProject

A time-limited attempt to create a specific set of products or
services; used in AcV-1, AcV-2, StV-3, StV-5 and SV-8.

Extensions:
. Object
Constraints:

. Classifier must be a Project
Use:
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. Press Ctrl and drag a Project from the Browser window to
create an instance, or drop an ActualProject from the
Diagram Toolbox and press Ctrl+L to set the classifier

. Can have Aggregations to or from another ActualProject

. Can have a set of 'ownedMilestones' (type
ActualProjectMilestone, including IncrementMilestone,
OutOfServiceMilestone, NoLongerUsedMilestone and
DeployedMilestone)

ActualProjectMilestone

An event in a project by which progress 1s measured; used
in AcV-2, StV-3, StV-5 and SV-8.

See also: IncrementMilestone, OutOfServiceMilestone,
NoLongerUsedMilestone and DeployedMilestone.

Extensions:

. Object

Specializations:

. IncrementMilestone

. OutOfServiceMilestone
. NoLongerUsedMilestone
. DeployedMilestone
Constraints:

. Classifier must be a ProjectMilestone
Use:
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. Can have a set of associated Resource
. Can be client/supplier of a MilestoneSequence

Alias

A comment used to define an alternative name for an
element; used in AV-2.

Extensions:

. Note

Constraints:

. AnnotatedElement must be a UPDMElement
Use:

. Just drag a Quicklink NoteLink from the Alias to the
annotated element

Arbitrary Relationship

Represents a visual indication of a connection used 1n high
level operational concept diagrams. The connections are
purely visual and cannot be related to any architectural
semantics; used in OV-1.

Extensions:
. Dependency
Constraints:
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. Client and Supplier must both be stereotyped
ConceptRole

Use:
. Drag a Quicklink from a ConceptRole

ArchitecturalDescription

A specification of a system of systems at a technical level,
which also provides the business context; used in AV-1.

Extensions:
. Package

Use:

. Can have a DefinesArchitecture Realization to an
EnterprisePhase

. Can have an ArchitecturalReference Dependency to
another ArchitecturalDescription

. Can be annotated with an ArchitectureMetadata note

ArchitecturalReference

Asserts that one architectural description refers to another;
used in AV-1.

Extensions:
. Dependency
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Constraints:

. Client and Supplier must both be stereotyped
ArchitecturalDescription

Use:
. Drag a Quicklink from an ArchitecturalDescription.

ArchitectureMetadata

Information on architectural description; used in AV-1.
Extensions:

. Note

Generalizations:

. Metadata

Constraints:

. AnnotatedElement must be an ArchitecturalDescription
Use:

. Drag a quicklink from an ArchitecturalDescription

Capability

A high-level specification of the enterprise's ability; used in
AV-1,0V-2,SOV-3, StV-1, StV-2, StV-3, StV-4, StV-5,
StV-6, SV-1 and SV-9.

Extensions:
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. Class
Generalizations:

. SubjectOfForecast
Use:

. Can have a set of associated environment conditions
stereotyped Environment

. Capabilities can be composed of Capabilities (Composite
aggregation)

. Capabilities can be dependent on Capabilities
(Dependency)

. Capabilities can sub-class Capabilities (Generalization)

. Can be supplier or client of a Forecast (both must be same
stereotype) (from SubjectOfForecast)

CapabilityConfiguration

A set of physical and human resources (and their

interactions) configured to provide a capability; used in
OV-1, OV-2, OV-3, StV-3, StV-5, SV-1, SV-3, SV-9,
SV-10a, SV-12, TV-1, TV-2 and AcV-2.

Extensions:

. Class
Generalizations:
. Resource

. Conceptltem
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Performer
Resourcelnteractionltem
SubjectOfResourceConstraint
SubjectOfForecast
SystemsElement
SubjectOfResourceStateMachine
Resourcelnteractionltem

Specializations:

SystemsNode

Use: Can:

Have a set of associated deployed milestones, stereotyped
DeployedMilestone

Have an optional associated no longer used milestone,
stereotyped NoLongerUsedMilestone

Have a set of associated increment milestones,
stereotyped IncrementMilestone

Have an optional associated out of service milestone,
stereotyped OutOfServiceMilestone

Be annotated by a StandardConfiguration note
Be the type of a ConceptRole (from Conceptltem)

Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

Be the client of a RealizesCapability Realization to a
Capability (from Resource)

Be the client of a ProvidesCompetence Dependency to a
Competence (from Resource)
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. Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

. Be the supplier or client of a Forecast Dependency (both
must have same stereotype) (from SubjectOfForecast)

. Own a ServicePoint (from Resource)
. Own a RequestPoint (from Resource)
. Own a ResourcePort (from Resource)

. Be the source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be the type of a KnownResource (from Resource)
. Be the type of a ResourceRole (from Resource)

. Have a Performs Dependency to a PerformedActivity
(Function or OperationalActivity) (from Performer)

Climate

A type of weather condition, or combination of weather
conditions, in which a Performer performs; used in StV-2.

Extensions:

. Class
Generalizations:

. EnvironmentalType

Use:
. Can be the type of an EnvironmentProperty
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Commands

Asserts that one OrganizationalResource commands
another; used in OV-4, SV-1 and SV-10c.

Extensions:

. InformationFlow

Generalizations:

. Resourcelnteraction

Constraints:

. Source must be an OrganizationalResource
. Target must be an OrganizationalResource
Use:

. Conveys a DataElement

CompatibleWith

Relates a node to a location to assert that the operational
node must be situated at that location; used in OV-2.

Extensions:

. Dependency
Constraints:

. Client is a Node
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. Supplier is a ReferredLocation (Location or
PhysicalLocation)

Use:
. Drag a Quicklink from a Node

Competence

A specific set of abilities defined by knowledge, skills and
attitude; used in OV-4, SV-1 and SV-9.

Extensions:

. Class
Generalizations:

. SubjectOfForecast
Use: Can be:

. The supplier or client of a Forecast Dependency (both
must have same stereotype) (from SubjectOfForecast)

. The supplier of a ProvidesCompetence Dependency
. The supplier of a RequiresCompetence Dependency

ConceptRole

A relationship that asserts that a Conceptltem forms part of
the high level operational concept; used in OV-1.

Extensions:
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. Part

Constraints:

. Type is a Conceptltem

Use:

. Owned by a HighLevelOperationalConcept

. Can be supplier and client of an ArbitraryRelationship
dependency

ConfigurationExchange

CapabilityConfigurations that are exchanged between
Nodes; used in OV-2, OV-3 and OV-6c¢.

Extensions:

. InformationFlow

Generalizations:

. OperationalExchange

Constraints:

. Source is a Node (from OperationalExchange)
. Target is a Node (from OperationalExchange)
Use:

. Conveys a CapabilityConfiguration

Controls
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A type of Resourcelnteraction where one Resource controls
another; used in SV-1 and SV-10c.

Extensions:

. InformationFlow
Generalizations:

. Resourcelnteraction
Constraints:

. Source is an OrganizationalResource (Organization or
Post)

. Target is a ManufacturedResourceType (ResourceArtifact
or Software)

Use:
. Conveys a DataElement

DataElement

A formalized representation of data that 1s managed by or
exchanged between systems; used in OV-4, SV-1, SV-2,
SV-4, SV-6, SV-10a, SV-10b and SV-11.

Extensions:

. Class

Generalizations:

. SubjectOfResourceConstraint
. Resourcelnteractionltem
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. SystemsElement
. SubjectOfResourceStateMachine

Use:

. Can have an attached ResourceConstraint (from
SubjectOfResourceConstraint)

. Can have a set of associated defined Entityltems

. Can be conveyed on a Controls or Commands information
flow

DataExchange

A DoDAF alias for Resourcelnteraction.
Extensions:

.« InformationFlow

Generalizations:

. Resourcelnteraction

. SystemsElement

Use:

. Conveys Resourcelnteractionltem (Energy, Post,
Organization, CapabilityConfiguration, Software,
ResourceArtifact, or DataElement)

DefinesArchitecture
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Establishes a relationship between ArchitecturalDescription
and EnterprisePhase; used in AV-1.

Extensions:

. Realization

Constraints:

. Client is an ArchitecturalDescription

. Supplier is an EnterprisePhase

Use:

. Drag a Quicklink from an ArchitecturalDescription

Definition

A definition of an element in the architecture; used in AV-2.
Extensions:

. Note

Constraints:

. Annotated Element is a UPDMElement

Use:

. Drop from toolbox and drag a NoteLink to any UPDM
clement

DeployedMilestone
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Asserts that an ActualOrganizationResource started to use,
or 1s slated to start using, a CapabilityConfiguration from a
specific point in time; used in StV-5.

Extensions:

. Object

Generalizations:

. ActualProjectMilestone
Constraints:

. Classifier must be a ProjectMilestone (from
ActualProjectMilestone)

Use: Can:

. Have a set of associated (usedBy)
ActualOrganizationalResource (ActualOrganization or
ActualPost)

. Have a set of associated Resource (from
ActualProjectMilestone)

. Be client/supplier of a MilestoneSequence (from
ActualProjectMilestone)

EnduringTask

A type of behavior recognized by an enterprise as being
essential to achieving its goals - that 1s, a strategic
specification of what the enterprise does; used in StV-1.

Extensions:
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. Class
Use:
. Target of association from EnterprisePhase

Energy

Energy to be exchanged between Nodes; used in OV-2,
OV-3, OV-5, SV-1, SV-4 and SV-6.

Extensions:

. Class

Generalizations:

. Resourcelnteractionltem

. OperationalExchangeltem

Use:

. Conveyed on an EnergyExchange information flow

EnergyExchange

A relationship specifying the need to exchange energy
between nodes; used in OV-2, OV-3 and OV-6c.

Extensions:
. InformationFlow

Generalizations:

(c) Sparx Systems 2022 Page 187 of 1007



Modeling Frameworks 3 October, 2022

. OperationalExchange

. OperationalElement

Constraints:

. Source 1s a Node (from OperationalExchange)
. Target is a Node (from OperationalExchange)
Use:

. Conveys a Class stereotyped Energy

EnterpriseGoal

A specific required objective of the enterprise that the
architecture represents; used in StV-1.

Extensions:

. Class

Use:

. Has an association to one EnterprisePhase

EnterprisePhase

A specific, required objective of the enterprise that the
architecture represents; used in AV-1, StV-1, StV-2, StV-5
and SV-9.

Extensions:
. Class
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Specializations:
. WholeLifeEnterprise

Use:

. Can have a set of associations (statementTasks) to
EnduringTask Class

. Can have a set of associations (exhibits) to Capability
Class

. Can have a set of associations (inhabits) to Environment
Class

. Can have a set of associations (goals) with EnterpriseGoal
Class

. Can have a set of associations (visions) with
EnterpriseVision Class

. Can be the type of a StructuralPart or TemporalPart

. Fulfills a Mission Use Case
. Can be Supplier of a DefinesArchitecture Realization

EnterpriseVision

The overall aims of an enterprise over a given period of
time; used in StV-1.

Extensions:

. Class

Use:

. Has an association to one EnterprisePhase

(c) Sparx Systems 2022 Page 189 of 1007



Modeling Frameworks 3 October, 2022

EntityAttribute

A defined property of an Entityltem; used in OV-7 and
SV-11.

Extensions:

. Attribute

Use:

. Is owned by an Entityltem

Entityltem

A definition (type) of an item of interest; used in OV-7 and
SV-11.

Extensions:

. Class

Constraints:

. Owned attributes must be stereotyped Entity Attribute
Use: Can:

. Be owned by a DataModel

. Be the end type of an EntityRelationship

. Have a set of associated (definedBy) DataElement

. Have a set of associated (represents) InformationElement
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. Be conveyed on a Commands or Controls information
flow

EntityRelationship

Asserts that there 1s a relationship between two Entityltems;
used in OV-7 and SV-11.

Extensions:
. Association
Constraints:

. The types of any object at either end must be stereotyped
Entityltem

Environment

A definition of the conditions in which the Enterprise exists
or functions; used in AV-1 and StV-2.

Extensions:

. Class

Constraints:

. Owned attributes must be EnvironmentProperty

EnvironmentProperty
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Asserts that an Environment has one or more properties
such as Climate, Location or LightCondition; used in StV-2.

Extensions:
. Attribute
Constraints:

. Type must be an Environmental Type (LightCondition,
Location, PhysicalLocation or Climate)

Use:
. Owned by an Environment element

Equipment

A physical resource that is used to accomplish a task or
function in a system or an environment; used in SV-1.

Extensions:

. Part
Generalizations:
. ResourceRole
Constraints:

. Class must be an OrganizationResource (Organization or
Post)

. Type must be a ResourceArtifact
Use:
. Can have a RequiresCompetence dependency to a
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Competence (from ResourceRole)

. Can have a set of associations (usedFunctions) to
Function (from ResourceRole)

ExhibitsCapability

Assertion that a Node is required to have a Capability; used
in OV-2.

Extensions:

. Dependency

Constraints:

. Client must be a Node

. Supplier must be a Capability

Expose

Assertion that a service interface exposes a capability.
Extensions:

. Dependency

Constraints:

. Client must be a Servicelnterface

. Supplier must be a Capability
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Externalindividual

An individual defined by an external ontology; used in
AV-2,

Extensions:

. Object

Use:

. Can be the supplier of a SameAs dependency

ExternalNode

Operational node that is external to the architecture; used in
OV-2.

Extensions:

. Class

Generalizations:

. Node

. Performer

Use: Can:

. Own a RequestPoint Port (from Node)
. Own a ServicePoint Port (from Node)

. Be client of an ExhibitsCapability dependency to a
Capability (from Node)

. Have a Performs dependency to a PerformedActivity
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(Function or OperationalActivity) (from Performer)

. Have a CompatibleWith dependency to a
ReferredLocation (PhysicalLocation or Location) (from

Node)

ExternalType

A type defined by an external ontology; used in AV-2.
Extensions:
. Class

Use:
. Can be the Supplier of a SameAs dependency

. Any UPDM element can have a Generalization to an
External Type

FieldedCapability

A deployed and fully realized instance of a capability; used
in SV-2.

Extensions:

. Object

Constraints:

. Its classifier must be a CapabilityConfiguration

(c) Sparx Systems 2022 Page 195 of 1007



Modeling Frameworks 3 October, 2022

FillsPost

Asserts that ActualPerson fills an ActualPost; used in OV-4.
Extensions:

. Dependency

Constraints:

. Client must be an ActualPerson

. Supplier must be an ActualPost

Forecast

The actual or predicted status of a system at a project
milestone; used in SV-9.

Extensions:

. Dependency
Specializations:

. TechnologyForecast
Constraints:

. Client and Supplier are both SubjectOfForecast (Standard,
Competence, Capability, CapabilityConfiguration,
Organization, Post, ResourceArtifact or Software)

. Client and Supplier must be the same specialization of
SubjectOfForecast
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Function

An activity that 1s specified in context of the resource that
performs it; used in OV-4, SV-1, SV-4, SV-5 and SV-10a.

Extensions:

. Activity

Generalizations:

. PerformedActivity

. SystemsElement

. SubjectOfResourceConstraint
Constraints:

. Owned parameters are FunctionParameter
Use: Can:

. Be Supplier of a Performs dependency (from
PerformedActivity)

. Own ServiceOperationAction, FunctionAction and
FunctionEdge

. Be Client of an ImplementsOperational dependency to an
Operational Activity (from SystemsElement)

. Have an attached ResourceConstraint (from
SubjectOfResourceConstraint)

FunctionAction
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A call behavior action that invokes the function that needs to
be performed; used in SV-4.

Extensions:

. Action (Call Behavior)
Specializations:

. SystemFunctionAction
Constraints:

. Activity is stereotyped Function
Use:

. Ctrl+L to set the function

FunctionEdge

Models the flow of control/objects through a function; used
in SV-4,

Extensions:

. ControlFlow

Generalizations:

. SystemsElement

Specializations:

. SystemFunctionEdge

Constraints:

. Source must be a ServiceOperationAction
. Target must be a ServiceOperationAction
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Use:

. Can realize a Resourcelnteraction (Right-click | Advanced
| Information Flows Realized)

FunctionParameter

Represents inputs and outputs of a Function; used in SV-4.
Extensions:

. ActivityParameter

Constraints:

. Type must be a Resourcelnteractionltem (Energy,
DataElement, CapabilityConfiguration, Organization,
Post, ResourceArtifact or Software)

Use:
. Owned by a Function

HighLevelOperationalConcept

A generalized model for operations; used in OV-1.
Extensions:

. Class

Constraints:

. Owned attributes are ConceptRole
Use:
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. Can have a set of described Mission

HostedSoftware

Asserts that software 1s hosted on a ResourceArtifact; used
in SV-1.

Extensions:

. Part

Generalizations:

. ResourceRole

Constraints:

. Owning Class must be a ResourceArtifact

. Type must be a Software

Use: Can:

. Have a RequiresCompetence dependency to a
Competence (from ResourceRole)

. Have a set of associations to 'used' Functions (from
ResourceRole)

HumanResource

The role of a Post or Organization in a
CapabilityConfiguration; used in SV-1.

Extensions:
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. Part

Generalizations:

. ResourceRole

Constraints:

. Owning Class must be a CapabilityConfiguration

. Type must be an OrganizationalResource (Organization or
Post)

Use: Can:

. Have a RequiresCompetence dependency to a
Competence (from ResourceRole)

. Have a set of associations to 'used' Functions (from
ResourceRole)

ImplementsOperational

Relationship between a system element and the operational
element that it implements; used in SV-35.

Extensions:

. Dependency

Constraints:

. Client must be a SystemsElement (Function)

. Supplier must be an OperationalElement
(Operational Activity)
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IncrementMilestone

An ActualProjectMilestone that indicates the point in time at
which a project 1s predicted to deliver or has delivered a
Capability; used in AcV-2, StV-3 and SV-8.

Extensions:

. Object

Generalizations:

. ActualProjectMilestone
Constraints:

. Classifier must be a ProjectMilestone (from
ActualProjectMilestone)

Use:

. Can be the supplier or client of a MilestoneSequence
dependency (from ActualProjectMilestone)

. Can have a set of associated Resource (from
ActualProjectMilestone)

. Has a set of associations with CapabilityConfiguration

InformationElement

Information exchanged between nodes; used in OV-2,
OV-3, OV-5, OV-6a, OV-6b and OV-7.

Extensions:
. Class
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Generalizations:

. OperationalExchangeltem

. SubjectOfOperational Constraint

. SubjectOfOperationalStateMachine
. OperationalElement

Use: Can:

. Have a set of associations with (represented by)
Entityltem Classes

. Be conveyed on an InformationExchange - right-click >
Advanced > Information Items Conveyed

. Have an attached OperationalConstraint (from
SubjectOfOperationalConstraint)

. Own an OperationalStateMachine (from
SubjectOfOperationalStateMachine)

InformationExchange

A relationship specifying the need to exchange information
between nodes; used in OV-2, OV-3 and OV-6c.

Extensions:

. InformationFlow
Generalizations:

. OperationalExchange
Constraints:

. Conveys an InformationElement
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. Source is a Node (from OperationalExchange)
. Target is a Node (from OperationalExchange)

InternalDataModel

DoDAF alias for PhysicalDataModel; used in SV-11.
Extensions:

. Package

Generalizations:

. PhysicalDataModel

. DataModel

Constraints:

. Owns Entityltem elements (from DataModel)

KnownResource

Asserts that a known resource plays a part in the
architecture; used in OV-2.

Extensions:
. Part
Generalizations:

. NodeChild
Constraints:
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. Type must be a Resource (Post, Organization,
CapabilityConfiguration, SystemsNode, Software or
ResourceArtifact)

. Class must be a NodeParent (Node or
Logical Architecture) (from NodeChild)

LightCondition

A specification of environmental lighting conditions; used
in StV-2.

Extensions:

. Class
Generalizations:

. Environmental Type
Use:

. Can be the type of an EnvironmentProperty (from
Environmental Type)

Location

A general specification of the surroundings/scenario in
which an operation might take place. Examples include
'desert’, 'arctic', 'at sea'; used in OV-1 and OV-2.

Extensions:
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. Class
Generalizations:

. ReferredLocation

. Conceptltem

. EnvironmentalType
Use: Can be:

. Supplier to a CompatibleWith dependency from a Node
(from ReferredLocation)

. Type of a ConceptRole (from Conceptltem)

. The type of an EnvironmentProperty (from
Environmental Type)

LogicalArchitecture

A composite structure model whose parts are either
NodeRoles, ProblemDomains, or KnownResources; used in

OV-2.

Extensions:

. Class

Generalizations:

. NodeParent

Use:

. Can own ProblemDomain properties
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LogicalDataModel

A specification of business information requirements as a
formal data structure; used in OV-7.

Extensions:

. Package

Generalizations:

. DataModel

Constraints:

. Owns Entityltem elements (from DataModel)

MapsToCapability

Asserts that a StandardOperational Activity is in some way
part of a capability; used in StV-6.

Extensions:

. Dependency

Constraints:

. Client must be a StandardOperational Activity
. Supplier must be a Capability

MaterielExchange
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Materiel that 1s exchanged between Nodes; used in OV-2,
OV-3 and OV-6c.

Extensions:

. InformationFlow

Generalizations:

. OperationalExchange

Constraints:

. Source is a Node (from OperationalExchange)
. Target is a Node (from OperationalExchange)
Use:

. Can convey a ResourceArtifact or Software

Measurement

A category of measures; used in AV-3, OV-2 and SV-7.
Extensions:

. Attribute

Specializations:

. PerformanceParameter

Use:

. Owned by a MeasurementSet Class

MeasurementSet
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A set or collection of Measurements; used in AV-3, OV-3
and SV-7.

Extensions:

. Class

Constraints:

. Owned attributes must be Measurement
Use:

. Has a set of associations with (measuredElement)
UPDMElement

. Is classifier of ActualMeasurementSet object

Metadata

Annotation that can be applied to any element in the
architecture; used in AV-1.

Extensions:

. Note

Specializations:

. ArchitectureMetadata

MilestoneSequence

A relationship between two milestones; used in AcV-2 and
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SV-8.

Extensions:

. Dependency

Constraints:

. Client must be an ActualProjectMilestone

. Supplier must be an ActualProjectMilestone

Mission

A purpose to which a person, organization, or autonomous
system 1is tasked; used in AV-1, OV-1, OV-6a and OV-6b.

Extensions:

. UseCase

Generalizations:

. SubjectOfOperationalConstraint

. SubjectOfOperationalStateMachine
Use:

. Fulfilled by an EnterprisePhase

. Can have an attached Operational Constraint (from
SubjectOfOperational Constraint)

. Can own an OperationalStateMachine (from
SubjectOfOperationalStateMachine)
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MovementOfPeople

MODATF alias for OrganizationalExchange.
Extensions:

. InformationFlow

Generalizations:

. OrganizationalExchange

Use:

. Conveys an OrganizationalResource (Organization or
Post)

Needline

Documents the requirement to exchange information
between nodes; used in OV-2 and OV-3.

Extensions:

. Association

. Connector

Generalizations:

. OperationalElement

Constraints:

. End Types must be Node

. End Roles must be NodePort

. End Roles must be NodeChild (NodeRole,
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ProblemDomain, KnownResource)
Use:

. Realizes an OperationalExchange - create a Needline
between the same two elements as an
OperationalExchange, then right-click on the Needline
and select 'Advanced > Information Flows Realized'

NoLongerUsedMilestone

Asserts that an ActualOrganizationResource ceased to use -
or is slated to cease using - a CapabilityConfiguration from
a specific point in time; used in StV-5.

Extensions:

. Object

Generalizations:

. ActualProjectMilestone
Constraints:

. Classifier must be a ProjectMilestone (from
ActualProjectMilestone)

Use:

. Has set of associations to 'noLongerUsedBy'
ActualOrganizationalResource (ActualOrganization or
ActualPost) objects

. Can have a set of associated Resource (from
ActualProjectMilestone)
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. Can be client/supplier of a MilestoneSequence (from
ActualProjectMilestone)

. Has a set of associations with 'configuration’
CapabilityConfiguration Classes

Node

Logical entity that performs operational activities; used in
OV-1, OV-2, OV-3, OV-5,OV-6a, OV-6b and OV-6c.

Extensions:

. Class

Generalizations:

. Performer

. Conceptltem

. NodeParent

. SubjectOfOperationalConstraint
. SubjectOfOperationalStateMachine
. OperationalElement
Specializations:

. OperationalNode

Constraints:

. Owned ports must be NodePort, RequestPoint or
ServicePoint

Use: Can:
. Have a Performs dependency to a PerformedActivity
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(Function or OperationalActivity) (from Performer)

. Be the Client of a CompatibleWith dependency to a
ReferredLocation (Location or PhysicalLocation)

. Be the type of a ConceptRole (from Conceptltem)
. Own a RequestPoint port
. Own a ServicePoint port

. Be client of an ExhibitsCapability dependency to a
Capability

. Own NodeChild (NodeRole, KnownResource,
ProblemDomain) (from NodeParent)

. Be source and target of an OperationalExchange
(ConfigurationExchange, EnergyExchange,
InformationExchange, MaterielExchange or
OrganizationalExchange) information flow

. Be the end type of a Needline association

. Have an attached OperationalConstraint (from
SubjectOfOperational Constraint)

. Own an OperationalStateMachine (from
SubjectOfOperationalStateMachine)

. Be the type of a NodeRole
. Own ServiceOperations

NodePort

A property of a Node that specifies a distinct interaction
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point between the node and its environment or between the
node and its internal parts.

Extensions:
. Port
Constraints:

. Type must be an OperationalExchangeltem (Post,
Organization, ResourceArtifact or System)

Use:
. Owned by a Node
. Can be the ends of a Needline

NodeRole

Used to link a parent Node to its sub-nodes; used in OV-2,
OV-3 and OV-6c.

Extensions:

. Part

Generalizations:

« NodeChild
Specializations:

. ProblemDomain
Constraints:

. Class must be a Node
. Type must be a Node
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OperationalActivity

A logical process, specified independently of how the
process 1s carried out; used in OV-2, OV-3, OV-4, OV-5,
OV-6a, OV-6b and SV-5.

Extensions:

. Activity

Generalizations:

. PerformedActivity

. SubjectOfOperationalConstraint

. OperationalElement

. SubjectOfOperationalStateMachine
Specializations:

. StandardOperational Activity
Constraints:

. Owned parameters must be OperationalParameter
Use: Can:

. Be Supplier of a Performs dependency (from
PerformedActivity)

. Be Supplier of an OwnsProcess dependency
. Be the Activity/Behavior of an Operational ActivityAction
. Be the owner of an Operational ActivityEdge

. Have an attached OperationalConstraint (from
SubjectOfOperationalConstraint)
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. Be the Supplier of a SupportsOperational Activity
dependency

. Own an OperationalStateMachine (from
SubjectOfOperationalStateMachine)

OperationalActivityAction

A call behavior action that invokes the activity to be
performed; used in OV-5.

Extensions:

. CallBehaviorAction

Constraints:

. Activity/Behavior must be an Operational Activity
Use:

. Can be the Source or Target of an
Operational ActivityEdge

OperationalActivityEdge

Models the flow of control/objects through an
Operational Activity; used in OV-35.

Extensions:
. ControlFlow
Generalizations:
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. OperationalElement

Constraints:

. Must be owned by an Operational Activity

. Source must be an Operational ActivityAction
. Target must be an Operational ActivityAction
Use: Can:

. Have a set of Operational Exchange
(ConfigurationExchange, EnergyExchange,
InformationExchange, MaterielExchange or
OrganizationalExchange) information flows that it
realizes

. Carry a set of Operational Exchangeltem (Post,
Organization, ResourceArtifact or System)

OperationalConstraint

A rule governing an operational behavior or property; used
in OV-6a.

Extensions:

. Constraint
Specializations:

. OperationalRule
Constraints:

. Constrained element must be a
SubjectOfOperational Constraint (Operational Activity,
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Node, InformationElement or Mission)

OperationalMessage

Message for use in an Operational Event Trace, which
carries any of the subtypes of OperationalExchange; used in

OV-6c.

Extensions:

. Message
Generalizations:

. OperationalElement
Use:

. Can have a set of OperationalExchange
(ConfigurationExchange, EnergyExchange,
InformationExchange, MaterialExchange or
OrganizationalExchange) information flows that it
realizes

OperationalNode

An element of the operational architecture that produces,
consumes, or processes information.

Extensions:
. Class
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Generalizations:

Node

Constraints:

Owned ports must be NodePort, RequestPoint or
ServicePoint

Use: Can:

Have a Performs dependency to a PerformedActivity
(Function, Operational Activity) (from Performer)

Be the Client of a CompatibleWith dependency to a
ReferredLocation (Location or PhysicalLocation)

Be the type of a ConceptRole (from Conceptltem)
Own a RequestPoint port
Own a ServicePoint port

Be client of an ExhibitsCapability dependency to a
Capability

Own NodeChild (NodeRole, KnownResource,
ProblemDomain) (from NodeParent)

Be source and target of an OperationalExchange
(ConfigurationExchange, EnergyExchange,
InformationExchange, MaterielExchange or
OrganizationalExchange) information flow

Be the end type of a Needline association

Have an attached OperationalConstraint (from
SubjectOfOperationalConstraint)

Own an OperationalStateMachine (from
SubjectOfOperationalStateMachine)
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. Be type of a NodeRole
. Own ServiceOperations

OperationalParameter

Represents inputs and outputs of an operational activity;
used in OV-5.

Extensions:
. ActivityParameter
Constraints:

. Type must be an OperationalExchangeltem (Post,
Organization, ResourceArtifact or System)

Use:
. Can be owned by an Operational Activity

OperationalRule

A DoDATF alias for Operational Constraint.
Extensions:

. Constraint

Generalizations:

. OperationalConstraint

Constraints:
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. Constrained element must be a
SubjectOfOperationalConstraint (Operational Activity,
Node, InformationElement or Mission) (from
OperationalConstraint)

OperationalStateMachine

A StateMachine describing an operational behavior or
property; used in OV-6b.

Extensions:
. StateMachine
Constraints:

. Owner 1s SubjectOfOperationalStateMachine (Mission,
InformationElement or Node)

Organization

A group of persons, associated for a particular purpose; used
in OV-4, SV-1, SV-3, SV-9, SV-10a and SV-12.

Extensions:

. Class

Generalizations:

. OrganizationalResource
. Resource, Performer
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SubjectOfForecast
SubjectOfResourceConstraint

Use: Can:

Be classifier to an ActualOrganization

Be source or target of a Commands information flow
(from OrganizationalResource)

Be the owning Class of a PostRole
Be the Class or type of a SubOrganization

Be the Class of an Equipment (from
OrganizationalResource)

Be conveyed by an OrganizationalExchange (from
OrganizationalResource)

Be the type of a HumanResource (from
OrganizationalResource)

Be the source of a Controls information flow (from
OrganizationalResource)

Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

Be the client of a RealizesCapability realization to a
Capability (from Resource)

Be the client of a ProvidesCompetence dependency to a
Competence (from Resource)

Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

Be supplier or client of a Forecast dependency (both must
have same stereotype) (from SubjectOfForecast)
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. Own a ServicePoint (from Resource)
. Own a RequestPoint (from Resource)
. Own a ResourcePort (from Resource)

. Be source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be type of a KnownResource (from Resource)
. Be type of a ResourceRole (from Resource)

. Have a Performs dependency to a PerformedActivity
(Function or Operational Activity) (from Performer)

OrganizationalExchange

A relationship specifying flow of people across
organizations; used in OV-2, OV-3 and OV-6c.

Extensions:

. InformationFlow
Generalizations:

. OperationalExchange
Specializations:

. MovementOfPeople
Constraints:

. Conveyed element must be an OrganizationalResource
(Organization or Post)

. Source is a Node (from OperationalExchange)
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. Target is a Node (from OperationalExchange)

OutOfServiceMilestone

A project milestone that indicates a project's deliverable 1s
to go out of service; used in AcV-2, StV-3 and SV-8.

Extensions:

. Object

Generalizations:

. ActualProjectMilestone

Constraints:

. Classifier must be a ProjectMilestone
Use:

. Has a set of association (‘configuration') with
CapabilityConfiguration

. Can have a set of associated Resource (from
ActualProjectMilestone)

. Can be client/supplier of a MilestoneSequence (from
ActualProjectMilestone)

OwnsProcess

A relationship that asserts that an
ActualOrganizationalResource has responsibility for an
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Operational Activity; used in OV-4.
Extensions:

. Dependency

Constraints:

. Client must be an ActualOrganizationalResource
(ActualPost or ActualOrganization)

. Supplier must be an Operational Activity

Part

Use of a ResourceArtifact as a part of another
ResourceArtifact; used in SV-1.

Extensions:

. Part

Generalizations:

. ResourceRole

Specializations:

. SubSystemPart

Constraints:

. Class must be a ResourceArtifact
. Type must be a ResourceArtifact
Use: Can have:

. A RequiresCompetence dependency to a Competence
(from ResourceRole)
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. A set of associations to 'used' Functions (from
ResourceRole)

PerformanceParameter

A category of quality measures that address how well a
Performer meets Capability needs.

Extensions:
. Attribute
Generalizations:
. Measurement

Use:
. Owned by a MeasurementSet class

Performs

Links a Performer to the behavior that it can perform; used
in OV-2, OV-3, OV-4, OV-5, SV-1 and SV-4.

Extensions:
. Dependency
Constraints:

. Client must be a Performer (Node, ExternalNode,
OperationalNode, Post, Organization,
CapabilityConfiguration, SystemsNode, Software or
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ResourceArtifact)

. Supplier must be a PerformedActivity
(Operational Activity or Function)

Person

A type of human being; used in OV-4.
Extensions:

. Class

Use:

. Can be Classifier of an ActualPerson

PhysicalDataModel

An implementable specification of a data structure; used in
SV-11.

Extensions:

. Package
Generalizations:

. DataModel
Specializations:

. InternalDataModel
Constraints:
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. Owns Entityltem elements (from DataModel)

PhysicalLocation

Anywhere that can be specified; used in OV-1 and OV-2.
Extensions:

. Class

Generalizations:

. ReferredLocation

. Conceptltem

. Environmental Type

Use: Can be:

. Supplier to a CompatibleWith dependency from a Node
(from ReferredLocation)

. Type of a ConceptRole (from Conceptltem)

. The type of an EnvironmentProperty (from
Environmental Type)

Platform

Use of an artifact as a platform 1n a particular
ResourceConfiguration; used in SV-1.

Extensions:
. Part
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Generalizations:

. ResourceComponent

. ResourceRole

Constraints:

. Class must be a CapabilityConfiguration
. Type must be a ResourceArtifact

Use:

. Can have a RequiresCompetence dependency to a
Competence (from ResourceRole)

. Can have a set of associations to 'used' Functions (from
ResourceRole)

Post

A type of point of contact or responsible person; used in
OV-4, SV-1, SV-3, SV-9, SV-10a and SV-12.

Extensions:

. Class

Generalizations:

. OrganizationalResource
Resource

Performer
SubjectOfForecast
SubjectOfResourceConstraint
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Use: Can:

Be Classifier of an ActualPost
Be the Type of a PostRole

Be source or target of a Commands information flow
(from OrganizationalResource)

Be the Class of an Equipment (from
OrganizationalResource)

Be conveyed by an OrganizationalExchange (from
OrganizationalResource)

Be the type of a HumanResource (from
OrganizationalResource)

Be the source of a Controls information flow (from
OrganizationalResource)

Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

Be client of a RealizesCapability realization to a
Capability (from Resource)

Be client of a ProvidesCompetence dependency to a
Competence (from Resource)

Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

Be supplier or client of a Forecast dependency (both must
have same stereotype) (from SubjectOfForecast)

Own a ServicePoint (from Resource)
Own a RequestPoint (from Resource)
Own a ResourcePort (from Resource)
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. Be source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be type of a KnownResource (from Resource)
. Be type of a ResourceRole (from Resource)

. Have a Performs dependency to a PerformedActivity
(Function, Operational Activity) (from Performer)

PostRole

Asserts that a post exists in an organization; used in OV-4
and SV-1.

Extensions:

. Part

Generalizations:

. OrganizationRole

. ResourceRole

Constraints:

. Class must be an Organization
. Type must be a Post

Use: Can have a:

. RequiresCompetence dependency to a Competence (from
ResourceRole)

. Set of associations to 'used' Functions (from
ResourceRole)
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ProblemDomain

The boundary containing those Nodes that can be realized
by functional resources; used in OV-2.

Extensions:

. Part

Generalizations:

. NodeRole

. NodeChild

Constraints:

. Class must be a Logical Architecture

. Type must be a Node (from NodeRole)

Project

Used to define a category of project; used in AcV-1.
Extensions:

. Class

Use: Can:

. Be classifier of an ActualProject

. Have an association to a ProjectMilestone Class
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ProjectMilestone

A type of project milestone; used in AcV-2.
Extensions:

. Class

Constraints:

. Owned attributes must be ProjectTheme
Use: Can:

. Be classifier of an ActualProjectMilestone
. Have an association from a Project Class

ProjectSequence

Asserts that one ActualProject follows on from another;
used in AcV-2.

Extensions:

. Dependency

Constraints:

. Client must be an ActualProject

. Supplier must be an ActualProject

ProjectTheme
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An aspect by which the progress of various projects can be

measured; used in AcV-2.

Extensions:

. Attribute

Constraints:

. Type must be a ProjectThemeStatus
Use:

. Owned by ProjectMilestone

ProjectThemeStatus

Specifies a status for a ProjectTheme.
Extensions:
. Class

Use:
. The type of a ProjectTheme

Protocol

A standard for communication; used in SV-2, TV-1 and

TV-2.
Extensions:
. Class
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Generalizations:
. Standard
. SubjectOfForecast

Use: Can:

. Have a set of associations with ('ratifiedBy')
ActualOrganization objects (from Standard)

. Have ProtocolLayers
. Be the type of ProtocolLayers
. Be the client and supplier of a Forecast dependency

ProtocolLayer

Asserts that a protocol uses another protocol; used in TV-1
and TV-2.

Extensions:

. Attribute

Constraints:

. Owning Class must be a Protocol
. Type must be a Protocol

ProvidesCompetence

Asserts that a resource provides a competence; used in
OV-4.
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Extensions:
. Dependency
Constraints:

. Client must be a Resource (Post, Organization,
CapabilityConfiguration, SystemsNode, Software or
ResourceArtifact)

. Supplier must be a Competence

RealizesCapability

Asserts that a resource provides a capability; used in SOV-3,
StV-3, StV-5 and SV-1.

Extensions:

. Realization

Constraints:

. Client must be a Resource or a Servicelnterface
. Supplier must be a Capability

RequestPoint

The mechanism by which a Service communicates; used in
OV-2 and SV-I.

Extensions:
. Port
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Constraints:

. Type must be a Servicelnterface

Use:

. Can be owned by a Node or a Resource

RequiresCompetence

Asserts that a role requires a competence; used in SV-1.
Extensions:

. Dependency

Constraints:

. Client must be a ResourceRole

. Supplier must be a Competence

ResourceArtifact

A type of man-made object; used in OV-2, OV-3, OV-5,
SV-1, SV-3, SV-9, SV-10a and SV-12.

Extensions:

. Class

Generalizations:

. OperationalExchangeltem
. ManfacturedResourceType
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Resource

SubjectOfForecast
Resourcelnteractionltem
Performer
SubjectOfResourceConstraint

Specializations:

System

Use: Can:

Be conveyed by a MaterielExchange

Be the type of an OperationalParameter (from
OperationalExchangeltem)

Own HostedSoftware

Be the Class and type of a Part

Be the type of a ResourceComponent
Be the type of an Equipment

Be the target of a Controls flow (from
ManfacturedResourceType)

Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

Be client of a RealizesCapability realization to a
Capability (from Resource)

Be client of a ProvidesCompetence dependency to a
Competence (from Resource)

Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

Be supplier or client of a Forecast dependency (both must
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have same stereotype) (from SubjectOfForecast)
. Own a ServicePoint (from Resource)
. Own a RequestPoint (from Resource)
. Own a ResourcePort (from Resource)

. Be source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be type of a KnownResource (from Resource)
. Be type of a ResourceRole (from Resource)

. Have a Performs dependency to a PerformedActivity
(Function or OperationalActivity) (from Performer)

ResourceComponent

A well-defined resource that 1s used by a

CapabilityConfiguration to accomplish a capability; used in
SV-1.

Extensions:

. Part
Generalizations:
. ResourceRole
Specializations:
. Platform
Constraints:

. Type must be a ResourceArtifact
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. Owning Class must be a CapabilityConfiguration
Use: Can have a:

. RequiresCompetence dependency to a Competence (from
ResourceRole)

. Set of associations to 'used' Functions (from
ResourceRole)

ResourceConnector

A physical connection between two resources that
implements protocols through which the source resource can
transmit items to the destination resource; used in SV-2.

Extensions:

. Connector

Generalizations:

. Protocollmplementation

Constraints:

. End roles must be ResourcePort

Use: Can:

. Have a set of Resourcelnterface that it realizes
. Realize a Resourcelnteraction

ResourceConstraint
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Specifies the set of rules that govern the structural or
functional aspects of the system; used in SV-10a.

Extensions:
. Constraint
Constraints:

. Constrained element must be a
SubjectOfResourceConstraint (DataElement, Function,
SystemFunction, CapabilityConfiguration, SystemsNode,
Software, ResourceArtifact, System, Post or
Organization)

Resourcelnteraction

Represents data that 1s exchanged between resources; used
in OV-4, SOV-4c, SV-1, SV-2, SV-3, SV-4, SV-6 and
SV-10c.

Extensions:

. InformationFlow
Generalizations:

. SystemsElement

. Protocollmplementation
Specializations:

. Controls

. Commands

. DataExchange
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Constraints:
. Realizing connector 1s a Resourcelnterface
. Realizing activity edge is a FunctionEdge

. Conveyed elements must be Resourcelnteractionltem
(DataElement, Energy, Post, Organization,
CapabilityConfiguration, SystemsNode, Software,
ResourceArtifact or System)

. Source must be a Resource (Post, Organization,
CapabilityConfiguration, SystemsNode, Software,
ResourceArtifact or System)

. Target must be a Resource (Post, Organization,
CapabilityConfiguration, SystemsNode, Software,
ResourceArtifact or System)

Use:

. Can realize an OperationalExchange
(OrganizationalExchange, InformationExchange,
EnergyExchange or MaterielExchange)

. Can realize an ActualOrganizationRelationship

. Has an association to ('implements') a Protocol (from
Protocollmplementation)

Resourcelnterface

A contractual agreement between two resources that
implement protocols; used in OV-4, SV-1, SV-2, SV-3 and
SV-6.
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Extensions:

. Association

. Connector

Generalizations:

. SystemsElement
Specializations:

. SystemConnector

Constraints:

. End roles must be ResourceRole
. End types must be Resource
Use:

. Can realize a Resourcelnteraction

ResourceMessage

Message for use in a Resource event trace, implements a
Resourcelnteraction; used in SV-10c.

Extensions:

. Message

Generalizations:

. SystemsElement

Use:

. Can have a set of Resourcelnteraction that it carries
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ResourcePort

An interaction point for a resource through which it can
interact with the outside environment; used in SV-2.

Extensions:

. Port

Generalizations:

. Protocollmplementation
Constraints:

. Type must be a Resourcelnteractionltem (Energy, Post,
Organization, CapabilityConfiguration, Software,
ResourceArtifact or DataElement)

Use:
. Can be owned by a Resource

. Has an association to a Protocol Class that it 'implements'
(from Protocollmplementation)

. Can be the end role of a ResourceConnector

ResourceStateMachine

UPDM artifact that extends a UML StateMachine applied to
Resources; used in SV-10b.

Extensions:
. StateMachine
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Generalizations:
. SystemsElement
Constraints:

. Owner must be SubjectOfResourceStateMachine (Post,
Organization, CapabilityConfiguration, SystemsNode,
Software, ResourceArtifact, System or DataElement)

SameAs

Asserts that two elements refer to the same real-world thing;
used in AV-2.

Extensions:

. Dependency

Constraints:

. Client must be a UPDMElement

. Supplier must be an Externallndividual or External Type

ServiceAttribute

A property of a Servicelnterface that allows performance,
reliability and cost values to be captured; used in SOV-1.

Extensions:
. Attribute
Use:
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. Owned by a Servicelnterface

ServiceFunction

Describes the abstract behavior of ServiceOperations,
regardless of the actual implementation; used in SOV-5.

Extensions:

. Activity

Use: Can:

. Be the behavior of a ServiceFunctionAction
. Be the activity of a ServiceOperationAction
. Own ServicePoint ports

ServiceFunctionAction

A call behavior action that invokes the ServiceFunction to
be performed; used in SOV-5.

Extensions:

. CallBehaviorAction

Constraints:

. Behavior must be a ServiceFunction
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Servicelnteraction

Interaction for a service interface; used in SOV-4c.
Extensions:
. Interaction

Servicelnterface

A contractual agreement between two resources that
implement protocols through which the source service
interacts with the destination resource; used in SOV-1,

SOV-2, SOV-3, SOV-4a, SOV-4b, SOV-4c and SOV-5.
Extensions:

. Class

Constraints:

. Owned attributes must be ServiceAttribute

. Owned operations must be ServiceOperation

Use: Can:

. Be client of a SupportsOperational Activity dependency to
an Operational Activity

. Be client of a RealizesCapability realization to a
Capability

. Own ServicePolicy

. Have one association to a ServiceStateMachine

. Have one association to a Servicelnteraction

(c) Sparx Systems 2022 Page 248 of 1007



Modeling Frameworks 3 October, 2022

. Be type of a RequestPoint or ServicePoint port
. Be dependent on another Servicelnterface
. Be client of an Expose dependency to a Capability

ServiceMessage

Message for use in a service interaction specification,
implements a resource interaction; used in SOV-4c.

Extensions:
. Message

Use:
. Can carry a set of Resourcelnteractions

ServiceOperation

Provides the access point for invoking the behavior of a
provided service; used in SOV-2 and SOV-5.

Extensions:
. Operation
Constraints:

. Owner must be a Resource (Post, Organization,
CapabilityConfiguration, SystemsNode, Software,
ResourceArtifact or System)

. Owner must be a Node
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Use: Can:

. Have an association to a (concreteBehavior) Function
. Be owned by a Servicelnterface

. Be the operation of a ServiceOperationAction

. Have an association to an (abstractBehavior)
ServiceFunction

ServiceOperationAction

A call action that represents a Resource or ServiceFunction
invoking a ServiceOperation; used in SOV-5.

Extensions:

. CallOperationAction

Constraints:

. Activity must be a ServiceFunction

. Activity must be a Function

. Operation must be a ServiceOperation
Use:

. Can be the Source and Target of a FunctionEdge control
flow

ServicePoint

The mechanism by which a service communicates; used in
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OV-2, SV-1 and SV-12.

Extensions:

. Port

Constraints:

. Type must be a Servicelnterface

. Owned behavior is a ServiceFunction
Use:

. Can be owned by a Node or a Resource (Post,
Organization, CapabilityConfiguration, SystemsNode,
Software, ResourceArtifact or System)

ServicePolicy

A constraint governing the consumers and providers of
services; used in SOV-4a.

Extensions:

. Constraint

Use:

. Rule can be owned by a Servicelnterface

ServiceStateMachine

UPDM artifact that extends UML StateMachine; used in
SOV-4b.

(c) Sparx Systems 2022 Page 251 of 1007



Modeling Frameworks 3 October, 2022

Extensions:
. StateMachine

Software

Software needed for the functioning of the system; used in
OV-2, OV-3, SV-1, SV-3, SV-9, SV-10a and SV-12.

Extensions:

. Class

Generalizations:

. ManufacturedResourceType
. Resource

. SubjectOfForecast

. Resourcelnteractionltem

. Performer

. SubjectOfResourceConstraint
Use: Can:

. Be conveyed on a MaterielExchange information flow
. Be type of HostedSoftware

. Be the target of a Controls flow (from
ManfacturedResourceType)

. Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

. Be client of a RealizesCapability realization to a
Capability (from Resource)
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. Be client of a ProvidesCompetence dependency to a
Competence (from Resource)

. Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

. Be supplier or client of a Forecast dependency (both must
have same stereotype) (from SubjectOfForecast)

. Own a ServicePoint (from Resource)
. Own a RequestPoint (from Resource)
. Own a ResourcePort (from Resource)

. Be source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be a type of a KnownResource (from Resource)
. Be a type of a ResourceRole (from Resource)

. Have a Performs dependency to a PerformedActivity
(Function or Operational Activity) (from Performer)

Standard

A ratified set of rules that are used to guide and/or constrain
any UPDM element; used in SV-9, TV-1 and TV-2.

Extensions:
. Class

Generalizations:
. SubjectOfForecast

(c) Sparx Systems 2022 Page 253 of 1007



Modeling Frameworks 3 October, 2022

Specializations:
. Protocol

Use:

. Any UPDMElement can have a 'conformsTo' association
to a Standard

. Can have an association (ratifiedBy) with an
ActualOrganization

. Can be supplier or client of a Forecast (both must be same
stereotype) (from SubjectOfForecast)

StandardConfiguration

A comment, attached to a CapabilityConfiguration,
indicating that the annotated CapabilityConfiguration is a
standard Pattern for re-use in the architecture; used in TV1
and TV-2.

Extensions:

. Note

Constraints:

. The annotated element must be a CapabilityConfiguration

StandardOperationalActivity

An Operational Activity that is a standard procedure and that
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1s doctrinal; used in OV-5 and StV-6.
Extensions:

. Activity

Generalizations:

. Operational Activity

. PerformedActivity

. SubjectOfOperationalConstraint

. OperationalElement

. SubjectOfOperationalStateMachine
Constraints:

. Owned parameters must be OperationalParameter (from
Operational Activity)

Use: Can:

. Be Client of a MapsToCapability dependency to a
Capability Class

. Be Supplier of a Performs dependency (from
PerformedActivity)

. Be Supplier of an OwnsProcess dependency (from
Operational Activity)

. Be the Activity/Behavior of an Operational ActivityAction
(from Operational Activity)

. Be the owner of an Operational ActivityEdge (from
Operational Activity)

. Have an attached Operational Constraint (from
SubjectOfOperational Constraint)

. Be the Supplier of a SupportsOperational Activity
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dependency (from Operational Activity)

. Own an OperationalStateMachine (from
SubjectOfOperationalStateMachine)

StereotypeExtension

Defines an additional stereotype used in the architecture that
1s not defined in this metamodel; used in AV-2.

Extensions:

. Note

Constraints:

. Annotated element must be a UPDMElement

Use:

. Can have a set of associations (ontologyReference) to
External Type

StructuralPart

Describes a structural part of an EnterprisePhase; used in
AV-1.

Extensions:

. Part

Constraints:

. Type must be an EnterprisePhase
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. Class must be an EnterprisePhase

SubOrganization

Asserts that one type of organization is typically the parent
of another; used in OV-4 and SV-1.

Extensions:

. Part

Generalizations:

. OrganizationRole

. ResourceRole

Constraints:

. Type must be an Organization
. Class must be an Organization
Use: Can:

. Have a RequiresCompetence dependency to a
Competence (from ResourceRole)

. Have a set of associations to 'used' Functions (from
ResourceRole)

SubSystemPart

Indicates that a subsystem is part of another system; used in
SV-1.
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Extensions:

. Part

Generalizations:

. Part

. ResourceRole

Constraints:

. Class must be a ResourceArtifact (from Part)
. Type must be a ResourceArtifact (from Part)
Use: Can:

. Have a RequiresCompetence dependency to a
Competence (from ResourceRole)

. Have a set of associations to 'used' Functions (from
ResourceRole)

SupportsOperationalActivity

An assertion that a Service in some way contributes or
assists in the execution of an Operational Activity.

Extensions:

. Dependency

Constraints:

. Client must be a Servicelnterface

. Supplier must be an Operational Activity
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System

Any organized assembly of resources and procedures united
and regulated by interaction of interdependence to
accomplish a set of specific functions.

Extensions:

Class

Generalizations:

ResourceArtifact

Operational Exchangeltem
ManfacturedResourceType
Resource

SubjectOfForecast
Resourcelnteractionltem
Performer
SubjectOfResourceConstraint

Use: Can:

Be conveyed by a MaterielExchange (from
ResourceArtifact)

Be the type of an OperationalParameter (from
OperationalExchangeltem)

Own HostedSoftware (from ResourceArtifact)
Be the Class and type of a Part (from ResourceArtifact)

Be the type of a ResourceComponent (from
ResourceArtifact)
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. Be the type of an Equipment (from ResourceArtifact)

. Be the target of a Controls flow (from
ManfacturedResourceType)

. Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

. Be client of a RealizesCapability realization to a
Capability (from Resource)

. Be client of a ProvidesCompetence dependency to a
Competence (from Resource)

. Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

. Be supplier or client of a Forecast dependency (both must
have same stereotype) (from SubjectOfForecast)

. Own a ServicePoint (from Resource)
. Own a RequestPoint (from Resource)
. Own a ResourcePort (from Resource)

. Be source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be type of a KnownResource (from Resource)
. Be type of a ResourceRole (from Resource)

. Have a Performs dependency to a PerformedActivity
(Function or Operational Activity) (from Performer)

SystemConnector
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A link between two systems.

Extensions:

. Association

. Connector

Generalizations:

. Resourcelnterface

. SystemsElement

Specializations:

. SystemConnector

Constraints:

. End roles must be ResourceRole (from Resourcelnterface)
. End types must be Resource (from Resourcelnterface)
Use:

. Can realize a Resourcelnteraction (from
Resourcelnterface)

SystemFunction

A DoDAF alias for Function.
Extensions:

. Activity

Generalizations:

. Function
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. PerformedActivity

. SystemsElement

. SubjectOfResourceConstraint
Constraints:

. Owned parameters are FunctionParameter (from
Function)

Use: Can:

. Be Supplier of a Performs dependency (from
PerformedActivity)

. Own ServiceOperationAction, FunctionAction or
FunctionEdge (from Function)

. Be Client of an ImplementsOperational dependency to an
Operational Activity (from SystemsElement)

. Have an attached ResourceConstraint (from
SubjectOfResourceConstraint)

SystemFunctionAction

A DoDAF alias for FunctionAction.
Extensions:

. CallBehaviorAction
Generalizations:

. FunctionAction

Constraints:

. Activity is stereotyped Function (from FunctionAction)

(c) Sparx Systems 2022 Page 262 of 1007



Modeling Frameworks 3 October, 2022

Use:
. Press Ctrl+L to set the function (from FunctionAction)

SystemFunctionEdge

An alias for FunctionEdge.
Extensions:

. A DoDAF ControlFlow
Generalizations:

. FunctionEdge

. SystemsElement
Constraints:

. Source must be a ServiceOperationAction (from
FunctionEdge)

. Target must be a ServiceOperationAction (from
FunctionEdge)

Use:

. Can realize a Resourcelnteraction (right-click, Advanced
> Information Flows Realized) (from FunctionEdge)

SystemsNode

A DoDAF alias for CapabilityConfiguration.
Extensions:
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Class

Generalizations:

CapabilityConfiguration
Resource, Conceptltem
Performer
Resourcelnteractionltem
SubjectOfResourceConstraint
SubjectOfForecast
SystemsElement
SubjectOfResourceStateMachine
Resourcelnteractionltem

Use: Can:

Have a set of associated deployed milestones, stereotyped
DeployedMilestone (from CapabilityConfiguration)

Have an optional associated no longer used milestone,
stereotyped NoLongerUsedMilestone (from
CapabilityConfiguration)

Have a set of associated increment milestones,
stereotyped IncrementMilestone (from
CapabilityConfiguration)

Have an optional associated out of service milestone,
stereotyped OutOfServiceMilestone (from
CapabilityConfiguration)

Be annotated by a StandardConfiguration note (from
CapabilityConfiguration)

Be the type of a ConceptRole (from Conceptltem)
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. Have a set of associated milestones, stereotyped
ActualProjectMilestone (from Resource)

. Be client of a RealizesCapability realization to a
Capability (from Resource)

. Be client of a ProvidesCompetence dependency to a
Competence (from Resource)

. Have an attached ResourceConstraint (from Resource,
SubjectOfResourceConstraint)

. Be supplier or client of a Forecast dependency (both must
have same stereotype) (from SubjectOfForecast)

. Own a ServicePoint (from Resource)
. Own a RequestPoint (from Resource)
. Own a ResourcePort (from Resource)

. Be source and target of a Resourcelnteraction (from
Resource)

. Own a ServiceOperation (from Resource)
. Be the type of a KnownResource (from Resource)
. Be the type of a ResourceRole (from Resource)

. Have a Performs dependency to a PerformedActivity
(Function, Operational Activity) (from Performer)

TechnologyForecast

A statement about the future state of one or more types of
standard.
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Extensions:

. Forecast

. Dependency
Constraints:

. Client and Supplier are both SubjectOfForecast (Standard,
Competence, Capability, CapabilityConfiguration,
Organization, Post, ResourceArtifact or Software) (from
Forecast)

. Client and Supplier must be the same specialization of
SubjectOfForecast (from Forecast)

TemporalPart

EnterprisePhase elements that have a time-based nature;
used in AV-1.

Extensions:

. Part

Constraints:

. Type must be an EnterprisePhase
. Class must be an EnterprisePhase

UsedConfiguration

The use of a CapabilityConfiguration in another
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CapabilityConfiguration; used in SV-1.
Extensions:

. Part

Generalizations:

. ResourceRole

Constraints:

. Type must be a CapabilityConfiguration
. Class must be a CapabilityConfiguration
Use: Can:

. Have a RequiresCompetence Dependency to a
Competence (from ResourceRole)

. Have a set of Associations (usedFunctions) to Function
(from ResourceRole)

VisionStatement

A high-level textual description of an EnterpriseVision.
Extensions:
. Note

WholelifeEnterprise

A purposeful endeavor of any size involving people,
organizations and supporting systems; used in AV-1 and
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StV-1.
Extensions:

. Class
Generalizations:

. EnterprisePhase
Use: Can:

. Have a set of Associations (statementTasks) to
EnduringTask Class (from EnterprisePhase)

. Have a set of Associations (exhibits) to Capability Class
(from EnterprisePhase)

. Have a set of Associations (inhabits) to Environment
Class (from EnterprisePhase)

. Have a set of Associations (goals) with EnterpriseGoal
Class (from EnterprisePhase)

. Have a set of Associations (visions) with EnterpriseVision
Class (from EnterprisePhase)

. Be the type of a StructuralPart or TemporalPart (from
EnterprisePhase)

. Fulfill a Mission Use Case (from EnterprisePhase)

. Be Supplier of a DefinesArchitecture Realization (from
EnterprisePhase)
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Abstract Stereotypes

Stereotype Specializations

Stereotype Description

ActualOrgani = An actual organization or post.

zationalReso | Specializations:

urce . ActualOrganization

. ActualPost

Conceptltem | An item that might feature in a high level
operational concept.

Specializations:

. CapabilityConfiguration
. Node

. ReferredLocation

. Resource

DataModel A structured specification of data,
showing classifications of data elements
and the relationships between them.

Specializations:
. LogicalDataModel
. PhysicalDataModel
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Environment = A type of environment.
alType Specializations:

. LightCondition

. Location

. PhysicalLocation

. Climate

Manufacture = A resource artifact or software.
dResourceTy = Generalizations:
pe . Resource

Specializations:

. ResourceArtifact

. Software

NodeChild An abstract element used for supporting
the composite structuring of operational
elements such as Nodes and
LogicalArchitectures.

Specializations:

. NodeRole

. ProblemDomain
. KnownResource

NodeParent | Represents the owners/context of
composite structure at the operational
level.

Specializations:
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Node

ExternalNode
OperationalNode
Logical Architecture

Elements relating to operational models.

Specializations:

Operational Activity
StandardOperational Activity
OperationalMessage

Node

ExternalNode
OperationalNode

Needline
OperationalExchange
InformationElement
Operational ActivityEdge

Describes the characteristics of an
exchanged item, such as the content,
format (voice, imagery, text and message
format), throughput requirements,
security or classification level, timeliness
requirement, and the degree of
interoperability.

Generalizations:

OperationalElement
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Specializations:
. ConfigurationExchange
EnergyExchange

InformationExchange

MaterielExchange
OrganizationalExchange

OperationalE = An item that participates in an operational
xchangeltem @ exchange.

Specializations:

. Post

. Organization

. ResourceArtifact
. System

Organization = Either an organization or a post.
alResource Generalizations:
. Resource
. OperationalExchangeltem
Specializations:
. Post
. Organization

Organization = Represents properties in an organization
Role that are typed by another organization or
a post.
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Generalizations:

. ResourceRole
Specializations:

. SubOrganization
. PostRole

PerformedAc = A behavior that can be performed by a
tivity Performer.

Specializations:
. Operational Activity
. Function

Performer A structural element that can perform
behaviors (such as PerformedActivity)

Specializations:

. Node
. Resource

Protocollmpl = An element that implements a specific
ementation protocol.

Specializations:
. ResourcePort
Resourcelnteraction

Controls

Commands

DataExchange
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Resource
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ResourceConnector

Either an actual location or a type of
location (that 1s, environment) at/in which
operations can be conducted.

Generalizations:

Conceptltem
Environmental Type

Specializations:

Location
PhysicalLLocation

A physical asset, organizational resource
or functional resource that can contribute
towards fulfilling a capability.

Generalizations:

SystemsElement
SubjectOfResourceStateMachine
Resourcelnteractionltem
Performer
SubjectOfResourceConstraint
Conceptltem

SubjectOfForecast

Specializations:

Post
Organization
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Resourcelnte
ractionltem

ResourceRol
e
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Represents the items exchanged between
resources through a resource interaction.

Specializations:

Energy
Resource
DataElement

Defines the usage of any resource in the
system.

Specializations:

UsedConfiguration
Equipment
SubOrganization
PostRole

Part

SubSystemPart
HumanResource
ResourceComponent
Platform
HostedSoftware
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SubjectOfFor | Any element that can be subject to a
ecast forecast.

Specializations:

. Standard

. Protocol

. Capability

. Competence

. Post

. Organization

. CapabilityConfiguration
. SystemsNode

. Software

. ResourceArtifact
. System

SubjectOfOp | An element of the architecture that can be
erationalCons = subject to an OperationalConstraint or
traint OperationalStateDescription.

Specializations:

. Operational Activity
. InformationElement
. Node

. Mission

SubjectOfOp | The element being described by the
erationalState = StateMachine.
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Machine

SubjectOfRes
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SubjectOfRes
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Specializations:

Operational Activity
InformationElement

. Node

Mission

Anything that can be constrained by a
ResourceConstraint.

Specializations:

Post

Organization
CapabilityConfiguration
SystemsNode

Software
ResourceArtifact
System

DataElement

Function

The element being described by the
StateMachine.

Specializations:

Post

Organization
CapabilityConfiguration
SystemsNode
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Software
ResourceArtifact
System
DataFElement

SystemsElem = Elements relating to system models.

ent Specializations:

Resource
Resourcelnteraction
ResourceMessage
Resourcelnteraction
DataElement
ResourceStateMachine
FunctionEdge
Function

UPDMEleme A super type for all UPDM elements,
nt providing a means of extending UPDM
elements in a common way.

Specializations:
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Quicklinks

The UPDM profile makes use of Enterprise Architect's
'Quicklink' feature to make it quicker and easier to create
correct and consistent UPDM models.

When you select an element, the Quicklink arrow displays
next to the top-right corner of the element.

eOrganization=
Maritime Rescue

Team

Drag the arrow away from the element and release it over
empty diagram space. The Quicklink context menu displays,
listing all the UPDM elements that could commonly be
attached to the element, as shown.
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Class

n-ary Association

Interface
Package
Enumeration

Signal
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Requirement
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A [

ﬁ «drganization: ?

4 Mariti [

?i aritime Rescue ?
I

ﬁ Team :,.E
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]
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Feature

UPDM::Organization

el UPDM:: Post -*"-.- Commands

UPDM::ResourceArtifact
UPDM:: Software

| Associated

UPDM::ActualProjectMilestone
UPDM:: Capability
UPDM::Competence
UPDM::ResourceConstraint
UPDM::Function

T ¥ ¥ ¥ v ¥y ¥ ¥

UPDM:: OperationalActivity

-

Common

Help...

Selecting the 'UPDM::Post | Commands' option in the
context menu creates a new Post element connected to the
Organization element by a Commands relationship.
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Tagged Values for UPDM

UPDM is an extension of UML, which is extended by
applying stereotypes to elements. The stereotypes in turn
apply Tagged Values that provide additional information to
that normally associated with a UML element. Since UPDM
makes frequent use of Tagged Values, it 1s recommended to
keep the Properties window docked and visible at all times,
with the '"UPDM' section expanded.

Synchronize Tagged Values

The list of Tagged Values owned by an element can get out
of date. A new version of the UML Profile might define new
or modified Tagged Values for an element type, or as user
might delete some. Also, you might apply the stereotype
using the stereotype combo box, which doesn't add Tagged
Values. If you want to refresh the list of Tagged Values for
a single element, you can drag and drop the stereotype from
the Diagram Toolbox onto the element and select the 'Apply’
option. This only works for single diagram objects, and not
for connectors.

If you want to refresh the list of Tagged Values for every
element in your model, select the 'Specialize > Technologies
> UPDM > Synchronize Tagged Values' menu option.
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The URL/URI Tagged Value

In the UPDM Profile Specification the stereotype
«UPDMElement» - from which all profile elements are
derived - provides a Tagged Value URL/URI. In Enterprise
Architect, this Tagged Value has been omitted and you must
use the standard Enterprise Architect functionality to
achieve the same result: that 1s, open the 'Properties' dialog
for the element, select the 'Files' tab or page, and type in a
web location.
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Model Views in UPDM

The 'Model Views' tab of the Focus window displays a
variety of different views on the model data, providing an
alternative to the Browser window. You can use this tab as a
quick and easy method of locating all of your UPDM
diagrams in the current model.
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Project

& Model Views
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Cwerview and Summary Information
[ & AV-2 Diagrams
4 B acv Diagrams
| & AcV-1 Diagrams
El.. Search Found Mo Items
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I> 3 sv Diagrams
b &3 sty Diagrams
b @1 TV Diagrams
4 53 UPDM Framework Diagrams
[+ & UPDM Framework Diagrams

[
>
>
>

-

To open the 'Model Views' tab, select 'Start > All Windows
> Design > Focus > Model Views'. Expand the appropriate
folders and double-click on the required diagram to open it.

(c) Sparx Systems 2022 Page 284 of 1007



Modeling Frameworks 3 October, 2022

Glossary

UPDM provides the ability to import descriptions of all
UPDM stereotypes into the Enterprise Architect Glossary.
This gives you a quick reference to the meaning of each
stereotype, lists the views that the stereotype might appear
in and, for abstract stereotypes, lists the concrete stereotypes
that inherit from the abstract stereotype.

Import Glossary

Y ou import the Glossary definitions into each model
individually. To do this, select the 'Publish > Technologies >
Import > Other Tools/Formats' ribbon option.

View the Glossary

To view the Glossary, select one of:

. 'Design > Dictionary > Glossary > Glossary View to
display the Project Glossary view

. 'Design > Dictionary > Glossary > Edit' to open the
'Glossary' dialog

. In any dialog 'Notes' field, a Glossary hyperlink
(underlined and colored blue)
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Using Enterprise Architect Elements

Creating an instance from a Class

UPDM has Classifier/Instance pairs where the classifier
describes a class of elements and the instance represents a
single member of that Class. The Classifier/Instance pairs in
UPDM are:

. MeasurementSet/ActualMeasurementSet

. Organization/ActualOrganization

. Person/ActualPerson

. Post/ActualPost

. Project/ActualProject

. ProjectMilestoneType/ActualProjectMilestone
. CapabilityConfiguration/FieldedCapability

If you have an element that 1s the classifier part of one of
these Classifier/Instance pairs, you can choose between two
main approaches for creating the instance:

1. Set the classifier of an existing instance - Click on the
instance element in a diagram and then either press Ctrl+L
or right-click and select '"Advanced | Instance Classifier’;
the same command sets the type of a Port or Part.

2. Create an instance from an existing classifier - Press Ctrl
while dragging the classifier element from the Browser
window onto a diagram. The 'Paste Element' dialog
displays; select the 'Paste as Instance of Element' option.
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An anonymous instance is created with the appropriate
stereotype; select the instance, press F2 and give it a
name.

Set the run state of an object

Where a classifier can own a set of attributes, an instance of
that classifier can own a Slot for each attribute. The set of
assigned values for these Slots 1s known as the run state. To
set the run state of an object on a diagram, right-click on it
and select 'Features | Set Run State' or press Ctrl+Shift+R.

Some stereotypes are defined by UPDM as extending the
Slot metaclass. Each run state attribute represents a Slot, but
it 1s not possible to stereotype Slots in Enterprise Architect,
so UPDM's slot-extending stereotypes are not available in
Enterprise Architect's implementation. UPDM stereotypes
that extend Slot are:

. ActualMeasurement (ActualMeasurementSet)

. ActualOrganizationRole (ActualOrganization)

. MeasureOfPerformance (ActualMeasurementSet)
. ProjectStatus (ActualProjectMilestone)

Properties
Some stereotypes in UPDM are defined as extending the
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UML Property metaclass. This gives you the choice of a
number of different representations for these elements in
your model. If you drag one of the properties from the
Toolbox onto a classifier element on a diagram, you are
prompted to select to create an attribute, a Part, or a Port.
These are all different representation of the UML Property
metaclass; which one you choose depends on what
rendering of the Property you want to see in your model.

Another representation of the UML Property metaclass is
the Association End; to apply one of UPDM's Property
stereotypes to an Association End:

1. Double-click on the element to display the 'Properties'
dialog.
2. Select the 'Roles' tab.

3. Click on the [ ] button next to the appropriate 'Stereotype'
field.

4. On the 'Stereotype for Association' dialog, select 'UPDM'
from the 'Profile’ field.

5. Select every stereotype that applies.
Stereotypes that extend Property are:

. ConceptRole

. EntityAttribute

. EnvironmentProperty

. Equipment

. HostedSoftware

. HumanResource

. KnownResource
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. Measurement

. NodeRole

. Part

. PerformanceParameter
. Platform

. PostRole

. ProblemDomain

. ProjectTheme

. ProtocolLayer

. ResourceComponent
. ServiceAttribute

. StructuralPart

. SubOrganization

. SubSystemPart

. TemporalPart

. UsedConfiguration
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Model Validation in UPDM

Enterprise Architect supports model validation of UPDM
models, validating and reporting errors against more than
160 different rules.

Configure Model Validation

Before being able to validate a model, you first have to
select the rules to validate against. Select 'Design >Package
> Manage > Validate > Configure Validation Rules' and
deselect the checkbox against all validation rules except for
the UPDM set.

Perform Model Validation

Open a diagram or select either a Package or a number of
elements in the Browser window, then select the 'Design >
Package > Manage > Validate > Validate Current Package'
ribbon option (or press Ctrl+Alt+V). Validation results are
displayed in the System Output window, which is opened if
it isn't already displayed. To go to the element that caused a
validation error, double-click on the error message in the
System Output window.
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Output

MYRE00005 - error (Lifeboat Driver (dctualPost)): The object does nat have a valid dlassifier (Permitted value: Past)

MYRE0000F - error (Madel (Node)): The element has an invalid port (Required sterectypes: NodePort, RequestPoint, ServicePaint)

MYRE00013 - errar (Transmitter {ResourcePort)): The object does not have a valid type (Permitted value: ResourcelnteractionItem)

MYRE0000S - errar {<anonymous > (Needine)): The relationship does not have a valid end role (Permitted values: NodeChild, ModePort)

MYRE00009 - errar {<anonymous> (Needine)): The relationship does not have a valid end type (Permitted values: Node)

MYRS0000F - error (Modez {Node)): The element has an invalid port {Required sterectypes: ModePort, RequestPoint, ServicePoink)

MYRS0000b - error {<anonymous > {CrganizationalExchange)i: The relationship does not have a valid information target (Permitted values: Mode)
MYRES00013 - error (Receiver (ResourcePort)): The object does not have a wvalid bype (Permitted value; ResourcelnteractionItem)

MYRS00001 - error {Send Distress Signal (OperationalActivibyAction)): The action has a missing or invalid activity (Required stereotype; Operationalfctivity)
MYRES00003 - error {Send Distress Signal {OperationalActivibyaction)): The action has a missing or invalid behavior (Required stereotyvpe; Operationalfckivity)
Walidation complete - 10 error(s), O warningis)

14 v [ H] System ( Seript.| Model Validation, < I3 ¥
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Model Validation Rules

Errors are indicated by an error code of the format
MVRxxnnnn where:

. xx 1s 80 by default (if the MDG Technology for UPDM 1s
the only Add-In that you have installed) but could be
some other number, and

. nnnn 1s a hexadecimal number from 0001 to 0013 as
described here

MVRxx0001 - activity

Error Message: The action has a missing or invalid activity
(Required stereotype: <stereotypeList>)

The validation rule checks that stereotyped Action elements
are owned by an Activity with the required stereotype.

Solution: Locate the Action in the Browser window, locate
an Activity with one of the named stereotypes (or their
specializations) or create a new one, and drag the Action to
the Activity.

Action Activity Stereotypes
Stereotypes

FunctionActi = Function
on

Operational A
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ctivityAction = Operational Activity

ServiceOpera = Function
tionAction

ServiceOpera | ServiceFunction
tionAction

MVRxx0002 - annotatedElement

Error Message: The note has an invalid annotated element
(Required stereotype: <stereotype>)

This validation rule checks that stereotyped Note elements
are attached (by a NoteLink connector) to an element with
the required stereotype.

Solution: Attach the Note to an element with the named
stereotype (or one of its specializations). You can do this by
either dragging the opposite end of the NoteLink connector,
or deleting the NoteLink connector and creating a new one
with the Quick Linker.

Note Annotated Element Stereotypes
Stereotypes

Alias UPDMElement

Architecture
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Metadata ArchitecturalDescription
Definition UPDMElement

StandardConf = CapabilityConfiguration
iguration

StereotypeEx = UPDMElement
tension

MVRxx0003 - behavior

Error Message: The action has a missing or invalid behavior
(Required stereotype: <stereotype>)

This validation rule checks that stereotyped
CallBehaviorAction elements call a Behavior with the
required stereotype.

Solution: Right-click on the Action and select Advanced |
Set Behavioral Classifier, or press Ctrl+L, and select a
behavior element with the named stereotype (or one of its
specializations).

Action Behavior Stereotypes
Stereotypes

OperationalA = Operational Activity

(c) Sparx Systems 2022 Page 295 of 1007



Modeling Frameworks 3 October, 2022

ctivityAction

ServiceFuncti = ServiceFunction
onAction

MVRxx0004 - class

Error Message: The object does not have a valid owning
Class (Permitted values: <stereotypeList>)

This validation rule checks that stereotyped Property
elements (Parts or attributes) are owned by a Class with the
required stereotype.

Solution: Locate the property in the Browser window, locate
a Class with one of the named stereotypes (or their
specializations) or create a new one, and drag the property
to the Class.

Property Class Stereotypes
Stereotypes
Equipment OrganizationalResource

HostedSoftw = ResourceArtifact
are

HumanResou = CapabilityConfiguration
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rce

NodeChild NodeParent
NodeRole Node

Part ResourceArtifact
PostRole Organization

ProblemDom @ LogicalArchitecture
ain

ProtocolLaye @ Protocol
r

ResourceCo | CapabilityConfiguration
mponent

ResourceRol @ Resource
e

StructuralPart | EnterprisePhase

SubOrganizat = Organization
1on

TemporalPart = EnterprisePhase
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UsedConfigu = CapabilityConfiguration
ration

MVRxx0005 - classifier

Error Message: The object does not have a valid classifier
(Permitted value: <stereotype>)

This validation rule checks that stereotyped instance
elements (objects) are classified by elements with the
required stereotypes.

Solution: Select the object, right-click it and select
Advanced | Instance Classifier, or press Ctrl+L, and select a
classifier element with the named stereotype (or one of its
specializations).

Object Classifier Stereotypes
Stereotypes

ActualMeasu @ MeasurementSet
rementSet

ActualOrgani = Organization
zation

ActualPerson @ Person
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ActualPost Post
ActualProject  Project

ActualProject = ProjectMilestoneType
Milestone

FieldedCapab CapabilityConfiguration
ility

MVRxx0006 - client

Error Message: The relationship does not have a valid client
(Permitted values: <stereotypeList>)

This validation rule checks that, for stereotyped Dependency
or Realization relationships, their client (source) elements
have the required stereotypes.

Solution: Drag the end of the relationship without the
arrowhead to an element with the named stereotype (or one
of its specializations).

Relationship | Client Element Stereotypes
Stereotypes

ArbitraryRela HighLevelOperationalConcept
tionship
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Architectural
Reference

Compatible
With

DefinesArchi
tecture

ExhibitsCapa
bility

Expose
FillsPost
Forecast

ImplementsO
perational

MapsToCapa
bility

MilestoneSeq
uence

OwnsProcess
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ArchitecturalDescription

Node

ArchitecturalDescription

Node

Servicelnterface
ActualPerson
SubjectOfForecast

SystemsElement

StandardOperational Activity

ActualProjectMilestone

ActualOrganizationalResource
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Performs

ProjectSeque
nce

ProvidesCom
petence

RealizesCapa
bility

RealizesCapa
bility

RequiresCom
petence

SameAs
SupportsOper

ational Activit
Yy

MVRxx0007 - constrainedElement
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Error Message: The constraint has an invalid constrained
element (Required stereotype: %s)

This validation rule checks that stereotyped Constraint
elements are attached (by a NoteLink) to elements with the
required stereotypes.

Solution: Attach the constraint to an element with the named
stereotype (or one of its specializations). You can do this by
either dragging the opposite end of the NoteLink connector,
or by deleting the NoteLink connector and creating a new
one using the Quick Linker.

Constraint Constrained Element Stereotypes
Stereotypes

OperationalC = SubjectOfOperationalConstraint
onstraint

ResourceCon = SubjectOfResourceConstraint
straint

MVRxx0008 - endRoles

Error Message: The relationship does not have a valid end
role (Permitted values: <stereotypeList>)

This validation rule checks that, for stereotyped Association
or Connector relationships, the elements at both ends of the
relationship have the required stereotypes.
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Solution: Drag one or both ends of the relationship to
elements with the named stereotype (or one of its
specializations).

Relationship End Element Stereotypes

Stereotypes
Needline NodeChild
Needline NodePort

ResourceCon @ ResourcePort
nector

Resourcelnte = ResourceRole
rface

MVRxx0009 - endType

Error Message: The relationship does not have a valid end
type (Permitted values: <stereotypeList>)

This validation rule checks that, for stereotyped connectors,
the elements (Objects or Parts) at both ends of the
relationship are typed by the required stereotypes.

Solution: Drag one or both ends of the relationship to
elements that have types with the named stereotype (or one
of its specializations).
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Connector End Type Stereotypes
Stereotypes

EntityRelatio = Entityltem
nship

Needline Node

Resourcelnte = Resource
rface

MVRxx000a - informationSource

Error Message: The relationship does not have a valid
information source (Permitted values: <stereotypeList>)

This validation rule checks that stereotyped
InformationFlow relationship source elements have the
required stereotypes.

Solution: Drag the end of the information flow without the
arrowhead to an element with the named stereotype (or one
of its specializations).

InformationF Source Element Stereotypes
low
Stereotypes

ActualOrgani
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zationRelatio = ActualOrganizationalResource
nship

Commands OrganizationalResource
Controls OrganizationalResource

OperationalE = Node
xchange

Resourcelnte = Resource
raction

MVRxx000b - informationTarget

Error Message: The relationship does not have a valid
information target (Permitted values: <stereotypeList>)

This validation rule checks that stereotyped
InformationFlow relationship target elements have the
required stereotypes.

Solution: Drag the end of the information flow with the
arrowhead to an element with the named stereotype (or one
of its specializations).

InformationF | Target Element Stereotypes
low
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Stereotypes

ActualOrgani = ActualOrganizationalResource
zationRelatio

nship
Commands OrganizationalResource
Controls OrganizationalResource

OperationalE = Node
xchange

Resourcelnte = Resource
raction

MVRxx000c - ownedAttribute

Error Message: The element has an invalid attribute
(Required stereotype: <stereotype>)

This validation rule checks that, for stereotyped Class
clements, any attributes that they own have the required
stereotypes.

Solution: Replace the attribute with one with the named
stereotype (or one of its specializations).

Class
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Stereotypes

Entityltem
Environment

HighLevelOp
erationalCon
cept

Measurement
Set

ProjectMilest
oneType

Servicelnterf
ace

MVRxx000d - ownedOperation

Attribute Stereotypes

EntityAttribute

EnvironmentProperty

ConceptRole

Measurement

ProjectTheme

ServiceAttribute

3 October, 2022

Error Message: The element has an invalid operation
(Required stereotype: %os)

This validation rule checks that, for stereotyped Class
elements, any operations that they own have the required

stereotypes.
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Solution: Replace the operation with one with the named
stereotype (or one of its specializations).

Class Operation Stereotype
Stereotype

Servicelnterf = ServiceOperation
ace

MVRxx000e - ownedParameter

Error Message: The element has an invalid activity
parameter (Required stereotype: %os)

This validation rule checks that, for stereotyped Activity
clements, any ActivityParameter elements that they own
have the required stereotypes.

Solution: Locate the ActivityParameter in the Browser
window and drag and drop it onto an element with the
appropriate stereotype, and/or replace the ActivityParameter
in its current owner with an ActivityParameter with the
named stereotype.

Activity ActivityParameter Stereotypes
Stereotypes
Function FunctionParameter
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OperationalA = OperationalParameter
ctivity

MVRxx000f - ownedPort

Error Message: The element has an invalid Port (Required
stereotypes: <stereotypeList>)

This validation rule checks that, for stereotyped Class
elements, any Ports that they own have the required
stereotypes.

Solution: Locate the Port in the Browser window and drag
and drop it onto an element with the appropriate stereotype,
and/or replace the Port 1n its current owner with a Port with
one of the named stereotypes.

Class Port Stereotypes
Stereotypes

Node NodePort

Node RequestPoint
Node ServicePoint
Resource RequestPoint

(c) Sparx Systems 2022 Page 309 of 1007



Modeling Frameworks 3 October, 2022

Resource ResourcePort

Resource ServicePoint

MVRxx0010 - source

Error Message: The relationship does not have a valid
source (Permitted values: <stereotypeList>)

This validation rule checks that stereotyped ActivityEdge
connector source elements have the required stereotypes.

Solution: Drag the end of the relationship without the
arrowhead to an element with the named stereotype (or one
of its specializations).

ActivityEdge Source Element Stereotypes
Stereotypes

FunctionEdg = ServiceOperationAction
e

OperationalA = Operational ActivityAction
ctivityEdge

MVRxx0011 - supplier
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Error Message: The relationship does not have a valid
supplier (Permitted values: <stereotypeList>)

This validation rule checks that stereotyped Dependency or
Realization relationship supplier (target) elements have the
required stereotypes.

Solution: Drag the end of the relationship with the
arrowhead to an element with the named stereotype (or one
of its specializations).

Relationship Supplier Element Stereotypes
Stereotypes

ArbitraryRela HighLevelOperationalConcept
tionship

Architectural = ArchitecturalDescription
Reference

Compatible ReferredLocation
With

DefinesArchi = EnterprisePhase
tecture

ExhibitsCapa = Capability
bility

Expose Capability
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FillsPost
Forecast

ImplementsO
perational

MapsToCapa
bility

MilestoneSeq
uence

OwnsProcess
Performs

ProjectSeque
nce

ProvidesCom
petence

RealizesCapa
bility

RealizesCapa
bility
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SubjectOfForecast

OperationalElement

Capability

ActualProjectMilestone

Operational Activity
PerformedActivity

ActualProject

Competence

Capability

Competence
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RequiresCom Externallndividual
petence

SameAs External Type

SupportsOper | Operational Activity
ational Activit

y

MVRxx0012 - target

Error Message: The relationship does not have a valid target
(Permitted values: <stereotypeList>)

This validation rule checks that stereotyped ActivityEdge
connector target elements have the required stereotypes.

Solution: Drag the end of the relationship with the
arrowhead to an element with the named stereotype (or one
of its specializations).

ActivityEdge Target Element Stereotypes
Stereotypes

FunctionEdg = ServiceOperationAction
e

OperationalA = Operational ActivityAction
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ctivityEdge

MVRxx0013 - type

Error Message: The object does not have a valid type
(Permitted value: <stereotype>)

This validation rule checks that stereotyped Property
elements (Parts or attributes) have type elements with the
required stereotypes.

Solution: For Parts, right-click on the Part and select
'Advanced | Set Property Type', or press Ctrl+L, and select a
type element with the named stereotype (or one of its
specializations). For attributes, open the Features window
for the attribute and select a type element with the named
stereotype (or one of its specializations) in the 'Type' field.

Property Type Element Stereotypes
Stereotypes

ConceptRole | Conceptltem

Environment = Environmental Type
Property

Equipment ResourceArtifact

FunctionPara
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meter Resourcelnteractionltem

HostedSoftw = Software
are

HumanResou = OrganizationalResource
rce

KnownResou @ Resource
rce

NodePort OperationalExchangeltem

NodeRole Node

OperationalP = OperationalExchangeltem

arameter
Part ResourceArtifact
PostRole Post

ProjectThem @ ProjectThemeStatus
e

ProtocolLaye @ Protocol
r
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RequestPoint

ResourceCo
mponent

ResourcePort
ServicePoint
StructuralPart

SubOrganizat
1on

TemporalPart

UsedConfigu
ration
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ResourceArtifact

Resourcelnteractionltem
Servicelnterface
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The Open Group Architecture
Framework (TOGAF)

The Open Group Architecture Framework (TOGAF) 1s one
of the most widely accepted methods for developing
enterprise architecture. TOGAF is an open framework,
providing a practical, definitive and proven step-by-step
method for developing and maintaining enterprise
architecture.You can use the TOGAF facilities in Enterprise
Architect to model an enterprise of any size, and you can
create or import any number of Artifacts including
Catalogues, Matrices and diagrams, which can all be
conveniently stored in the repository that will serve as the
Architecture Repository. All Artifacts are stored in
compliance with the TOGAF metamodel; additionally
Reference Libraries, Standards and governance logs can all
be modeled in the tool.
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A.
Architecture
Vision

H.
Architecture B.
Change Business
Management Architecture

G. i C.
Implementation Requirements Information
Governance Management Systems

Architecture

F. D.
Migration Technology
Planning Architecture

E.
Opportunities
and
Solutions

The Open Group's TOGAF Architecture Development
Method

Enterprise Architecture is an important discipline, as
organizations need to understand the fundamental aspects of
their business in order to keep pace with the global market
and technology changes in a continually evolving world.
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Enterprise Architect has built-in support for all the
important enterprise architecture frameworks and enterprise
modeling languages, allowing you to model an enterprise
from the business goals and drivers through to Cloud-based
infrastructure services. In this topic you will learn how to
model an Enterprise using TOGAF, including working with
the ADM and metamodel attributes.

Discussion

The topics described here provide an introduction to, and
procedural explanation of, using TOGAF in Enterprise
Architect.

Section Content

Welcome This section provides an introduction to

A TOGAF, and contains the formal
O documentation defining its use with
Enterprise Architect.

Using Get started with TOGAF, learning about
TOGAF the model structure, templates, diagram
¢ types and more.

R

TOGAF The key to TOGAF remains a reliable,
ADM practical method - the TOGAF
Architecture Development Method
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=] (ADM) - for defining business needs and

=t developing an architecture that meets
those needs, applying the elements of
TOGAF and other architectural assets
available to the organization.

The TOGAF The TOGAF Enterprise Continuum is a
Enterprise  'virtual repository' of all the architecture
Continuum  assets - models, Patterns, architecture
nEEE descriptions and other artifacts - that exist

= . =B both within the enterprise and in the I'T
industry at large, and that the enterprise
considers itself to have available for the
development of architectures for the
enterprise.

Federal TOGAF provides diagrams and Toolbox
Enterprise | pages specific to the Federal Enterprise
Architecture = Architecture Framework (FEAF). It also

Framework  provides 'out-of-the-box' models of the
FEAF Performance Reference model and
Technical Reference model.

TOGAF Enterprise Architect helps you to create
Catalogs Model Catalog Artifacts, using the
Organization Units Catalo TOGAF-Catalog model Pattern, for:

Mame S5ta.. A..
. Actors

% Enterprise Pro.. rc..

Showing 1 -1 0f 7 items . Business Services
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Organization Units
Principles

Requirements and
Roles
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Brief Introduction

Welcome to The Open Group Architecture Framework
(TOGAF) integrated with Enterprise Architect.

Using this technology, users of Enterprise Architect benefit
from TOGAF within a multi-featured modeling environment
based on open standards.

About TOGAF

The Open Group Architecture Framework 1s one of the most
widely accepted methods for developing enterprise
architectures. TOGAF is an open framework, providing a
practical, definitive and proven step-by-step method for
developing and maintaining enterprise architectures.

The key to TOGAF remains a reliable, practical method -
the TOGAF Architecture Development Method (ADM) - for
defining business needs and developing an architecture that
meets those needs, applying the elements of TOGAF and
other architectural assets available to the organization.

TOGAF embodies the concept of the Enterprise Continuum
to reflect different levels of abstraction in an architecture
development process. In this way TOGAF facilitates
understanding and co-operation between actors at different
levels. It provides a context for the use of multiple

frameworks, models, and architecture assets in conjunction
with the TOGAF ADM. By means of the Enterprise
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Continuum, architects are encouraged to leverage all other
relevant architectural resources and assets, in addition to the
TOGAF Foundation Architecture, in developing an
organization-specific I'T architecture.

For detailed information on TOGAF itself, visit the TOGAF
website.

Benefits of TOGAF

. Helps align business processes and IT to the business
strategies and goals

. Provides support for all the phases in the ADM
. Provides support for OMG's Business Motivation Model
. Provides support for the Architecture Content Model

. Provides support for visual modeling of As-Is and To-Be
architecture

. Provides support for modeling all four architecture
domains specific to TOGAF (Business, Application, Data
and Technology)

. Provides support for the report generation of TOGAF
work products

. Provides the Open Group's TOGAF deliverable templates
as Linked Document templates

. Provides out-of-box FEAF reference models
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TOGAF Features

. A visual clickable Interface for the Architecture
Development Method (ADM)

. Useful starter model to help you become productive
quickly

. UML profiles for FEAF Business, Performance, Service
and Technical Reference Models

. Efficient relationship management for model artifacts
with Enterprise Architect's Relationship Matrix and
Hierarchy View

. Links to external files, audit log and report generation
features of Enterprise Architect, providing additional
capability for maintaining and managing your enterprise
architecture

A TOGAF-specific Glossary for the technology

Getting Started

For instructions on how to start using TOGAF within
Enterprise Architect, see the Using TOGAF Help topic.
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TOGAF System Requirements

TOGAF version 9.x runs under these environments:

Operating Systems

. Windows 10

. Windows 8

. Windows 7

. Windows 2008 Server

. Windows 2003 Server

. Windows XP Service Pack 2

Enterprise Architect Versions

. Enterprise Architect Version 11.1 or later
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TOGAF Support

Technical support for modeling through TOGAF 1n
Enterprise Architect is available to registered users of
Enterprise Architect in exactly the same way as for
Enterprise Architect itself.
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Licencing Copyright and Trademarks

TOGAF is owned and managed by The Open Group, and
any organization wanting to make commercial use of the
material must apply to The Open Group for a commercial
licence. See The Open Group TOGAF website.
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TOGAF Copyright Notices

TOGAF: Copyright © 2003-2018 X/Open Company Ltd,
Trading as The Open Group. All Rights Reserved.

Any organization that intends use the methods, resources,
and associated documentation suite known as The Open
Group Architecture Framework - TOGAF Version 9 (and all
earlier versions) for commercial purposes must apply to The
Open Group for a commercial licence. See The Open Group

TOGAF web site.
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TOGAF Software Product License
Agreement

This Software Product License Agreement relates to the
separately-purchased MDG Technology for TOGAF for use
with the Corporate and Professional Editions of Sparx
Systems Enterprise Architect. The MDG Technology for
TOGAF integrated with the Ultimate and Unified Editions
of Enterprise Architect 1s covered by the Sparx Systems
Enterprise Architect Modelling Tool.

MDG Technology for TOGAF, Enterprise Architect MDG
Add-In, Version 3.0.

Copyright © 2008-2022 Sparx Systems Pty Ltd. All Rights
Reserved

IMPORTANT-READ CAREFULLY: This End User
License Agreement ("EULA") 1s a legal agreement between
YOU as Licensee and SPARX for the SOFTWARE
PRODUCT identified above. By installing, copying, or
otherwise using the SOFTWARE PRODUCT, YOU agree
to be bound by the terms of this EULA. If YOU do not
agree to the terms of this EULA, promptly delete the unused
SOFTWARE PRODUCT.

The copyright in the SOFTWARE PRODUCT and its
documentation is owned by Sparx Systems Pty Ltd, A.B.N
38 085 034 546. Subject to the terms of this EULA, YOU
are granted a non-exclusive right for the duration of the
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EULA to use the SOFTWARE PRODUCT. YOU do not
acquire ownership of copyright or other intellectual property
rights in any part of the SOFTWARE PRODUCT by virtue
of this EULA.

Your use of this software indicates your acceptance of this
EULA and warranty.

DEFINITIONS

In this End User License Agreement, unless the contrary
intention appears:

. "EULA" means this End User License Agreement

. "SPARX" means Sparx Systems Pty Ltd A.C.N 085 034
546

. "Licensee" means YOU, or the organization (if any) on
whose behalf YOU are taking the EULA

. "Registered Edition of MDG Technology for TOGAF"
means the edition of the SOFTWARE PRODUCT which
is available for purchase from the web site:
https://sparxsystems.com/products/mdg/tech/togaf/purcha
se.html, following a thirty (30) day free evaluation period

. "SOFTWARE PRODUCT" or "SOFTWARE" means
MDG Technology for TOGAF, which includes computer
software and associated media and printed materials, and
may include online or electronic documentation

. "SUPPORT SERVICES" means email-based support
provided by SPARX, including advice on usage of the
SOFTWARE PRODUCT, investigation of bugs, fixes,
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repairs of models, if and when appropriate, and general
product support

. "SPARX SUPPORT ENGINEERS" means employees of
SPARX who provide on-line support services

. "Trial Edition of MDG Technology for TOGAF" means
the edition of the SOFTWARE PRODUCT which is
available free of charge for evaluation purposes for a
period of thirty (30) days

GRANT OF LICENSE

In accordance with the terms of this EULA YOU are
granted the following rights:

. To install and use ONE copy of the SOFTWARE
PRODUCT or, 1n its place, any prior version for the same
operating system, on a single computer; as the primary
user of the computer on which the SOFTWARE
PRODUCT is installed, YOU may make a second copy
for your exclusive use on either a home or portable
computer

. To store or install a copy of the SOFTWARE PRODUCT
on a storage device, such as a network server, used only to
install or run the SOFTWARE PRODUCT over an
internal network

. To make copies of the SOFTWARE PRODUCT for
backup, archival and instructional purposes
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EVALUATION LICENSE

The Trial Edition of MDG Technology for TOGAF i1s not
free software. Subject to the terms of this agreement, YOU
are hereby licensed to use this software for evaluation
purposes without charge for a period of thirty (30) days.

Upon expiration of the thirty (30) day evaluation period, the
SOFTWARE PRODUCT must be removed from the
computer. Unregistered use of Trial Edition of the MDG
Technology for TOGAF after the 30-day evaluation period
1s 1n violation of Australian, U.S. and international
copyright laws.

SPARX may extend the evaluation period on request and at
their discretion.

If YOU choose to use this software after the 30-day
evaluation period a license must be purchased (as described
at
https://sparxsystems.com/products/mdg/tech/togaf/purchase.
html). Upon payment of the license fee, YOU will be sent
details of where to download the registered edition of MDG
Technology for TOGAF and will be provided with a
suitable software 'key' by email.

ADDITIONAL RIGHTS AND LIMITATIONS

YOU hereby undertake not to sell or sub-license the
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SOFTWARE PRODUCT other than as expressly authorized
by this EULA.

NO WARRANTY. The SOFTWARE PRODUCT is
provided "AS IS", without warranty of any kind, and
SPARX expressly disclaims all warranties and/or conditions
with respect to the SOFTWARE PRODUCT, either express,
implied or statutory, including, but not limited to, the
implied warranties and/or conditions of merchantability, of
satisfactory quality, of fitness for a particular purpose, of
accuracy, of quiet enjoyment, and of non-infringement of
third party rights.

LIMITATION

Under no circumstances shall SPARX be liable for any
incidental, special, indirect or consequential damages arising
out of or relating to this license or YOUR use, reproduction,
modification, distribution of the SOFTWARE PRODUCT,
or any portion thereof, whether under a theory of contract,
warranty, strict liability or otherwise, even if the copyright
holder has been advised of the possibility of such damages
and notwithstanding the failure of essential purpose of any
remedy.

TRADEMARKS

All names of products and companies used in this EULA,
the SOFTWARE PRODUCT, or the enclosed
documentation can be trademarks of their corresponding
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owners. Their use in this EULA 1is intended to be in
compliance with the respective guidelines and licenses.

GOVERNING LAW

This agreement shall be construed in accordance with the
laws of the Commonwealth of AUSTRALIA, in the state of
Victoria.
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Acknowledgement of Trademarks

Trademarks of Microsoft

« Microsoft®
. Windows®

Trademarks of the OMG

. OMG™

. Object Management Group™
. UML™

. Unified Modeling Language™

Trademarks of The Open Group

. TOGAF™
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Using TOGAF

TOGAF provides a model-based framework for planning,
designing and implementing the Architecture for an
Enterprise. The starter model provided with TOGAF acts as
a base upon which you can build the Enterprise
Architecture. You can create the appropriate diagrams from
the extended Enterprise Architect UML diagram set, using
Toolbox pages that support every phase of the TOGAF
Interface Diagram. You can also align models across the
phases of the Architecture Development Method (ADM)
using the Enterprise Architect Relationship Matrix.

Notes

. TOGAF is integrated with the features of Enterprise
Architect

. Enterprise Architect is integrated with other Service
Oriented Architecture tools such as SOMF and SoaML,
and broader architecture modeling tools such as
ArchiMate, SPEM and Business Rule Modeling, all of
which you can use in conjunction with the TOGAF to
model and develop your Enterprise Architecture
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Getting Started With TOGAF

TOGAF is fully integrated with the Unified and Ultimate
Editions of Enterprise Architect, in which it 1s enabled and
ready for use.

If you have the Corporate Edition of Enterprise Architect,
you can purchase and install an MDG Technology for
TOGAF separately; once you have entered the registration
key for the MDG Technology for TOGAF, it is
automatically available in and integrated with Enterprise
Architect, as for the Unified and Ultimate Editions.

You can use the TOGAF profile in the Professional Edition
of Enterprise Architect. However, the Gap Analysis Matrix
feature 1s not available for TOGAF in the Professional
Edition.

Access TOGAF

1. Create a new Enterprise Architect project file, and click
on the top-level Package.

2. Select the 'Design > Package > Model Wizard' option.

3. In the 'Create from Pattern' tab (Model Wizard), select the
'Enterprise Architecture > TOGAF' Perspective and the
'Starter Model' Pattern.

4. Click on the Create Model(s) button.

A new base TOGAF model is created in the Browser
window, containing the TOGAF Architecture Development
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Method (ADM) structures and the Enterprise Continuum
asset Packages, and displaying the TOGAF-ADM

(Interface) diagram.
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TOGAF Model Patterns

TOGATF includes a set of model Patterns that you can use to
generate separate models within your TOGAF project.
These are available through the Model Wizard (Start Page
'Create from Pattern' tab).

Access

Display the Model Wizard (Start Page 'Create from Pattern'
tab), using any of the methods outlined here.

Once in the Model Wizard, select the 'Enterprise
Architecture > TOGAF' Perspective.

Select from the TOGAF Patterns:

. Starter Model (includes both ADM and Enterprise
Continuum)

. Architecture Development Method (ADM)
. Enterprise Continuum

. Technical Reference Model

. Catalogs

If you require additional diagrams, then while in the Model
Wizard, click on the 'Add Diagram' tab and (if necessary)
select the 'Enterprise Architecture > TOGAF' Perspective.
Then select from the diagram categories:

. FEAF Diagrams (Federal Enterprise Architecture
Framework)
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. TOGAF_BusinessArchitecture
. TOGAF DataArchitecture
. TOGAF Diagrams

In the 'Diagram Types' panel, select the required diagram
type.

Ribbon Design > Package > Model Wizard
Context Right-click on Package | Add a Model
Menu using Wizard

Keyboard Ctrl+Shift+M
Shortcuts

Other Browser window Header Bar: = | New
Model from Pattern
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The TOGAF Interface Diagram

In Enterprise Architect, the TOGAF Framework 1s presented
as a predefined model. The model-level diagram of this
model structure is the TOGAF Interface diagram, which
serves as a user interface for the development of Enterprise
Architecture based on TOGAPF.
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A.
Architecture
Vision

H.
Architecture B.
Change Business
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Architecture
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D

Technology
Architecture

E.
Opportunities
and
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The TOGAF Framework model makes use of UML
Packages, which 1s apparent from the model structure
diagram. The Interface diagram itself 1s a standard UML
Package diagram, using custom images.

Double-click on a cell of the Interface diagram to open the
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model Package and diagram corresponding to that particular
ADM phase.
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The TOGAF Model Structure

Within the TOGAF Framework model, each ADM phase is
modeled as the highest-level Package.

Project Browser O x
CINEREREREANERNERIE 3 AN
= g Model
= [B] TOGAF-ADM
FTOGAF-ADM
__| Preliminary

__| Phase &
__| Phase B
__| Phase C
__| Phase D
__| Phase E
__| Phase F
__| Phaze G
__| PhaseH
_| RM

= 2] Enterprise Continuum

LHHHHHHHHHH

%g! Enterprise Continuum
__| Foundation Architectures
__| Commuon Systerns Architectures
__| Industry Architectures
__| Organization Architectures
__| Industry Sclutions
__| Organization Soluticns
__| Products and Services
__| Systems Solutions
= [B] TOGAF_SIB
_1 5B

O = O - B B [ 3|
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TOGAF provides a number of diagram types to support

modeling with TOGAF. These diagrams include:
TOGAF diagrams:

. TOGATF Interface

. Conceptual Framework

. Architecture Content

. Architecture Development Method
. Service Model

. Enterprise Continuum

. Standards Information Base
TOGAF_BusinessArchitecture:

. Benefits

. Business Motivation Model

. Organization Structure

. Business Logistics

. Business Process
TOGAF_DataArchitecture:

. Data Map

FEAF diagrams:

. (FEAF) Business Reference Model
. (FEAF) Service Component Reference Model
. (FEAF) Technical Reference Model
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. (FEAF) Performance Reference Model

TOGAF-specific diagrams can be created in the same way
as for any other diagram in Enterprise Architect. When you
open a TOGAF diagram, Enterprise Architect automatically
opens the appropriate Toolbox pages for that diagram.
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The TOGAF Toolbox Pages

The MDG Technology For TOGAF Toolbox pages provide
elements and relationships for the full range of TOGAF
diagrams supported by the Technology.

Access

When you open a TOGAF diagram, Enterprise Architect
displays the Toolbox pages that are most useful for that
particular diagram type. In addition, the 'Common Elements'
and 'Common Relationships' pages of UML elements and
relationships display, regardless of which diagram is open.

The Diagram Toolbox pages can be docked on either side of
the diagram, or free floated on top of the diagram to expose
more surface for editing.

Ribbon Design > Diagram > Toolbox: £ >

Specify "TOGAF' in the 'Find Toolbox
Item' dialog

Keyboard Ctrl+Shift+3 : 2 > Specify "TOGAF' in
Shortcuts the 'Find Toolbox Item' dialog

Other You can display or hide the Diagram
Toolbox by clicking on the »/ or «l1cons
at the left-hand end of the Caption Bar at
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the top of the Diagram View.
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Architecture Development Method
Toolbox Pages

Architecture Development Method (ADM) elements are
used to define and model the TOGAF specific primitives in
all the phases of ADM. You use them to define the scope of
the architecture.
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(c) Sparx Systems 2022 Page 350 of 1007



Modeling Frameworks

Item

Architecture
Vision

Architecture
Board

Baseline
Architecture
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Description

Articulates a vision that enables the
business goals, responds to the strategic
drivers, conforms with the principles, and
addresses the stakeholder concerns and
objectives.

Tagged Values — ID, Scope, Version

Captures the definition for a
cross-organization Architecture Board.
This is a key element in a successful
architecture governance strategy, to
oversee the implementation of the
strategy.

This body should be representative of all
the key stakeholders 1n the architecture,
and typically comprises a group of
executives responsible for the review and
maintenance of the overall architecture.

Tagged Values — ID, Authority Limits,
Responsibilities

Captures the very high-level definitions
of the Baseline environment from the
perspective of business information
systems and technology. The scope and
level of detail to be defined depends on
the extent to which existing architecture
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clements are likely to be carried over into
the Target Architecture.

Tagged Values — ID, Type, Version

Target Captures the very high-level definitions

Architecture | of the target environment, from the
perspective of business information
systems and technology.

Tagged Values — ID, Type, Version

Framework Provides a textual description of the
Definition Framework.

Tagged Values — ID, Version

Request for Captures the information for the Request
Architecture  for Architecture Work, a major input for
Work the ADM phases.

This element is designed as a Document
Artifact. On creating a new element of
this type, double-click on the element to
open the Linked Document and select the
"TOGAF - Request for Architecture
Work' template from the list of templates
available for the 'Copy Template' option.

Tagged Values — ID, Architecturing
Organization, Sponsoring Organization

Statement of | Captures the information for the
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Architecture
Work

Product

Work
Package

Project
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Statement of Architecture Work, a major
output for the ADM phases.

This element is designed as a Document
Artifact. On creating a new element of
this type, double-click on the element to
open the Linked Document and select the
"TOGAF — Statement of Architecture
Work' template from the list of templates
available for the 'Copy Template' option.

Tagged Values — ID, Version

Captures the information on a product
produced by the enterprise.

Tagged Value — ID

Defines a set of actions that achieve one
or more objectives for the business. A
work Package can be a part of a project, a
complete project, or a program.

Tagged Values — CapabilityDelivered,
WorkPackageCategory, ID, Source,
Owner

Captures the information to define a
planned endeavor undertaken to create a
product or service.

Tagged Values — ID, FutureDirections,
Introduction, ProjectDevelopment,
Process Overview, References, Target
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Architecture(s) Mapping

Business Defines the business driver in the 'Name'
Driver field.

Tagged Values — ID, Version

Business Identifies and clarifies business needs,

Scenario and thereby derives the business
requirements that the architecture
development has to address. Creating a
business scenario involves these steps:

1. Identifying, documenting, and ranking
the problem driving the scenario.

2. Identifying the business and technical
environment of the scenario and
documenting it in scenario models.

3. Identifying and documenting desired
objectives.

4. Identifying the human actors
(participants) and their place in the
business model.

5. Identifying computer actors
(computing elements) and their place in
the technology model.

6. Identifying and documenting roles,
responsibilities, and measures of
success per actor; documenting the
required scripts per actor, and the
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results of handling the situation.

7. Checking for 'fitness-for-purpose' and
refining only 1f necessary.

A Linked Document template for
Business Scenarios is provided by the
Technology. To use the template,
right-click on the element and select the
'Edit Linked Document' menu option.
Select ' TOGAF — Business
Scenario/Architecture Vision' for the
'Copy template' option.

Tagged Value — ID

Business A generic element that captures
Entity enterprise resources.

Tagged Values — ID, Description

Goal Captures what 1s to be achieved by the
enterprise, with specifications defined by
the Tagged Values.

Tagged Values — Assumption, Critical
Success Factor, Goal Type, ID, Key
Performance Indicator, Measure, Unit
Responsible, Opportunity, Strength,
Threat, Weakness

Objective Captures the attainable, time-targeted,
and measurable target that the enterprise
seeks to meet 1n order to achieve its
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goals.
Tagged Value — ID

Strategy Captures the strategy statements for the
business plan.

Tagged Values — Action Plan, Estimated
Budget, Estimated Time Period, ID,
Measure, Target Value

IT Defines the strategy statement for IT
Governance | governance.

Strategy Tagged Values — ID, Version

Principle Defines and guides the organization, for

the use of all assets and resources across
the enterprise. Each Principle should be

linked to the relevant business objective
and key architecture drivers.

Tagged Values — ID, Implications,
Rationale, Statement, Type, Version

Guideline Captures the Guidelines governing the
enterprise and its functions, by providing
guidance on the optimal ways to carry out
design or implementation activities.

Tagged Value — ID

Asset Captures the enterprise resources that
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could be estimated for value.

Tagged Values — ID, AssetValue,
Description

Document A subtype of Asset that captures the

Asset important document resources of the
enterprise.
Tagged Values — ID, AssetValue,
Description

Equipment A subtype of Asset that captures the

Asset equipment resources of the enterprise.
Tagged Values — ID, AssetValue,
Description

Architecture  Captures summary views of the
Architecture Landscape (that is, the state
of the enterprise) at particular points in
time.

Tagged Values — ID, Category, Source,
Owner, Subject Matter, View Point,

Level Of Detail, Level Of Abstraction,
Accuracy, Version, Maturity

Solution Captures the summary views of a solution
in place for a specific architecture.

Tagged Values — ID, Category, Source,
Owner, Subject Matter, Time, Volatility,
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Version, Maturity

Architecture  (ABB) Relates to the Architecture

Building Continuum, and is defined or selected as

Block a result of the application of the ADM.
Tagged Values — ID, Description,
Owning Organization, Rationale,

ServicePortfolio
Solutions (SBB) Relates to the Solutions
Building Continuum, and can be either procured or
Block developed.

Tagged Values — ID, Description,
Supplier Organization

(c) Sparx Systems 2022 Page 358 of 1007



Modeling Frameworks 3 October, 2022

Architecture Content Model Toolbox
Pages

The Architecture Content framework provides a structural
model for architectural content that enables the major work
products that an architect creates to be consistently defined,
structured, and presented.
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Toolbox pages are described in separate topics:

For information on Architecture Content Model

ACM Core

Data Modeling Extension

Governance Extension

Infrastructure Consolidation Extension
Motivation Extension

Process Modeling Extension

Services Extension

3 October, 2022

relationships, see the topic Architecture Content Metamodel
Relationships in the TOGAF online documentation.
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ACM Core

Elements from the ACM page of the Architecture Content
Model Toolbox.

ACM Core Toolbox

Item Description

Actor Identifies a person, organization or
system with a role that initiates or
interacts with activities. Actors can be
internal or external to an organization.

Tagged Values — ID, Category, Source,
Owner, #FTEs, ActorGoal, ActorTasks

Assumption  Defines a statement of probable fact that
has not been fully validated at this stage,
due to external constraints.

Tagged Values — ID, Rationale,
Statement, Type

Business Identifies an external factor that prevents
Constraint an organization from pursuing particular
approaches to meet its goals.

Tagged Value — ID
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Business Identifies a factor that delivers business

Function capabilities closely aligned to an
organization, but not necessarily
explicitly governed by the organization.

Tagged Value — ID

Business Defines a quantitative statement of
Requirement = business need that must be met by a
particular architecture or work Package.

Tagged Value — ID

Business Identifies a service that supports business

Service capabilities through an explicitly defined
interface and is explicitly governed by an
organization.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate

Capability Defines a business-focused outcome that
is delivered by the completion of one or
more work Packages. Using a
capability-based planning approach,
change activities can be sequenced and
grouped 1n order to provide continuous
and incremental business value.

Tagged Values — ID, Category, Source,
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Data Entity

Gap

Organization
Unit

Principle
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Owner, Increments, BusinessValue

Defines an encapsulation of data that 1s
recognized by a business domain expert
as an entity. Logical data entities can be
tied to applications, repositories and
services, and can be structured according
to implementation considerations.

Tagged Values — ID, Category, Source,
Owner, PrivacyClassification,
RetentionClassification

Provides a statement of difference
between two states. Used in the context
of gap analysis, where the difference
between the Baseline and Target
Architecture is 1dentified.

Tagged Values — ID, Category, Source,
Owner

Defines a self-contained unit of resources
with line management responsibility,
goals, objectives, and measures.
Organizations can include external parties
and business partner organizations.

Tagged Values — ID, PersonIncharge

Provides a qualitative statement of intent
that should be met by the architecture.
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This has at least a supporting rationale
and a measure of importance.

Tagged Values — ID, Type, Statement,
Rationale, Implications

Process Represents the flow of control between or
within functions and/or services
(depending on the granularity of
definition). Processes represent a
sequence of activities that together
achieve a specified outcome, can be
decomposed into sub-processes, and can
show operation of a function or service
(at the next level of detail). Processes can
also be used to link or compose
organizations, functions, services, and
processes.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate,
ProcessCriticality, ProcessVolumetrics,

ProcessType
Platform Defines a technical capability required to
Service provide enabling infrastructure that

supports the delivery of applications.
Tagged Values — ID, Category, Source,
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Owner, StandardClass

Role Defines the usual or expected function of
an Actor, or the part somebody or
something plays in a particular action or
event. An Actor can have a number of
roles.

Tagged Values — ID, Category, Source,
Owner, Responsibilities

Work Identifies a set of actions to achieve one

Package or more objectives for the business. A
work Package can be a part of a project, a
complete project or a program.

Tagged Values — ID, Category, Source,
Owner, CapabilityDelivered

Application  Provides an encapsulation of application
Component functionality aligned to implementation
structure.

See also: 'Logical Application
Component' and 'Physical Technology
Component'.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate
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Logical Provides an encapsulation of application
Application  functionality that is independent of a
Component particular implementation.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate

Technology | Provides an encapsulation of technology

Component infrastructure that represents a class of
technology product or specific
technology product.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate

Physical Defines an instance of a specific
Technology | technology infrastructure product or
Component technology infrastructure product.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate,
ModuleName, ProductName, Vendor,
Version
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Data Modeling Extension

Elements from the Data Modeling Extension page of the
Architecture Content Model Toolbox.

Data Modeling Extensions Toolbox

Item Description

Logical Data = Defines a boundary zone that
Component encapsulates related data entities to form
a logical location to be held.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate

Physical Data Defines a boundary zone that
Component encapsulates related data entities to form
a physical location to be held.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate

(c) Sparx Systems 2022 Page 369 of 1007



Modeling Frameworks 3 October, 2022

(c) Sparx Systems 2022 Page 370 of 1007



Modeling Frameworks 3 October, 2022

Governance Extension

Elements from the Governance Extension page of the
Architecture Content Model Toolbox.

Governance Extension Toolbox

Item Description

Measure Identifies an indicator or factor that can
be tracked, usually on an ongoing basis,
to determine success or alignment with
objectives and goals.

Tagged Values — ID, Category, Source,
Owner

Contract Defines an agreement between a service
consumer and a service provider that
establishes functional and non-functional
parameters for interaction.

Tagged Values — ID, Source, Owner,
AvailabilityCharacteristics,
BehaviorCharacteristics,
CapacityCharacteristics,
ConsumingService,
ContractControlRequirements,
CredibilityCharacteristics,
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ExtensibilityCharacteristics, Growth,
GrowthPeriod, IntegrityCharacteristics,
InternationalizationCharacteristics,
LocalizationCharacteristics,
LocatabilityCharacteristics,
ManageabilityCharacteristics,
PeakProfileLongTerm,
PeakProfileShortTerm,
PerformanceCharacteristics,
PortabilityCharacteristics,
PrivacyCharacteristics, ProvidingService,
QualityOfInformationRequired,
RecoverabilityCharacteristics,
ReliabilityCharacteristics,
ResponseRequirements,
ResultControlRequirements,
ScalabilityCharacteristics,
SecurityCharacteristics,
ServiceabilityCharacteristics,
ServiceQualityCharacteristics,
ServiceTimes, Throughput,
ThroughputPeriod

Defines an Operation Level Agreement.

Tagged Values — ID, Source, Owner,
AvailabilityCharacteristics,
BehaviorCharacteristics,
CapacityCharacteristics,
ConsumingService,
ContractControlRequirements,
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CredibilityCharacteristics,
ExtensibilityCharacteristics, Growth,
GrowthPeriod, IntegrityCharacteristics,
InternationalizationCharacteristics,
LocalizationCharacteristics,
LocatabilityCharacteristics,
ManageabilityCharacteristics,
PeakProfileLongTerm,
PeakProfileShortTerm,
PerformanceCharacteristics,
PortabilityCharacteristics,
PrivacyCharacteristics, ProvidingService,
QualityOfInformationRequired,
RecoverabilityCharacteristics,
ReliabilityCharacteristics,
ResponseRequirements,
ResultControlRequirements,
ScalabilityCharacteristics,
SecurityCharacteristics,
ServiceabilityCharacteristics,
ServiceQualityCharacteristics,
ServiceTimes, Throughput,
ThroughputPeriod

SLA Defines a Service Level Agreement

Tagged Values — ID, Source, Owner,
AvailabilityCharacteristics,
BehaviorCharacteristics,
CapacityCharacteristics,
ConsumingService,
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ContractControlRequirements,
CredibilityCharacteristics,
ExtensibilityCharacteristics, Growth,
GrowthPeriod, IntegrityCharacteristics,
InternationalizationCharacteristics,
LocalizationCharacteristics,
LocatabilityCharacteristics,
ManageabilityCharacteristics,
PeakProfileLongTerm,
PeakProfileShortTerm,
PerformanceCharacteristics,
PortabilityCharacteristics,
PrivacyCharacteristics, ProvidingService,
QualityOfInformationRequired,
RecoverabilityCharacteristics,
ReliabilityCharacteristics,
ResponseRequirements,
ResultControlRequirements,
ScalabilityCharacteristics,
SecurityCharacteristics,
ServiceabilityCharacteristics,
ServiceQualityCharacteristics,
ServiceTimes, Throughput,

ThroughputPeriod
Service Defines a preset configuration of
Quality non-functional attributes that can be

assigned to a service or service contract.
Tagged Values — ID, Category, Source,
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Owner

(c) Sparx Systems 2022 Page 375 of 1007



Modeling Frameworks 3 October, 2022

Infrastructure Consolidation Extension

Elements from the Infrastructure Consolidation Extension
page of the Architecture Content Model Toolbox.

Infrastructure Consolidation Extension
Toolbox

Item Description

Location Represents a place where business
activity takes place and can be
hierarchically decomposed.

Tagged Values — ID, Category, Source,
Owner

Logical Provides an encapsulation of technology

Technology  infrastructure that is independent of a

Component particular product. A class of technology
product.

Tagged Values — ID, Category, Source,
Owner, StandardsClass,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate, RetireDate

Physical Identifies an application, application
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Application ~ module, application service or other
Component deployable component of functionality.

Tagged Values — ID, Source, Owner,
AvailabilityCharacteristics,
CapacityCharacteristics,
CredibilityCharacteristics,
ExtensibilityCharacteristics, Growth,
GrowthPeriod, IntegrityCharacteristics,
InternationalizationCharacteristics,
InteroperabilityCharacteristics,
LocalizationCharacteristics,
LocatabilityCharacteristics,
ManageabilityCharacteristics,
PeakProfileLongTerm,
StandardCreationDate,
LastStandardReviewDate,
NextStandardReviewDate,
RetirementDate, PeakProfileShortTerm,
PerformanceCharacteristics,
PortabilityCharacteristics,
PrivacyCharacteristics,
RecoverabilityCharacteristics,
ReliabilityCharacteristics,
ScalabilityCharacteristics,
SecurityCharacteristics,
ServiceabilityCharacteristics,
ServiceTimes, Throughput,
ThroughputPeriod, LifeCycleStatus,
InitialLiveDate, DateOfLastRelease,
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DateOfNextRelease, StandardsClass
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Motivation Extension

Elements from the Motivation Extension page of the
Architecture Content Model Toolbox.

Motivation Extension Toolbox

Item Description

Business Defines an external or internal condition

Driver that motivates the organization to define
its goals.

Tagged Values — ID, Version

Goal Provides a high-level statement of intent
or direction for an organization. Typically
used to measure success of an

organization.
Tagged Values — ID, Category, Source,
Owner

Objective Identifies a time-bounded milestone for

an organization, to demonstrate progress
towards a goal.

Tagged Values — ID
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Process Modeling Extension

Elements from the Process Modeling Extension page of the
Architecture Content Model Toolbox.

Process Modeling Extension Toolbox

Item

Control

Event

Product

(c) Sparx Systems 2022

Description

Defines a decision-making step with
accompanying decision logic, used to
determin